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History of Changes 

Date Changes Reason

2012-03-02 ADDED:
When logging on in the Profile creation dialog for the first time the user need not perform 
any manual configurations.

FRN4403

2012-03-02 ADDED:
Depending on the configuration, the context menu of a consultation call offers the option 
to start a local or server-based conference.

FRN5079

2012-03-02 ADDED:
In the Port restrictions dialog of the SIP Service Provider you can define the port ranges 
for audio and video streaming.

FRN4685

2012-04-26 CHANGED:
The dialog for configuring the QoS settings of the SIP Service Provider are available 
under Microsoft Windows XP only.

CQ00207211
A31003-G2570-U100-1-7619, 05/2012
OpenScape Personal Edition V7, User Guide 9

         



PE_History.fm
 A31003-G2570-U100-1-7619, 05/2012
10 OpenScape Personal Edition V7, User Guide

         



About this Manual
Target Group of this Manual
1  About this Manual

The OpenScape Personal Edition (also called OpenScape Desktop Client in this 
manual) is an IP-based communications software that can be used as SIP or HFA 
softphone when connected to an SIP (OpenScape Voice) or HFA communica-
tions system. It is installed on a PC or Laptop and enables mobile users to take 
their phone number with them. Calls and thus be made and accepted indepen-
dently from the location. In addition, it enables managing a local contact list, 
integrating corporate directories and private contact lists (e.g. Microsoft Outlook 
contacts) via LDAP as well as calling Microsoft Outlook contacts directly from 
Microsoft Outlook. During operation the OpenScape Desktop Client logs all calls 
in a local journal. In combination with an OpenScape Voice the OpenScape 
Personal Edition enables conducting video phone calls and taking part in video 
conferences with up to three participants.

1.1  Target Group of this Manual

This manual addresses:

• all users who deploy OpenScape Desktop Client; in particular also 
newcomers who require information about the program interface and 
operating OpenScape Desktop Client.

• advanced users who want to customize OpenScape Desktop Client 
according to their requirements.

The instructions contain important information about using OpenScape Desktop 
Client safely and correctly. Please follow them precisely to avoid operating 
OpenScape Desktop Client incorrectly and to make best use of this application.

1.2  Contents of this Manual

This manual describes how to configure and operate the OpenScape Desktop 
Client of the OpenScape Personal Edition after the setup.

The information is structured as follows:

Chapter 1: About this Manual

In this chapter you find information about the structure and use of these operating 
instructions as well as a list of all acronyms used.

Chapter 2: Configuration and Settings

This chapter tells you how to set parameters required for operating the 
OpenScape Desktop Client.

Chapter 3: Step-by-Step

The information contained in this chapter helps the user to familiarize himself/
herself with the OpenScape Desktop Client features.
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Chapter 4: Operation Reference

This chapter represents the different OpenScape Desktop Client controls and 
explains how to use them.

Chapter 5: Communicating with Contacts

In this chapter you find information about the OpenScape Desktop Client features 
that enable communicating with your contacts.

1.3  Representation Conventions

We use the following markups and representations to highlight information in this 
manual.

1.3.1  Formats and Display Forms

In the manual on hand the following conventions apply:

Purpose Appearance Example

Product and company 
names

Italic OpenScape UC Application

Special emphasis Bold Name must not be deleted.

User interface 
elements

Bold Click on OK.

Menu sequence  > File > Exit

Textual cross 
reference

Italic You find further information in the Configu-
ration and Administration manual.

Path and file names Font with fix 
character 
spacing, e. g. 
Courier

c:\Program Files\... or Example.txt

Specifications that 
may have individual 
content, e.g. variables.

Italic in angle 
brackets

Enter your <user name> and the <password> 
to log on to the system.

System entry and 
output

Font with fix 
character 
spacing, e. g. 
Courier

Command not found.

Key combination Bold [Ctrl]+[Alt]+[Esc]
 A31003-G2570-U100-1-7619, 05/2012
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Continuative Documentation
1.3.2  Notes

Types of notes

Critical notes and additional information are indicated in this manual in the 
following manner:

NOTICE:  Notes indicated in this way point to information worth 
knowing or useful tips.

IMPORTANT:  This indicates notes that carry information of high 
priority. Please definitely read and heed such notes to avoid 
malfunctions, loss of data or damages to devices.

1.3.3  Figures

This manual displays all entry dialogs important for operation and configuration. 
Depending on the operating system, the browser used, the screen resolution, the 
configurations on your PC and your selection of the user interface style these 
dialogs may appear slightly different. Normally, this does not influence the 
functionality described.

1.4  Continuative Documentation

You find further information about OpenScape Desktop Client in the following 
documentation:

• OpenScape Personal Edition V7 Installation and Administration, setup guide
Contains information about setting up and uninstalling OpenScape Personal 
Edition and as well as detailed information about program configuration and 
the tools supplied for administrators of OpenScape Desktop Client.

• OpenScape Personal Edition V7, quick guide
Describes the basic OpenScape Personal Edition features.

1.5  Acronyms

Table:  Acronyms used

Abbreviation Meaning

ACD Automatic Call Distribution

BLF Busy-Lamp Field

CCBS Completion of Calls to Busy Subscriber

CCNR Completion of Calls on No Reply
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Acronyms
CLA Customer License Agent

CSV Comma Separated Value

DLC DLS Client

DLS DepLoyment Service

DMC Direct Media Connect

DNS Domain Name System

DTMF Dual -Tone Multi-Frequency

GAL Global Address List

HFA HiPath Feature Access

HLM HiPath License Management

IPC InterProcess Communication

LAN Local Area Network

LDAP Lightweight Directory Access Protocol

LED Light-emitting Diode

LIN Local Identification Number

MLHG Multi-Line Hunt Group

MWI Message Waiting Indicator

NANP North American Numbering Plan

OCS Office Communications Server

QoS Quality-of-Service

qWAVE Quality Windows Audio/Video Experience

RNA Ring-No-Answer

SDES Session Description Protocol (SDP) Security Descriptions for Media 
Streams

SIP Session Initiation Protocol

SRTP Secure Real-time Transport Protocol

TCSPI Telephony Conferencing Service Provider Interface

TLS Transport Layer Security

UC Unified Communications

URI Uniform Resource Identifier

VPN Virtual Private Network

Abbreviation Meaning
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Configuration and Settings
“Audio Schemes”
2  Configuration and Settings

Smoothly operating the OpenScape Desktop Client requires various individual 
user settings. Type and volume of these settings depend among other things on 
the installed and activated modules, basic network parameters and installed 
audio hardware. Some settings must be performed before the initial login, since 
proper operation is otherwise not possible. Other settings can be performed 
during operation.

You edit user settings in the Settings dialog.

You can open this dialog in two ways: Either click on the Manage button in the 
login dialog and then select Settings. Or, during operation after the login, select 
the OpenScape Settings option in the OpenScape context menu that you open 
in the notification area of the Windows task bar.

NOTICE:  During live operation, not all settings can be modified.

2.1  “Audio Schemes”

NOTICE:  Various audio devices are supported for operating 
OpenScape Desktop Client. You find comprehensive information 
about these devices in the OpenScape Desktop Client setup 
guide.
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So that you can conduct phone calls, your PC must be equipped with speaker and 
microphone, e.g. in the form of a headset.

NOTICE:  OpenScape Desktop Client supports operating a range 
of audio devices. You find a list of these devices in the setup 
manual of OpenScape Desktop Client.

The hardware settings are grouped in audio schemes. To set the audio schemes, 
select in the Settings dialog the Audio Schemes tab during the user login.

You can add audio schemes and modify or delete single audio schemes. This 
makes it easy to program different audio options (for example, on different 
hardware) and then select the appropriate scheme you want to use.

Adding an Audio Scheme

A click on the Add... button defines a new audio scheme in the OpenScape 
Desktop Client. The following dialog opens:
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• Enter an expressive text for the audio scheme under Description. This text 
appears in green (the audio scheme is available) or red writing (the audio 
scheme is unavailable) in the list of configured audio schemes.

• Select the audio hardware for the voice recording under Voice recording.

• You determine the audio hardware for voice playback under Audio 
Response.

• You select optionally the audio hardware for the additional speaker under 
Additional speaker. If you have defined an additional speaker here and this 
audio scheme is being used by OpenScape Desktop Client, the icon appears 

on the SoftPhone > Calls tab of the ribbon and on the main bar: .

NOTICE:  The hardware for the additional speaker and the one 
for the audio response must be different.

• You determine the audio hardware for the ringtone under Signal response.

• Under Controller you select the audio hardware for controlling special 
hardware functions.

NOTICE:  Components of an audio scheme that are currently 
locally unavailable are represented in brackets. The entire audio 
scheme is then considered unavailable. The OpenScape Desktop 
Client may then use the next available audio scheme.

Selecting/Activating Audio Schemes

To select an audio scheme, click the one you want in the list of audio schemes.

Changing an Audio Scheme

You can edit the settings of the selected audio scheme by clicking on the 
Change... button. The following dialog opens:

The possible settings are identical with the settings for a new audio scheme.

Deleting an Audio Scheme

You can remove a selected audio scheme from the list of configured audio 
schemes with a click on the Delete button.
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Sequence of Audio Schemes

You can use the audio scheme sequence to influence the required / necessary 
audio hardware selected. After the user has logged in, the OpenScape Desktop 
Client checks the audio hardware specified in the audio schemes and processes 
the schemes one after the other from top to bottom. If all components set for a 
scheme are available and ready for operation, this scheme is used for operating 
the OpenScape Desktop Client.

You can change the sequence of an audio scheme with the buttons up and down.

Click the Refresh button to check the availability of added audio schemes and to 
display the scheme currently used.

2.2  “Modules” Tab

The Modules tab lists all modules that were determined for operation with the 
standard provider selected during the installation. This determination is based on 
the functionality and features of these modules.

Click the Show all modules button to see all installed modules.

NOTICE:  You can activate or deactivate modules only before you 
log in. This is not possible during operation.
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“Modules” Tab
The following table lists the available modules and summarizes their functions. 
The modules that are automatically loaded with any setup method are indicated 
with ( ).

IMPORTANT:  Do not activate modules not contained in the below 
table! If you add modules that are not described here, consid-
erable problems may occur during the operation of OpenScape 
Desktop Client!
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Module Description Setup type

Screensaver Manager Provides the OpenScape Desktop Client screensaver feature. All ( )

Communication Provider1 Enables SIP Service Provider operation. SIP Provider

Directory Manager This module activates name resolution via configured directory 
services (e.g. LDAP, private contact list) and controls the priority with 
which the information in these directories is handled.

All ( )

Device State This module is in charge of the telephone and redirection menus in 
the main bar and ribbon of the OpenScape Desktop Client.

All ( )

HiPath Provider Provides the connection to a HiPath 4000or OpenScape Office MX 
PBX.

HiPath Provider

HLM License Provider Provides the connection to the HiPath license server. SIP Provider and 
HiPath Provider

IPC Manager1 This module is required for initiating calls from Microsoft Outlook or 
IBM Lotus Notes via the OpenScape Desktop Client. It provides a 
dialog for selecting phone numbers.

All ( )

Journal Provides the Journal user interface. All ( )

Keyboard Manager This module provides keyboard support features. All ( )

Contact List1 This module provides a contact list for local use. All ( )

LDAP Directory Provider The LDAP Directory Provider enables connecting OpenScape Desktop 
Client to external LDAP directories used for resolving phone numbers.

All ( )

Local Journal Provider Stores connection data for the journal in the local database. These 
data records are automatically deleted after a specific period or when a 
certain maximum number of data records has been reached.

All ( )

IBM Lotus Notesprovider This module provides the connection to a IBM Lotus Notes client and 
enables the IBM Lotus Notes integration.

All

Microsoft Outlook Provider1 This module is used for searching the Microsoft Outlook contact list. All ( )

Ribbon1 This module is in charge of representing the ribbon in the main 
window.

All ( )

Notifier Toast (Desktop Alerts) This module controls the display of a dynamically appearing notifi-
cation window at the bottom right screen margin.

All ( )

Pearl Main Window1 This module is in charge of the individual window view. All ( )

Sendmail Provider1 This module enables sending e-mails to a contact directly from one of 
the directories or from the contact list.

All ( )

SIP Service Provider This module enables the OpenScape Desktop Client to perform SIP 
telephony services.

SIP Provider

Softphone1 This module provides user interface of a telephone. All

Sound control1 This module is in charge of the audio command (audio buttons, menu 
volume, volume control, button additional speakers).

All ( )

SQLite Provider The SQLite Provider enables accessing Microsoft Outlook contact 
directories via an SQLite database.

All ( )
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NOTICE:  A guide to adding or removing modules is given in the 
setup manual of OpenScape Desktop Client.

2.3  “Advanced” Tab

On the Advanced tab you can perform the main settings for the application. The 
single main settings are subdivided in subsettings.

Stimulus Provider This module is in charge of showing information on the telephone 
display.

SIP Provider and 
HiPath Provider

Lookup Service1 Enables looking for contacts in all available directories. All ( )

Toolbar1 The activated module is in charge of representing the main bar in the 
individual window view.

All ( )

Telephone The telephone module controls the integrated and free telephone in 
the OpenScape Desktop Client.

All ( )

Call Control Provides the call control feature. All ( )

Directory Search1 Enables searching contact directories from several data sources, e.g. 
LDAP directories, Microsoft Outlook contacts, etc.

All ( )

Video Viewer This module is in charge of representing the video window in the video 
viewer. 

SIP Provider

Dialing Helper1 Using this module the OpenScape Desktop Client initiates calls started 
in Microsoft Outlook or in IBM Lotus Notes. The dialing helper is exclu-
sively used in combination with the IPC manager.

All ( )

Webbrowser This module enables opening frequently accessed internet pages 
directly in the web browser of the OpenScape Desktop Client.

All ( )

Web Access Manager1 This module enables configuring and opening web addresses for your 
contacts.

All ( )

Status and Event Display1 This module serves as indicator plugin and enables the display of 
various events and statuses, e.g. secure or non-secure connection, in 
the main bar.

All

1 For this module no Settings are possible or required on the Advanced tab.

Module Description Setup type
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You can perform the following main settings, listed in the left-hand area, by 
default.

2.3.1  General Settings

The General settings include the following sub-settings.

2.3.1.1  General

You can select a preset and coordinated color scheme to adjust the color layout 
of your OpenScape Desktop Client. For this purpose, select on the tab Advanced 
> General > General.

In the right-hand section of the Advanced tab you can perform the following 
settings:
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• In the Color scheme combo box you can select the desired color scheme.

NOTICE:  For the time being, only the color scheme DarkGray is 
available.

• Activating the Automatically run program when I log on to Windows 
checkbox starts the OpenScape Desktop Client automatically when you 
perform your Windows logon to the system.

• Open main window
In this input field you can define a key or hotkeys considered System-wide 
keyboard tokens (hotkeys) that will open the main window again or move it 
to the foreground when its hidden or minimized. The cursor is automatically 
positioned in the <Name or Number> input field of the main menu.

NOTICE:  The system-wide keyboard token (hotkey) is also 
available during operation in restricted mode.

IMPORTANT:  System-wide means in this case that no other 
application executed on your PC in parallel to the OpenScape 
Desktop Client will react to these keys. Be sure not to enter keys 
or hotkeys that are allocated in other programs or in the Windows 
environment with functions that you want to use.

 Admissible keys or hotkeys are:

– [F2] to [F11], also in combination with Shift or [Ctrl],

– Letter keys A to Z and the digit key 0 to 9, also in combination with [Ctrl],

– The hotkey Shift + [Esc],

– Blank key,

– [Alt] + Shift + [Ctrl].

NOTICE:  You must not define the function keys [F1] and [F12] as 
hotkeys.

2.3.1.2  User Data

NOTICE:  The user data can only be set or modified while you log 
in and not while the system is in operation.

You can enter your First and Last name here as well as insert your Own image. 
This image is only used during a chat (instant messaging). It will not be stored on 
the server and not transferred, i.e. it is not visible for the chat partner.
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You can add your image via the Loading... button. Select the relevant image file 
in the open file selection dialog. Then click the Open button. The selected image 
appears in the Own image section.

Clicking the Delete button removes the image.

2.3.1.3  Starting the Program

NOTICE:  Options for editing program start settings are only 
available when you activate them while operating the OpenScape 
Desktop Client . Open the OpenScape context menu in the 
Windows task bar and select the OpenScape Options menu 
item.

To edit the OpenScape Desktop Client start-up options, select on the tab 
Advanced > General > Program Start.

You can define the following settings for the program start:
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• Profile to be selected
When you select this option, the login dialog displays the field for selecting a 
profile. If this option is not selected, there are no profile-specific administration 
functions available in the Logon dialog.
Activate this setting, for example, if you want to use the same Windows user 
account in different locations. Profile-specific parameters are therefore 
considered during logon.

NOTICE:  Profile-specific information is always necessary for 
user logon. Consequently, the Profile field may only be masked 
out in the Logon dialog if only one profile is used. This profile must 
be created at the first program start after the installation.

• Language to be selected
When you select this option, the login dialog displays the field for selecting 
Language. Select this setting, for example, if staff members with different 
native languages operate the OpenScape Desktop Client on the same PC.

• Configuration options
You can use this setting to specify whether – and if so which – configuration 
options shall be available to a user when logging on. The following options are 
available:

– Admit Settings and Profile administration
The complete list of management features as well as the Settings option 
is displayed in the menu of the Manage button when you click on the 
Manage button. The Add Profile ... button appears in the login dialog in 
addition.

– Hide Settings and Profile administration
You cannot access the menu of the Manage button. The Add Profile ... 
button is hidden.

– Only accept settings
The Settings entry is displayed in the menu of the Manage button after 
you have clicked on the button. The other management functions are not 
available. The Add Profile ... button is hidden from the login dialog.

• Settings for the LIN mode
This option controls how an LIN (Local Identification Number) is entered in the 
logon dialog. The LIN can be used to pinpoint emergency calls by assigning 
location numbers to buildings, building section numbers, etc.

NOTICE:  Please obtain detailed information about configuring an 
LIN number in an HiPath 4000 from the documentation of the 
respective HiPath 4000 PBX.

The following options are available:
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– Suppressed (no entries)
The LIN field is not displayed in the login dialog.

NOTICE:  If the Suppressed (no entries) option was selected 
and no password was assigned to the user, the program starts 
automatically without displaying the logon dialog.

– Optional (empty entry field)
The LIN field appears blank in the login dialog and need not be filled in for 
logging on.

– Optional (display last entry)
The LIN field is displayed in the logon dialog. The LIN from the last logon 
is set by default. The field need not be filled in for logging on.

– Mandatory (empty entry field) 
The LIN field appears blank in the login dialog and need to be filled in for 
logging on.

– Mandatory (display last entry)
The LIN field is displayed in the logon dialog. The LIN from the last logon 
is set by default. The field must be filled out for logon.

NOTICE:  If you want to see the Login dialog every time, but do 
not wish to assign a password, select the Optional (empty entry 
field) option.

2.3.1.4  Connection Status Change

NOTICE:  Options for editing settings that change the connection 
status are only available when activated during login, not when 
activated during live operation.

Depending on the display mode set for the OpenScape Desktop Client in normal 
mode you may want the display mode to reflect a change of connection status. 
For example, if the main bar is minimized in connection-free status, you can enter 
a setting that places the OpenScape Desktop Client back on top in the case of 
incoming or outgoing calls.

To edit these options, select on the tab Advanced > General > Change of 
connection status. You can define the display mode of the program for any 
connection status.
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The following connection statuses exist:

• Without connection
There is not connection (no connection request, no connection setup, no 
active connection).

• Connection setup
You set up a connection to another station, for example, a call connection, by 
dialing a phone number.

• Active Connection
There is an active connection. This may be an active call.

• Connection request
You receive a connection request, for example, an incoming call.

You can determine how OpenScape Desktop Client displays the single 
connection statuses in case of a connection status change. The display mode can 
change to:

• (no changes)
The current display is not modified.

• normal/positioned
The main bar is reset to the active status (normal or positioned) in which it was 
before it was minimized. The OpenScape Desktop Client reappears on the 
desktop.

• minimized/hidden
The main bar is minimized or hidden. The main bar is hidden if you did not 
select the icon display in the notification area settings.

The time entered in the after field for all connection statuses and all display 
modes indicates for how many seconds the specified display mode is to be active 
after a connection status change. This setting ensures that the OpenScape 
Desktop Client is automatically minimized/hidden again within a certain period 
after a connection has ended.
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2.3.1.5  Task Bar and Notification Area

NOTICE:  Options for editing settings for the Windows task bar 
and notification area of the Windows task bar are only available in 
the case of activation when logging on, not in the case of 
activation during operation.

To edit the options for displaying the OpenScape Desktop Client in the Windows 
taskbar and in the notification area of the Windows taskbar, select on the tab 
Advanced > General > Task Bar and Notification Area.

• Symbol in notification area
Depending on the status of the main window you can display an icon for the 
(we call it OpenScape icon as we proceed) in the notification area of the 
Windows task bar.

– Normal main window
The OpenScape icon is displayed when the main window is not 
minimized.

– Minimized main window
The OpenScape icon is displayed when the main window is minimized.

• Entry in task bar and task manager
By activating the Minimized main window option you can determine that an 
entry for the OpenScape Desktop Client is displayed in the task bar and in the 
task manager of Windows when the main window is minimized.

2.3.1.6  Program Update

NOTICE:  You find detailed information about the automatic 
program update of OpenScape Desktop Client in the manual 
OpenScape UC Application V7 OpenScape Desktop Client 
Installation and Administration.

NOTICE:  Options for editing settings for program updating are 
only available in the case of activation when logging on, not in the 
case of activation during live operation.

On the Advanced  > General > Program Update tab you can perform various 
settings to automate the search for updates.
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The following options are available for configuring the automatic program update:

• Never
Program updates are never searched for.

• Every time the program starts
When you start the OpenScape Desktop Client, a more recent version is 
searched for in the memory location specified under Folder.

• Periodically while program running
While the OpenScape Desktop Client is being operated, a more recent 
version is searched for in the memory location specified under Folder and 
during the period defined under Interval (minutes).

• Interval (minutes)
Defines the time interval in which a more recent program version is searched 
for in case of a periodical check. You specify the time interval in minutes.

• Specify in the Folder input field the path to the setup folder under which 
updated program versions shall be found. You can also click on the browser 
button ... and select the desired folder.

NOTICE:  If the update folder of the program is stored on another 
computer in the network, specify the path to the setup folder in the 
UNC (Uniform Naming Convention) format, for example 
\\server name\path. Before you do that, verify that you have 
the privileges required for accessing this computer.

2.3.1.7  Central Configuration

NOTICE:  Options for editing the central configuration settings are 
only available in the case of activation during live operation, not in 
the case of activation when logging on.

In cases where a Deployment Service (DLS or central configuration) is available 
on the network for an installation, the settings for the OpenScape Desktop Client 
can also be stored centrally. In such cases, the parameters for accessing the 
central configuration must be entered in the OpenScape Desktop Client, so that 
the centrally stored parameters can be retrieved.

To edit the settings for the central configuration, select on the tab Advanced > 
General > Central Configuration.
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The following settings are required for using the central configuration:

• Connection
If you have configured using a central configuration during the installation, 
select the required setting under Connection. The following options are 
available:

– No use
No central configuration.

– Complete use
Complete use of the central configuration.

– Only for encryption
The central configuration is exclusively used for encoding the voice 
signaling.

• Server (DLS)
Enter the IP address in the Server field and the port number of the DLS server 
in the Port field. The DLS port is the port number used for accessing the 
central server.

• Client (DLC)

– Select the client Address. You can either use Detect automatically for 
the entry or select the IP address(es) specified in the client PC configu-
ration. Furthermore, you can enter an IP address manually.

NOTICE:  If you use central configuration here and have multiple 
network cards and/or multiple IP addresses on a network card, 
you must deactivate the Detect automatically option and 
manually configure the IP address/MAC address to be used. The 
IP address/MAC address set here is then transferred to the DLS 
connected.

– In the Port field , enter the number of the local port under which the 
OpenScape Desktop Client responds to queries from the central server.
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– In the Network card combo box select the network card ID used for DLS-
server exchange. The options available here are Detect automatically or 
the network card IDs configured on the PC.

NOTICE:  IDs of network cards that are no longer available in the 
PC are depicted in brackets ( ) in this list.

NOTICE:  These settings are entered by default if the central 
configuration is used during the OpenScape Desktop Client 
setup.

2.3.2  Telephone Settings

The telephone module controls the integrated and free telephone in the 
OpenScape Desktop Client.

While the display of the integrated phone is a permanent main bar feature, the 
corresponding function, dial and dialog keys (depending on the individual setting) 
are usually not displayed. Under Advanced > Telephone > Integrated phone 
you can specify which action is to be performed following a click on the display in 
the main bar.

By selecting the desired option you can control the display behavior that follows 
a click on the display of the integrated phone. The following options are available:

• Display integrated phone as popup window
When you click on the display, the dial and dialog keys appear as popup 
window on the display (subject to individual setting). You can then use the 
keys in the window as usual. When you click on another window, the popup 
window with the keys is hidden again.

• Display free phone
When you click on the integrated-phone display, the free phone opens 
(subject to individual setting). If the free phone is already open, this window 
will be switched to.

• Show and hide free phone
When you click on the integrated-phone display, the free phone opens 
(subject to individual setting). If the free phone is already open, it will be 
closed now.
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2.3.3  Device State Settings

The Device State is in charge of the Telephone menu in the main bar and of the 
Functions menu in Ribbon > SoftPhone tab > Device Feature group. Since no 
additional settings are required for this module, no editing parameters can be 
selected.

2.3.3.1  Line Settings

NOTICE:  Options for editing line display settings are only 
available in the case of activation during live operation, not in the 
case of activation when logging on.

You define the line display options on the tab Advanced > Device State > Lines. 
You can select the lines you wish to display in the Lines window from the list of 
configured lines:

In the Display line status section you can define the icon size (Large icons or 
Small icons) for the line options displayed in the Lines window.

• Normal View
Select the icon size for the Lines window, if it is docked to the main bar or 
freely positionable.

• Anchored View
Define the icon size in the Lines window.

• Symbols
You can also specify whether the symbols in the Lines window are to appear 
in Gold or in Silver-Gray.

All lines configured in the OpenScape Desktop Client are listed in the Lines to be 
displayed section. Select here the lines to be displayed in the Lines window. 
Only the lines activated here can later be operated in the Lines window.
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2.3.4  Web Browser Settings

NOTICE:  You can edit the web browser settings via the Settings 
dialog during the program start or during live operation. Click on 
the Manage button in the Logon dialog or the OpenScape 
Options button in the Pearl menu.

In daily operation you can directly open frequently visited internet pages in the 
web browser of the OpenScape Desktop Client without having to leave the 
program. The selectable internet pages are configured in the Internet pages 
section and subsequently offered as selection options in the Pearl menu > View 
> Webbrowser.

2.3.4.1  Internet Page Settings

If you want to perform web browser settings, click on the Internet pages option 
in the Webbrowser area.

Here you can add a new internet page, edit already configured web pages or 
delete them. The following operating elements are available in this dialog:

Adding a new Internet Page

A click on this button opens the following dialog:

In this dialog you can configure a new internet page address for the web browser.
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• Name
Enter an expressive name for the desired internet page in this field. While you 
operate the OpenScape Desktop Client, this name appears in the Pearl 
menu > View > Web Browser and enables invoking the respective internet 
page.

• Address
Enter the URL of the desired internet page in this field.

Editing Internet Pages

NOTICE:  The corresponding button remains inactive until you 
select an entry in the list of configured internet pages.

A click on this button opens the following dialog:

In this dialog you can change the already configured Name and the Address of 
a selected internet page.

Deleting an Internet Page

NOTICE:  The corresponding button remains inactive until you 
select an entry in the list of configured internet pages.

A click on this button removes a selected entry from the list of configured internet 
pages.

2.3.5  SIP Service Provider Settings

NOTICE:  To edit the SIP Service Provider settings you need to 
open the Settings dialog during the program start. Click on the 
Manage button in the login dialog for this purpose.

By setting the SIP Service Provider you configure the OpenScape Desktop Client 
for being used as softphone at an SIP communications system.

To edit the SIP Service Provider settings, select on the tab Advanced > SIP 
Service Provider. Then click on one of the following settings.
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2.3.5.1  System Services

Select under Advanced > SIP Service Provider > System Services the server 
type with which the OpenScape Desktop Client is connected.

Server Type

• OpenScape Voice/hiQ4200
Select this server type if the OpenScape Desktop Client is connected to an 
OpenScape Voice or a hiQ4200.

• OpenScape Voice/hiQ4200 without video
Select this server type if the OpenScape Desktop Client is connected to an 
OpenScape Voice or a hiQ4200 without video support.

• HiPath 3000/OpenOffice EE
Select this server type if the OpenScape Desktop Client is connected to this 
server.

• HiPath 3000 >=V8
Select this server type if the OpenScape Desktop Client is connected to an 
HiPath3000 V8 or later.

• HiPath 4000 >=V7
Select this server type if the OpenScape Desktop Client is connected to an 
HiPath 4000 V6 or later.

• Default without Video/Instant Messaging
Select this server type if the OpenScape Desktop Client is connected to any 
SIP-protocol-based SIP server. In this case the video and instant-messaging 
features are not supported.

• Custom
If you select this server type, you can individually activate the support for the 
following features for the connected communications system (if available):

Server services

• Video connections
Enables connections for exchanging video images.
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• Instant Messaging connections
Enables connections for exchanging instant messages.

• Additional lines/stations
Enables the Lines module window.

• Extended call functions/call forwardings
Enables extended features and functions, such as Transfer.

• Suppress blind transfer
The "Blind Transfer" feature (transfer to a device or subscriber) is not 
supported by this PBX.

You determine the number of supported features (server services) by selecting 
the relevant option in the Server Type combo box. The user cannot change this. 
The following table shows which features are supported by which server type.

NOTICE:  If a listed server service is active, the associated 
features and elements such as buttons, menu options, module 
windows, etc. are also active in the OpenScape Desktop Client. 
These controls are unavailable or inactive if the associated server 
service is not active.

2.3.5.2  Connection

Select the entry Advanced > SIP Service Provider > Connection. Enter the 
different connection settings for the OpenScape Desktop Client at the connected 
communications system.

Server Type Server Services

OpenScape Voice/hiQ4200 • Video connections

• Additional lines/stations

• Extended call functions/call forwardings

OpenScape Voice/hiQ4200 
without video

• Additional lines/stations

• Extended call functions/call forwardings

HiPath 3000/OpenOffice EE None of the listed services is supported.

HiPath 3000 >=V8 • Video connections

• Suppress blind transfer

HiPath 4000 >=V6 • Video connections

• Suppress blind transfer

Default without Video/Instant 
Messaging

None of the listed services is supported.

Custom You can individually activate the support of the features 
for the connected communications system (if 
available):
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• Protocol
Select the transport type for the transport protocol. The available options are 
UDP, TCP, and TLS.
If you operate OpenScape Desktop Client at an OpenScape Voice with 
connection to an OpenScape Media Server, tones, announcements and 
conference data can be transmitted encrypted via the SRTP protocol. In this 
process, the keys for data encryption are negotiated on the basis of the SDES 
security model and exchanged via the SIP connection. It is therefore 
important to select the TLS protocol for such connections at this point of the 
SIP Service Provider configuration.

IMPORTANT:  Furthermore, you need to set Port 5061 in the SIP 
Signaling section under Advanced > SIP Service Provider > 
Port restrictions.

NOTICE:  Encrypted data transmission is also possible when 
operating in Restricted Mode.

NOTICE:  You find more information about data encryption in the 
manual OpenScape Personal Edition V7 Installation and Admin-
istration.

• Time-To-Live (sec.)
This is an SIP-specific timer for some kind of heartbeat procedure: So that the 
SIP server does not put an inactive subscriber out of action, the OpenScape 
Desktop Client needs to register with the SIP server in intervals specified in 
the Time-To-Live (sec.) field.

IMPORTANT:  This value should only be modified by your system 
administrator.
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• Own IP address
The Own IP address must be known for the IP connection of the OpenScape 
Desktop Client. If the OpenScape Desktop Client is connected to a network 
adapter to which a unique IP address has been assigned, select the Detect 
automatically setting. If the network card is assigned multiple IP addresses 
or if the network card cannot be reached directly, for example, via the ACME/
Session Border Controller, all addresses are listed in the list box and you can 
select the required one.

SIP Session Timer

• Time limitation
Activate this option to specify whether the validity of active sessions is to be 
monitored by means of heartbeat procedures.

• Duration (90-3600 Sek.)
Specify here the duration of the timer in seconds (admissible range 90 - 
3600 sec.). Value 0 means the timer is off.

Transaction Timer

• Duration (3000-32000 ms)
The OpenScape Desktop Client expects a response from the SIP server to its 
SIP request (e.g. when setting up an SIP connection) within this period. The 
default value set for this parameter is 32000 ms. When this period has 
expired and the OpenScape Desktop Client has not yet received an answer 
from the SIP server, an error message is generated. An example is the error 
message “Request Timeout”, in the case that the network can be reached but 
the SIP server temporarily or permanently cannot.

NOTICE:  The required details are provided by your administrator 
or PBX administrator.

TLS Connectivity Check

If OpenScape Desktop Client is connected to an OpenScape Voice via the TLS 
protocol, the connection to the PBX can be regularly checked. As soon as a 
connection breakdown has been detected, the program attempts automatically to 
re-establish the connection to the PBX.

NOTICE:  You can change the settings for monitoring the TLS 
connection to the OpenScape Voice after you have selected the 
TLS option under Protocol.

• Enable Check
If a tick is placed in the Enable Check checkbox (default settings), monitoring 
the TLS connection is active.

• Interval (60 - 600 sec.)
With this parameter you can define an interval of 60 sec. to 600 sec. in which 
the existance of the TLS connection to the OpenScape Voice is checked. The 
default value is 120 sec.
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2.3.5.3  Main Line

Select Advanced > SIP Service Provider > Main line for defining the param-
eters for the main line of the OpenScape Desktop Client.

• User
For logging on to the SIP communications system you need to enter a unique 
OpenScape Desktop Client phone number/user address.
If you leave this field emtpy, logging on to the SIP communications system (e. 
g. OpenScape Voice) will fail. In this case it is not possible using the 
OpenScape Desktop Client as SIP softphone.

• Display
Enter the complete name. The text is displayed by the free or integrated 
phone when idle and is also transferred as name information to your 
connection partners. This text is also used as a description of the primary line 
in the Lines window or menu.

• Tooltip text
The Tooltip text appears when the mouse pointer is moved close to the main 
connection line in the Lines window.

• Login
Enter here your SIP ID that has been configured for authenticating at the SIP 
communications system.

• Password
Enter here the SIP password that has been configured for the SIP ID specified 
under Login.

NOTICE:  The administrator of your SIP communications system 
provides you with the required details.

You can define a connection target in the Immediate connection section. This 
target is automatically called after you have picked up the receiver or pushed the 
corresponding headset button (pick up/put down receiver), and after a configu-
rable period has elapsed, in which you have not dialed a phone number.
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• Address
Enter here the phone number or SIP address to be automatically called after 
activating the line (e.g. after picking up the receiver or pushing the corre-
sponding key (picking up/putting down the receiver) of your headset).

IMPORTANT:  You can use the Immediate connection feature 
only with headsets that have a function key picking up/putting 
down the receiver , such as the headset USB adapter GN 8120 
USB and other products by manufacturers GN Netcom and 
Plantronics.

• Delay (sec.)
This entry specifies the delay after which the above address is to be dialed. If 
the delay is set to 0, the immediate connection is set up without delay.

• Keyset
Activate this checkbox to configure your OpenScape Desktop Client as 
Keyset. A Keyset is a telephone that can support several lines and on which 
each line is represented by a key with LED. As soon as you have defined at 
least one assignment, this checkbox becomes automatically active. In this 
case the setting can only be deactivated by deleting the additional line. If your 
OpenScape Desktop Client is connected to an OpenScape-Voice PBX, the 
user of a single line (i. e. only one main line and no additional lines are 
configured) must activate the checkbox for logging on to the system.

• Private usage
Activating this checkbox defines this line as private line. That is, if you use this 
line, other stations with a secondary line do not receive any status change 
messages on your call number/user address.

NOTICE:  The administrator of your PBX provides the required 
details.

2.3.5.4  Additional Lines

IMPORTANT:  If you use the OpenScape Desktop Client, you 
must not configure or deploy any additional lines.

Your connections are conducted via lines in the OpenScape Desktop Client. 
Every user has at least one separate line that is individually assigned and used 
only by that specific user (main line). If supported by the communication system 
connection, SIP users can use additional configured lines or share them with 
other SIP users. The choice of lines available is defined in the connected commu-
nication system. You can define further lines for the user on the Advanced tab 
under SIP Service Provider > Additional lines.
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Previously configured additional lines are displayed in the list. You can add 
additional lines, change settings or delete lines.

Adding additional Lines

After clicking the Add... button you can define an additional line for the user. The 
following dialog opens:

• Under User enter the phone number of the SIP user.

• Enter an expressive text in the Display field. This text will be shown in the 
display of the free respectively integrated phone in idle state and also trans-
mitted as name information to your connection partners. Furthermore, this 
text will be used as description of the respective line in the line window 
respectively line menu.

• The Tooltip text appears when the mousepointer rests on the connection line 
in the line window.

• Login
Enter your login here.

• Password
If the authentication was configured on the server, you need to enter you 
password in this field.
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In the Immediate connection section you can configure an immediate 
connection for the main line.

• Address
Use this entry field to specify which address is to be dialed after the line has 
become active (e.g. after lifting the handset).

• Delay (sec.)
This entry specifies the delay after which the above address is to be dialed. If 
the delay is set to 0, the immediate connection is set up without delay.

• Private usage
Activating this checkbox defines this line as private line. That is, if you use this 
line, other stations with a secondary line do not receive any status change 
messages on your call number/user address.

NOTICE:  The required details are provided by your OpenScape 
UC Application or PBX administrator.

The main line and all additional lines configured here can be selected in the Lines 
menu on the main bar. The Lines window, on the other hand, only contains lines 
that were specially activated and suitable for editing.

Changing additional Lines

After clicking the Change... button you can edit the already configured settings of 
a line. The following dialog opens:

NOTICE:  You cannot change the entry in the User entry field.

Deleting additional Lines

You can remove a selected line from the list of configured lines with a click on the 
Delete button.
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2.3.5.5  Line Parameters

NOTICE:  The line parameters settings are only required in 
combination with configured additional lines.

Select under Advanced > SIP Service Provider the Line parameters option. In 
the displayed dialog you can perform the following settings:

Accept calls automatically 

Select an option in this combo box to define which criteria are used for accepting 

calls on a specific line by lifting the handset or pushing the headset key or .

The following settings are available:

• From the preferred line or the line that has been ringing the longest 
(default)

• From the line that has been ringing the longest

• From the preferred line or the line that was called the longest

• From the line that was called the longest

• Only from the preferred line for incoming calls

Line selection for outbound calls

Select an option in this combo box to define which criteria are used for accepting 

calls on a specific line by lifting the handset or pushing the headset key or .

The following settings are available:

• On the preferred line (default)

• On the next free line (lines always considered from first to last)

• On the last line used

• No automatic line seizure
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Signaling type for second call waiting on another line

Select an option in this combo box to define if and how the OpenScape Desktop 
Client should signal inbound connection requests if an active call is in progress 
when you receive a second connection request on another line.

You can choose between:

• Special alert tone (default)

• Normal alert tone

• No Alert tone

Behavior on switching the line

Select an option in this combo box to define what is to happen to an active call in 
the OpenScape Desktop Client when you answer another connection request:

• Places active call on hold (default)

• Ends (disconnects) the active call.

In the Immediate connection for the device section you can configure an 
instant connection for your device.

• Address
Use this entry field to specify a number to which a connection is automatically 
set up independent from the line-specific immediate-connection settings.

• Delay (sec.)
This entry specifies the delay after which the number specified under 
Address is to be dialed. 0 seconds here means an immediate connection 
without delay.

NOTICE:  If values have been configured for a device-specific 
and a line-specific immediate connection, the lower delay setting 
is used. If the delay time settings are identical for the line and 
device, the immediate connection is set up first for the line.

2.3.5.6  Registrar

Select under Advanced > SIP Service Provider > Registrar to define the 
parameters for the registrar portion of the server.
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• Server
Enter the IP address or server name of the registrar portion of the SIP server.

NOTICE:  The necessary details can be obtained from the system 
administrator.

In the Connection are you can define the port number for the server connection:

• Use DNS SRV
If this option is active, the settings for the registrar portion of the SIP server 
are determined by a DNS service. In this case, enter the domain name of the 
registrar portion of the server under Server.

• Use Default Port 
Depending on the selected transport type, this option for the connection to the 
registrar portion of the server is active by default.

• Use Custom Port
If you select this option, you must enter the port number under Port.

NOTICE:  The necessary details can be obtained from the system 
administrator.

2.3.5.7  Proxy

Select under Advanced > SIP Service Provider > Proxy to define the param-
eters for the proxy portion of the SIP server.

• Server
Enter the IP address or server name of the proxy portion of the SIP server.

NOTICE:  The necessary details can be obtained from the system 
administrator.

In the Connection are you can define the port number for the server connection:

• Use DNS SRV
If this option is active, the settings for the proxy portion of the SIP server are 
determined by a DNS service. In this case, enter the domain name of the 
proxy portion of the server under Server.

• Use Default Port
Depending on the selected transport type, this option for the connection to the 
proxy portion of the server is active by default.
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• Use Custom Port
If you select this option, you must enter the port number under Port.

NOTICE:  The necessary details can be obtained from the system 
administrator.

2.3.5.8  Outbound Domain

An outbound domain (outbound proxy server) is used e.g. for a (Survivable 
Branch Office Solution) with an OpenScape Voice. In this case the survivability is 
provided by an extra proxy component of the SIP server (survivable SIP proxy, 
e.g. Comdasys Convergence). A survivable SIP proxy (gateway) offers restricted 
SIP server functions (restricted operation mode), as soon as it realizes that the 
OpenScape Voice cannot be reached. The OpenScape Personal Edition status 
bar signals operation in restricted mode by a corresponding information display 

. Operation is not interrupted.

NOTICE:  Survivability describes here the ability of the communi-
cations network to maintain the service for network subscribers 
even in case of existing errors in the network. You find detailed 
information about Survivability in the administrator manual of the 
OpenScape Voice V4R1 or V5.

Using an outbound domain enables you to make calls without having to specify 
the complete SIP addresses (SIP URIs/SIP phone numbers) when dialing. For 
example, the SIP phone number to be dialed reads: sip:0123456789@Domain 
Name. You can enter only 0123456789 in the <Name or Number> input field in 
the main menu. The SIP communications system completes the SIP phone 
number to the dialed.

Select the entry Advanced > SIP Service Provider > Outbound Domain to 
define the parameters for the outbound domain and the SIP gateway server.
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• Use Outbound Domain
Activate this option so that you can fill in the fields in this dialog.

NOTICE:  This checkbox must be ticked for connecting the 
OpenScape Desktop Client to an OpenScape Voice in the central 
as well as in a branch office.

• Domain name
Enter the name of your outbound domain in this input field. The SIP commu-
nications system automatically completes it in the phone number to be dialed 
before the connection is set up.

NOTICE:  Leave this input field empty for connecting the 
OpenScape Desktop Client to an OpenScape Voice with an 
OpenScape Branch solution in the central as well as in a branch 
office.

• Delete port entries in INVITE headers
Activating this option removes the ports from the INVITE headers for the 
domain names entered. This is necessary, for example, in the case of ACME/
Session Border Controller configurations.

• If, for example, OpenScape Desktop Client is used with an OpenScape Voice 
in a survivable branch solution (e.g. OpenScape Branch), enter the IP 
address or the server name of the gateway server or of the Survivable SIP 
Proxy in the Server field of the Gateway section.

NOTICE:  You need to set the IP address or the server name of 
the Survivable SIP Proxy also under SIP Service Provider > 
Proxy.

IMPORTANT:  Leave this input field empty for connecting the 
OpenScape Desktop Client to an OpenScape Voice with an 
OpenScape Branch solution in the central office.

NOTICE:  The necessary details can be obtained from the system 
administrator.

Set the port number for the server connection in the Connection section:
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• Delete DNS SRV / port specification in ROUTE headers
If this option is active, a DNS server can be used to search the gateway 
settings. In this case, enter the domain name of the gateway server under 
Server. Alternatively, the ports can be removed from the ROUTE header. This 
is necessary, for example, in the case of ACME/Session Border Controller 
configuration. To do this, enter the IP address of the gateway under Server.

IMPORTANT:  You must set this option for connecting an 
OpenScape Voice in survivable branch solutions (e.g. 
OpenScape Branch).

• Use Default Port
Depending on the selected transport type, this option for the connection to the 
proxy server is active by default.

• Use Custom Port
If you select this option, you must enter the port number under Port.

2.3.5.9  Network Access

NOTICE:  The network access settings are used for normalizing 
phone numbers. They need to be configured only if the Normalize 
call numbers option has been activated in the Settings dialog on 
the tab Advanced > SIP Service Provider > Address 
conversion.

Network access settings (location information) are needed for setting up a direct 
connection to telephone numbers from OpenScape Desktop Client directories or 
call lists. These settings are also used for converting call numbers into interna-
tional dialable format. If these settings are not configured properly, you may 
encounter problems when setting up connections.

Select on the tab Advanced > SIP Service Provider > Network access to 
configure the network access settings.
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• Country code
Enter here the international prefix for your location, e.g. for Germany 49.

• Area code
Enter here the telephone prefix for your location in the national phone number 
scope. Omit the leading zero for this entry.

• System identification number
Enter the system identification number. This system ID number identifies 
internal call numbers in the directories that only set up internal connections 
when selected.

• Extension range
Specify the extension range of your network in the form of a regular 
expression.
Example:
You have been assigned the system identification number with the numbers 
0049 35 12345-2000 to 0049 35 12345-4999. In this case the extension range 
reads 2000 to 4999. Enter the following in the Extension range field for these 
phone numbers: \b[2-4][0-9]{3}\b.

– \b - the number must begin with a blank

– [2-4] - the first digit may be a character between 2 and 4 inclusive, thus 2, 
3, 4

– [0-9]{3} - for the next three digits, numbers 0 to 9 are allowed

– \b - the number must end with a blank

• Office code
Enter here the code that has been configured on your system or on your PBX 
to allocate trunks for outgoing connections.

• Prefix for local calls/long distance calls/international calls
Enter the network operator ID for the respective call type in the corresponding 
fields. E.g. in Germany no Prefix for local calls is used, while for other 
countries in Europe and members of the NANP (North American Numbering 
Plan) the zero is used to mark local calls. For example, in Germany the prefix 
for long distance calls is 0 and the prefix for international calls is 00. This 
data is independent from the configuration of the connected communications 
system and determined by the network operator.

• Additional code for local calls/long distance calls/international calls 
Enter here any additional digits to be used as call-by-call prefixes. This data 
is independent from the configuration of the connected communication 
system.
The sequence of the various codes is as follows:
<office code><additional code><prefix><phone number>

Test

Click on the Test... button to open the following dialog and test your entries.
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• Extension to be dialed
Enter the number to be dialed in this entry field. Based on the currently set 
parameters the OpenScape Desktop Client determines the phone number in 
international format.

• Converted internationally
The phone number entered in the above field is automatically displayed in this 
field.

• Effectively dialed
This field displays automatically the actually dialed number. Depending on the 
set network access parameters the number may be shorter, e.g., if an internal 
phone number has been recognized.

2.3.5.10  Address Conversion

In the Settings dialog, select on the tab Advanced > SIP Service Provider > 
Address conversion.

• Normalize call numbers
 Normalizing a phone number means that it is converted in a permanently 
defined default representation from any representation format. A phone 
number is always normalized when it is to be searched for or passed on to 
another system that expects a defined phone number format.
Activate this option if phone numbers are to be normalized based on the infor-
mation from the network access settings on the tab Advanced > SIP Service 
Provider > Network access.

NOTICE:  Make sure that all required network access data on the 
tab Advanced > SIP Service Provider > Network access is set 
correctly.

• Remove domain specification in display texts
Activate this option to suppress the domain port for a SIP-URI to be displayed 
(e.g. display the calling station) on the display.
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• Remove same domain address
Activate this option to suppress the domain port in the case of SIP-URIs from 
the same/own registrar in addresses, e.g. call lists.

• Add international prefix (“+“) to SIP address
Activate this option if the OpenScape Desktop Client is to indicate the SIP 
address as international.
Example:
The SIP Service Provider delivers the address 
sip:4924049087666@siemens.com and the OpenScape Desktop Client 
converts it in sip:+4924049087666@siemens.com.

• Handle SIP-addresses as call numbers
If this option is active, the domain portion is ignored and the text that precedes 
the domain considered a phone number.
Example:
sip:+4924049087666@enterprise.com is considered +4924049087666.

• Input and selection option of SIP-addresses
Activate this checkbox to allow the input and selection option of SIP-
addresses.

2.3.5.11  Additional Functions

On the Advanced tab, under SIP Service Provider > Additional functions , you 
can define additional features depending on the connected communications 
system.

Call forwarding

• Ringing time (sec.) until the call forwarding type ’unavailable’ takes effect
Using this option you can set a ringing time after the expiry of which a call 
forwarding you have configured becomes active. Specify the desired value in 
the associated field.

DTMF tone dialing

• DTMF mode
The available options in this combo box read Auto and Inband. You can 
obtain further details from your PBX administrator.
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Attendant function

• Join call after hang up
This option determines the telephone's reaction when you hang up 

via during a consultation call: you are connected to the consultation call 
subscriber while the connection to the original caller is being held. If this 
option is active, the original caller and consultation call subscriber are then 
connected. If this option is inactive, the connection to the consultation call 
subscriber is closed and you are automatically reconnected to the original 
caller.

NOTICE:  If, however, you put down the receiver, the held 
connection persists. Your PBX automatically triggers a call signal. 
After picking up the receiver, you are reconnected to the held 
subscriber.

Reconnect function

• Reconnect call after hang up
If a connection (partner A with partner B) is set to call-hold owing to a consul-
tation call (A consults with C) and the consultation call is finished, activating 
this option will effect the following:

– Partner A is automatically reconnected to the held partner B, after partner 
C has closed the consultation call connection.

– The held partner B calls partner A again after partner A has closed the 
consultation call connection.

2.3.5.12  System Functions

Select on the tab Advanced > SIP Service Provider > System functions to 
define the system function settings.

NOTICE:  The functions offered in this dialog are possibly not 
supported by every SIP communications system.
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Message Waiting Indicator (MWI)

You can use this feature to be alerted to available voicemails and retrieve them.

• Voice-Mail ID
Enter the phone number for the callback access of the voicemail system 

under Voice-Mail ID. This setting effects the display of the 

option Request messages in the telephone menu.

NOTICE:  The necessary details for this can be obtained from the 
administrator of the connected communication system.

Server-based Voice Conference

A server-based voice conference is a conference connection based on a consul-
tation call connection that can connect more than three participants to each other.

NOTICE:  In the OpenScape Voice documentation this type of 
conference is referred to as device-controlled conference.

• Conference Factory URI
Enter here the number or URI of the conference server supported by your 
communications system. For example, the OpenScape Desktop Client sends 
during a consultation call the conference server URI to the OpenScape 
Voice, which then establishes a conference connection to the connected 
Media Server of the OpenScape UC Application. 
If this function is configured, the context menu of a consultation call contains 
the "Initiate server-based conference" option. Otherwise, the context menu 
of a consultation call contains the "Initiate local conference" option.

NOTICE:  We recommend to only enter the user portion of the 
conference server URI, e.g. "4989" instead of 
"4989@<address of the SIP server>".

Automatic acceptance of calls for server-controlled connections

• Alert tone
If you operate the OpenScape Personal Edition via a CTI application and 
have dialed a phone number via the CTI application, a connection is first set 
up to the OpenScape Personal Edition. The program accepts this connection 
request automatically. Subsequently, the connection to the desired call target 
is set up. In case of the ticked checkbox the OpenScape Desktop Client 
indicates with a signal tone after the automatic call pickup that the hands-free 
function is active.
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Voice recording

• Disable Voice Recording

NOTICE:  This option is not activated by default.

Activating this option hides the voice recording icon in the main bar and in 
the ribbon > SoftPhone tab > Calls group. Recording an active call with 
OpenScape Desktop Client is then not possible anymore.

2.3.5.13  Codes

Select on the tab Advanced > SIP Service Provider > Codes to define codes for 
various telephony features.

Callback

The callback function enables you to activate an automatic return call for a busy 
or free internal subscriber. When the busy subscriber finishes his/her call, the 
return call is initiated. In this process, the subscriber who activated the return call 
is called first, and after he/she has accepted this call, the target subscriber is 
called.

You can set the following codes for the Callback function:

• Code for activation "on free"
The setting defines the key (0 to 9, *, #) used for automatic activation in case 
of a free line.

• Code for activation "on busy"
The setting defines the key (0 to 9, *, #) required for automatic activation in 
case of a busy line.

• Code to delete all requests
This setting defines the key (0 to 9, *, #) required for deleting all automatic 
callback requests
The option Delete callback is additionally available in the telephony menu of 

the main bar ( ) and in the ribbon > SoftPhone tab > Functions by config-
uring this code during operation.
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Call pickup

Call pickup is a telephony function that allows the members of a subscriber group 
(or business group in OpenScape Voice terminology) to pick up calls for other 
members of the group. Two features are available for this function: 

• Call pickup group
This feature combines subscribers in pickup groups. Each group member can 
accept a call for another group member. Calls signalled acoustically to a 
subscriber of a call pickup group are at the same time signalled visually to the 
other group members by an LED (next to the programmed key) on the display. 
You can pick up the call by pushing a key or dialing a code number as well as 
via the displayed desktop notification.

NOTICE:  To use the Call Pickup Group feature you need to 
perform appropriate settings in the OpenScape Voice.

• Directed call pickup
This feature allows subscribers to accept signalled or waiting calls and to 
resume manually held calls for every phone number within a business group.

You can set the following parameters for the call pickup function:

• Server Type
You can select one of the following server types from this combo box: 

– OpenScape Voice

– Broadsoft

– Sylantro

– Auto

– HiQ4200

NOTICE:  The PBX OpenScape Voice used to be called HiPath 
8000.

• Code
Here you can define the key (0 to 9, *, #) used for call pickup and configured 
in the OpenScape Voice.

By configuring this code during operation, the options Directed call 

pickup and Pickup call are additionally available in the telephony menu 

of the main bar ( ) and in the ribbon > SoftPhone tab > Functions.

Hunting group

The hunting group telephony feature enables call distribution within a subscriber 
group. These subscribers are linked, so that a call to the group is automatically 
routed to the next free member in case of a busy or unanswered phone.

You can set the following codes for the hunting group function:
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• Code to stop call forwarding 
This setting defines the key (0 to 9, *, #) required for ending the automatic 
call forwarding. You can use the keypad of the integrated/free phone as well 
as the of the SoftPhone of the OpenScape Personal Edition.
The option Logoff from hunting group is additionally available in the 

telephony menu of the main bar ( ) and in the ribbon > SoftPhone tab > 
Functions by configuring this code during operation.

• Code for busy signaling
This setting defines the key (0 to 9, *, #) required for signaling a busy line. 
You can use the keypad of the integrated/free phone as well as the of the 
SoftPhone of the OpenScape Personal Edition.
The option Unavailable for hunting group is additionally available in the 

telephony menu of the main bar ( ) and in the ribbon > SoftPhone tab > 
Functions by configuring this code during operation.

NOTICE:  The necessary details can be obtained from the system 
administrator.

2.3.5.14  Sounds

The tone signals for ring tones, busy signals, etc., differ from one country to 
another. You can perform the settings for these tones in the OpenScape Desktop 
Client. This is done on the tab Advanced > SIP Service Provider > Sounds.

• Tone scheme
Select from this combo box the country for which the default tones in the 
OpenScape Desktop Client are to be used. Besides the individual countries, 
you can also select the option International Market.

• Music on hold
Use this option to activate/deactivate music on hold for held/consultation 
calls.

• Alert tone for calls on hold
If this option is active, an acoustic signal reminds you about calls that are on 
hold.

2.3.5.15  Ring Tones

Alternatively to the default ring tones determined by the ring tone color set in the 
PBX, you can select an individual ring tone for signaling incoming calls. 
Compatible ring tone files must comply with the following requirements:

• The ring tone file must be available in WAV or MP3 format.
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• The file size must not exceed 2 MB. If you configure a bigger ring tone file as 
ring tone, only the first 2 MB of this file are played.

To configure an individual ring tone, select on the tab Advanced > SIP Service 
Provider > Ring tones.

NOTICE:  You can edit the settings for the individual ring tone via 
the Settings dialog during the program start or during live 
operation. Click on the Manage button in the login dialog or select 
in the Pearl menu > Personal Settings > Ring Tones.

• Via the Use individual ring tones option you activate an individual ring tone. 
After you have activated this option, the OpenScape Desktop Client uses the 
tone specified under File to signal incoming calls.

• Under File you define the WAV or MP3 file that contains the desired ring tone. 
Via the browse button ... you can look for the desired file.

NOTICE:  OpenScape Desktop Client copies the content of the 
selected WAV or MP3 file. In this way the ring tone is still available 
even if the original sound file is deleted.

2.3.5.16  Video Schemes

One or more video cameras must be installed in your workplace for sending video 
signals. No camera installation is required for receiving and representing video 
signals from other subscribers. The video hardware settings are grouped in video 
schemes. You can add video schemes and modify or delete single video 
schemes. This makes it easy to program different video options (for example, on 
different hardware) and then select the appropriate scheme you want to use. 
Select on the tab Advanced > SIP Service Provider > Video schemes to 
configure, select, edit or delete video schemes:
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Adding a Video Scheme

After clicking the Add... button you can configure a new video scheme. The 
following dialog opens:

• Enter an expressive name for the video scheme under Description.

• In the Camera combo box you select the camera to record the image for the 
video connections in the OpenScape Desktop Client.

Selecting/activating a Video Scheme

To select/activate a video scheme, click the one you want in the list of configured 
video schemes. If a video scheme is available and active and the user logged in, 
the SoftPhone tab in the ribbon displays in the Video group the following icon for 

switching the camera on and off: camera preview.

NOTICE:  If a video scheme is temporarily locally unavailable, the 
OpenScape Desktop Client uses the next available video 
scheme.

Changing a Video Scheme

After clicking the Change... button you can edit the Description and Camera 
settings of a selected video scheme. The following dialog opens:
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Deleting a Video Scheme

You can remove a video scheme from the list of configured video schemes with a 
click on the Delete button.

Video Scheme Sequence

You can define the sequence of the configured video schemes, thus influencing 
the respective video hardware selection. After the user log-in, OpenScape 
Desktop Client checks the video hardware specified in the video schemes. The 
list entries are processed from top to bottom. You can set the video scheme 
sequence using the up and down buttons.

2.3.5.17  Bandwidth

Communication between the OpenScape Desktop Client and the communica-
tions system is based on defined compression algorithms (codecs) for the trans-
mission of audio and video signals via network. To this, you can select the 
following settings under Advanced > SIP Service Provider > Bandwidth:

Network connection

• Download (kbit/s) 
Use this combo box to select one of the velocities available in your system for 
the download.

• Upload (kbit/s)
Use this combo box to select one of the velocities available in your system for 
the upload. The minimum value we recommend for this setting is 256kBit/s.

• Load Default Profile
Use this button to open a window in which the different profiles (tariffs) are 
listed. You can select your tariff/profile there. Although the associated speeds 
for Download or Upload are preset by default, they can be modified.
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Audio Codecs

Determine in this section the codec sequence required for voice communication. 
The three audio codecs that OpenScape Desktop Client supports are G.711, 
G.729 and G.722.

• Priority 1
Use this combo box to select the audio codec to be used for your voice 
connections with the highest priority. 

• Priority 2
Use this combo box to select the audio codec to be used for your voice 
connections if the audio codec with the highest priority is not available.

• Priority 3
Use this combo box to select the audio codec to be used for your voice 
connections if the audio codecs with Priority 1 and Priority 2 are not 
available.

• Packet length (ms)
Select Auto here or enter the desired value (in milliseconds).

• Jitter Buffer (ms)
To avoid voice packet loss, which can result in poor voice quality and 
dropouts, set the buffer size in this field. We recommend to set the jitter buffer 
to value 60. The jitter buffer caches all incoming voice packets for the period 
set and then forwards them to the audio device’s sound output. The jitter 
buffer continues to forward voice packets until none are left, even if the 
network does not deliver new voice packets quickly enough. This avoids 
dropouts.
When selecting the optimum setting for the jitter buffer the following applies:

– The better the network quality, the smaller the jitter buffer may be.

– The bigger the jitter buffer, the more the voice output will be delayed.

Video Codecs

Determine in this section the codec sequence required for video connection. The 
two video codecs that the OpenScape Desktop Client supports are H.263 and 
H.264.

• Priority 1
Use this combo box to select the video codec to be used for your voice 
connections with the highest priority.

• Priority 2
Use this combo box to select the video codec to be used for your voice 
connections if the video codec with the highest priority is not available.

2.3.5.18  Port Restrictions

To determine the port restrictions in firewall environments, select on the tab 
Advanced > SIP Service Provider > Port restrictions.
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Port Restrictions

• RTP video port range from/to
Enter the RTP ports used for the video connections in these fields.

NOTICE:  If no video transmission is possible during operation 
despite a correct login, make sure that the RTP port range is 
configured between 29120 and 29131.

• RTP audio port range from/to
Enter the RTP ports used for the voice connections in these fields.

NOTICE:  If no voice transmission is possible during operation 
despite a correct login, make sure that the RTP port range is 
configured between 29100 and 29119.

SIP signaling

• Port
In this entry field you specify the SIP port used for the signaling connections.

NOTICE:  If you have set the TLS entry under SIP Service 
Provider > Connection in the Protocol field, specify value 5061. 
This port is used for secure connections.
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2.3.5.19  Quality of Service (QoS)

IMPORTANT:  The configuration dialog for QoS setting is only 
available under Microsoft Windows XP.

IMPORTANT:  Deploying the QoS service requires a QoS Packet 
Scheduler being active for the connection used.

NOTICE:  Please obtain further information about configuring the 
QoS settings and creating the QoS policies for the operating 
systems Microsoft Windows Vista SP1/Microsoft Windows 7/
Microsoft Windows 7 SP1 from the setup guide OpenScape 
Personal EditionV7 Installation and Administration.

If you wish to modify the QoS settings, select on the tab Advanced > SIP Service 
Provider > Quality of Service.

The displayed dialog shows the default settings for the following parameters:

• Layer 2: User priority acc. to IEEE802.1p
Under Microsoft Windows XP Professional SP2 and later you cannot perform 
any settings for Layer 2.

• Layer 3: Priority classes (Codepoint acc. to DiffServ)
Under Microsoft Windows XP Professional SP2 and later you can set the QoS 
values for the traffic types Call Signaling and Voice payload individually. You 
can use the Mark Packets option to individually define whether the data of 
the traffic types Call Signaling and Voice payload is furnished with the 
respectively set QoS values.
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• Restore Standard Settings
Click on this button if you want to reset the QoS settings to the default values.

NOTICE:  On a PC with Intel Centrino Duo processor, 
OpenScape Desktop Client will detect this automatically at 
runtime. In this case the OpenScape Desktop Client uses the QoS 
support provided by the Intel Centrino Duo processor.

NOTICE:  The PC needs to be rebooted for the QoS settings 
changes to become active.

2.3.5.20  Mobile User

NOTICE:  You can use the SIP Mobile User functionality only if a 
DLS server is available in your SIP communications system. 
Furthermore, the Use central configuration option must have 
been activated when setting up OpenScape Desktop Client. In 
addition, you need to enter the DLS configuration parameters for 
the central configuration on the tab Advanced > General > 
Central Configuration.

The DLS mobility concept enables assigning phone numbers of specific persons 
or person profiles instead of specific devices. In this way, OpenScape Desktop 
Client users can communicate with their contacts independent from the device 
used. When the device is changed, the user keeps his/her phone number and 
personal settings (e.g. individual ringtone). The DLS server administers for each 
mobile user a mobile-user profile, which consists of a mobility number and a 
mobile-user password.

SIP Mobile User Logon

An SIP Mobile User can log on to the OpenScape Desktop Client or at a device 
(e.g. office phone, mobile phone, laptop) with his/her mobile-user profile.

NOTICE:  Be sure to have a mobile-user profile in the DLS. 
Please consult your system administrator for further information.

If you are logged in at the OpenScape Desktop Client with your mobile-user 
profile, a corresponding message is displayed when you try to log on to another 
device. You are logged off from the communications system immediately after-
wards. The user interface, however, is visible until you click on OK. The message 
is closed and the OpenScape Desktop Client terminated.

If you are still conducting a call with OpenScape Desktop Client, there are two 
options, which depend on the DLS configuration:
A31003-G2570-U100-1-7619, 05/2012
OpenScape Personal Edition V7, User Guide 63



Configuration and Settings
“Advanced” Tab
• The active connection is immediately closed. You are logged off from the 
communications system afterwards. The user interface, however, is visible 
until you click on OK. The message is closed and the OpenScape Desktop 
Client terminated.

• After a pre-set time has expired, the active connection is automatically closed 
and you are logged off from the communications system. The user interface, 
however, is visible until you click on OK. The message is closed and the 
OpenScape Desktop Client terminated.

In the When the client is started and there is another user logged on with the 
same mobile number combo box you can define how the DLS server is to 
behave if you are logged in at another device or at OpenScape Desktop Client 
with your mobile-user profile at the time of the login at OpenScape Desktop Client 
or at a device.

• ask for confirmation
If you are logged in at a device with your mobile-user profile and this option is 
selected, a message is displayed at the OpenScape Desktop Client start. This 
message informs you, that you are already logged in at another device, which 
is indicated with its MAC address or assigned phone number, with the same 
mobile-user profile. Select Yes to log off from the other device and to start the 
OpenScape Desktop Client as mobile-user. Select No to abort logging on to 
the OpenScape Desktop Client.
If you are still conducting a call on the device, there are two options, which 
depend on the DLS configuration:

– The active connection is closed after a pre-set time and the OpenScape 
Desktop Client logs on to the communications system.

– Logging off from the device is denied by the DLS. You can try again after 
finishing the call.

• log them off without confirmation
You are automatically logged off from the other device, at which you are 
logged in at the time of the program start with the same mobile-user profile.

• do not start the client
The OpenScape Desktop Client is not started.
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During the first start of the program you are prompted to enter the Mobile User 
Password. Your entry is copied to the input field of the same name.

NOTICE:  If the specified Mobile User Password is incorrect, a 
corresponding error message appears. Thereafter, you can enter 
the password again.

NOTICE:  The program start is also abandoned if you do not have 
a valid mobile-user license or if the device has not been 
configured as mobility-enabled device in the DLS. A corre-
sponding error message is displayed.

NOTICE:  You can obtain further information about DLS and the 
DLS mobility concept from the administrator documentation of 
Deployment Service V3.0.

2.3.6  HiPath Provider Settings

NOTICE:  You cannot activate the HiPath Provider in combi-
nation with the Communication and Stimulus Provider 
modules.

You perform settings for the HiPath Provider to use the OpenScape Desktop 
Client as softphone at a HiPath 3000 or HiPath 4000. To edit the HiPath Provider 
settings, select in the left-hand area of the tab Advanced > HiPath Provider.

You can configure the following settings for the HiPath Provider:

2.3.6.1  Device

NOTICE:  To edit the device settings you need to open the 
Settings dialog during the program start. Click on the Manage 
button in the login dialog for this purpose.

To display the freephone of OpenScape Desktop Client and the extended keypad, 
you can choose from various device types for phone and key module.

To set the desired device type, select on the tab Advanced > HiPath Provider 
the Device option.
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• Phone type
Select your phone type in this combo box. Phone type determines also the 
following properties for the free and integrated phone of OpenScape Desktop 
Client:

– How many display lines are indicated in the OpenScape Desktop Client 
freephone (in the integrated phone of the main bar always two display 
lines are shown).

– Whether Electronic Key Labeling (EKL) is available for the OpenScape 
Desktop Client.

– How many feature keys are available in the free and integrated telephone 
of OpenScape Desktop Client.

– How many programmable feature keys are available in the extended 
keypad of OpenScape Desktop Client.

• Key module type
This combo box lets you define type of your key module and determine the 
following key module properties:

– Whether Electronic Key Labeling (EKL) is available for the key module 
columns in the extended keypad.

– How many programmable feature keys are available in the key module 
columns of the extended keypad in OpenScape Desktop Client.

• Maximum number of key modules
This combo box specifies how many key module columns are displayed in the 
extended keypad at the most. Possible values range from 0 to 4. Value 0 
means that the extended keypad remains empty, and 4 means that a 
maximum of four key module columns is displayed in the extended keypad.

2.3.6.2  Main Connection

NOTICE:  To edit the main connection settings you need to open 
the Settings dialog during the program start. Click on the Manage 
button in the login dialog for this purpose.

The main connection configuration defines the connection properties between 
OpenScape Desktop Client and the main communication system. 

To configure the failover parameters, select on the tab Advanced > HiPath 
Provider the Main connection option.
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• Type
Select your PBX type in this combo box. Available are HiPath 2000/3000/
5000 and HiPath 4000.

NOTICE:  For connecting an OpenScape Office MX select the 
option HiPath 2000/3000/5000.

NOTICE:  Select option HiPath 4000 for connecting an HiPath 
4000 V3/V4/V5/V6.

• Gatekeeper
Enter the IP address of the communications system gatekeeper.

• Extension number
Enter the number under which you can be reached on the connected commu-
nications system.

• Password
Specify the password configured for your extension number.

• ACD agent number
If available, enter your ACD agent number.

• Emergency call number
Specify the emergency call number. Your system administrator will provide 
information on this.

• Own IP address
Via this combo box you familiarize the OpenScape Desktop Client with the 
own IP address. 

– If an own IP address is assigned to the network card of the user PC, select 
the Detect automatically setting here.

– If several IP addresses are assigned to the network board of the user PC, 
they are all listed in this combo box. Select the desired IP address.

In the Security section you can perform the following settings:
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• Mode
From this combo box you can select the security mode that is also selected 
as security mode on the connected communications system.

• Gatekeeper ID
Specify the Gatekeeper ID already configured on your PBX.

• Time window
Under this option you can enter the time in seconds. Your system adminis-
trator will provide information on this.

NOTICE:  You can obtain more detailed information about these 
parameters from your system administrator.

2.3.6.3  Main Network Access

NOTICE:  To edit the main network access settings you need to 
open the Settings dialog during the program start. Click on the 
Manage button in the login dialog for this purpose.

Network access settings must be entered if call number normalization is active. 
Network access settings (location information) are needed for setting up a direct 
connection to telephone numbers from OpenScape Desktop Client directories or 
call lists. These settings are also used for converting call numbers into interna-
tional dialable format. If these settings are not configured properly, you may 
encounter problems when setting up connections. Network access settings are 
not needed if call number normalization is not active.

Select the HiPath Provider option on the Advanced tab and open the Main 
network access dialog to configure the network access settings. The parameters 
you see in the figure are only examples.

• Country code
Enter here the international prefix for your location, e. g. for Germany 49.
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• Area code
Enter here the telephone prefix for your location in the national phone number 
scope. Omit the leading zero for this entry.

• System identification number
Enter the system identification number. This system ID number identifies 
internal call numbers in the directories that only set up internal connections 
when selected.

• Extension range
Specify the extension range of your network in the form of a regular 
expression.
Example:
You have been assigned the system identification number with the numbers 
0049 35 12345-2000 to 0049 35 12345-4999. In this case the extension range 
reads 2000 to 4999. Enter the following in the Extension range field for these 
phone numbers: \b[2-4][0-9]{3}\b.

– \b - the number must begin with a blank

– [2-4] - the first digit may be a character between 2 and 4 inclusive, thus 2, 
3, 4

– [0-9]{3} - for the next three digits, numbers 0 to 9 are allowed

– \b - the number must end with a blank

• Office code
Enter here the code that has been configured on your system or on your PBX 
to allocate trunks for outgoing connections.

• Prefix for local calls, Prefix for long distance calls, Prefix for interna-
tional calls
Enter the network operator ID for the respective call type in the corresponding 
fields. For example, in Germany no Prefix for local calls is used, while for 
other countries in Europe, and members of the NANP (North American 
Numbering Plan) the zero is used to mark local calls. For example, in 
Germany the prefix for long distance calls is 0 and the prefix for interna-
tional calls is 00. This data is independent from the configuration of the 
connected communications system and determined by the network operator.

• Additional code for local calls, Additional code for long distance calls, 
Additional code for international calls
Enter additional digits to be used as call-by-call prefixes in the fields. This data 
is independent from the configuration of the connected communications 
system.
The sequence of the various codes is as follows:
<office code><additional code><prefix><phone number>

Test

Click on the Test... button to open the following dialog and test your entries.
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• Extension to be dialed
Enter the number to be dialed in this entry field. Based on the currently set 
parameters the OpenScape Desktop Client determines the phone number in 
international format.

• Converted internationally
The phone number entered in the above field is automatically displayed in this 
field.

• Effectively dialed
This field displays automatically the actually dialed number. Depending on the 
set network access parameters the number may be shorter, e.g., if an internal 
phone number has been recognized.

2.3.6.4  Fallback Connection

NOTICE:  To edit the fallback connection settings you need to 
open the Settings dialog during the program start. Click on the 
Manage button in the login dialog for this purpose.

NOTICE:  You only need to perform the fallback system settings 
if you operate the OpenScape Desktop Client with a fallback 
system. The configuration of the fallback connection defines the 
connection properties between and the OpenScape Desktop 
Client and the fallback communication system.

To configure the failover parameters, select on the tab Advanced > HiPath 
Provider the Fallback connection option.
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• Type
Select the fallback system type in this combo box. The following options are 
available: No fallback system and HiPath 4000.

NOTICE:  The significance of the further parameters for the 
fallback connection corresponds to the significance of the param-
eters for the main connection. They do not, however, refer to the 
main but to the fallback communication system.

• Gatekeeper
Enter the IP address of the fallback system gatekeeper in this field.

• Extension number
Enter the number under which you can be reached on the fallback system in 
this field.

• Password
Specify the password configured for your extension number on the fallback 
system in this field.

• ACD agent number
If available, enter your ACD agent number.

• Emergency call number
Specify the emergency call number. Your system administrator will provide 
information on this.

• Own IP address
Select your own IP address or Detect automatically in this combo box.

In the Security section you can perform the following settings:

• Mode
From this combo box you can select the security mode that is also selected 
as security mode on the connected communications system.

• Gatekeeper ID
Specify the Gatekeeper ID already configured on your PBX.
A31003-G2570-U100-1-7619, 05/2012
OpenScape Personal Edition V7, User Guide 71



Configuration and Settings
“Advanced” Tab
• Time window
Under this option you can enter the time in seconds. Your system adminis-
trator will provide information on this.

NOTICE:  You can obtain more detailed information about these 
parameters from your system administrator.

2.3.6.5  Fallback Network Access

NOTICE:  To edit the fallback network access settings you need 
to open the Settings dialog during the program start. Click on the 
Manage button in the login dialog for this purpose.

NOTICE:  You only need to perform the fallback network access 
settings if you operate the OpenScape Desktop Client with a 
fallback system.

Select on the tab Advanced > HiPath Provider the Fallback network access 
option to configure the fallback network access settings. The parameters you see 
in the figure are only examples.

NOTICE:  The settings of the fallback network access parameters 
correspond to those for the main network access but do not refer 
to the main but to the fallback communication system.

• Country code
Enter here the international prefix for your location, e.g. for Germany 49.

• Area code
Enter here the telephone prefix for your location in the national phone number 
scope. Omit the leading zero for this entry.
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• System identification number
Enter the system identification number. This system ID number identifies 
internal call numbers in the directories that only set up internal connections 
when selected.

• Extension range
Specify the extension range of your network in the form of a regular 
expression.
Example:
You have been assigned the system identification number with the numbers 
0049 35 12345-2000 to 0049 35 12345-4999. In this case the extension range 
reads 2000 to 4999. Enter the following in the Extension range field for these 
phone numbers: \b[2-4][0-9]{3}\b.

– \b - the number must begin with a blank

– [2-4] - the first digit may be a character between 2 and 4 inclusive, thus 2, 
3, 4

– [0-9]{3} - for the next three digits, numbers 0 to 9 are allowed

– \b - the number must end with a blank

• Office code
Enter here the code that has been configured on your system or on your PBX 
to allocate trunks for outgoing connections.

• Prefix for local calls/long distance calls/international calls
Enter the network operator ID for the respective call type in the corresponding 
fields. For example, in Germany no Prefix for local calls is used, while for 
other countries in Europe and members of the NANP (North American 
Numbering Plan) the zero is used to mark local calls. For example, in 
Germany the prefix for long distance calls is 0 and the prefix for interna-
tional calls is 00. This data is independent from the configuration of the 
connected communications system and determined by the network operator.

• Additional code for local calls/long distance calls/international calls
Enter the additional digits to be used as call-by-call prefixes in the fields. This 
data is independent from the configuration of the connected communications 
system.
The sequence of the various codes is as follows: 
<office code><additional code><prefix><phone number>

Test

Click on the Test... button to open the following dialog and test your entries.

• Extension to be dialed
Enter the number to be dialed in this entry field. Based on the currently set 
parameters the OpenScape Desktop Client determines the phone number in 
international format.
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• Converted internationally
The phone number entered in the above field is automatically displayed in this 
field.

• Effectively dialed
This field displays automatically the actually dialed number. Depending on the 
set network access parameters the number may be shorter, e.g., if an internal 
phone number has been recognized.

2.3.6.6  Failover

NOTICE:  To edit the failover settings you need to open the 
Settings dialog during the program start. Click on the Manage 
button in the login dialog for this purpose.

If you use the OpenScape Desktop Client with a failover communication system, 
then OpenScape Desktop Client will be automatically switched to the specified 
fallback communication system if the main communication system fails. After this 
switch, OpenScape Desktop Client in regular intervals attempt to reach and 
reconnect to the main communication system again.

To configure the failover parameters, select on the tab Advanced > HiPath 
Provider the Failover option.

Determine the values for the following parameters:

• Under Number of failed connection attempts to the primary system 
before you are switched to the fallback system in case of failure you 
specify after how many failed connection attempts OpenScape Desktop 
Client will switch from the main to the fallback communication system.

• Under Waiting time between connection attempts you specify in which 
intervals the OpenScape Desktop Client attempts to reach the main commu-
nications system again.

• Under Minimum number of successful connection attempts to primary 
system to switch back you specify after how many successful connection 
attempts the main communication system is to be considered operable again. 
The OpenScape Desktop Client will not switch back to the main communi-
cation system until it is considered operable.
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• Under Waiting time between connection attempts you specify in which 
intervals the OpenScape Desktop Client attempts to reach the main commu-
nication system again.

• With the No automatic switch back to primary system option you 
determine whether OpenScape Desktop Client automatically switches back 
to the main communication system as soon as it is operable again. If you 
activate the checkbox of this option, the OpenScape Desktop Client does not 
automatically switch back to the main communication system.

2.3.6.7  Ring Tones

Alternatively to the default ring tones determined by the ring tone color set in the 
PBX, you can select an individual ring tone for signaling incoming calls. 
Compatible ring tone files must comply with the following requirements:

• The ring tone file must be available in WAV or MP3 format.

• The file size must not exceed 2 MB. If you configure a bigger ring tone file as 
ring tone, only the first 2 MB of this file are played.

To configure an individual ring tone, select on the tab Advanced > HiPath 
Provider > Ring tones.

NOTICE:  You can edit the settings for the individual ring tone via 
the Settings dialog during the program start or during live 
operation. Click on the Manage button in the login dialog or select 
in the Pearl menu > Personal Settings > Ring Tones.

• Via the Use individual ring tones option you activate an individual ring tone. 
After you have activated this option, the OpenScape Desktop Client uses the 
tone specified under File to signal incoming calls.

• Under File you define the WAV or MP3 file that contains the desired ring tone. 
Via the browse button ... you can look for the desired file.

NOTICE:  OpenScape Desktop Client copies the content of the 
selected WAV or MP3 file. In this way the ring tone is still available 
even if the original sound file is deleted.
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2.3.6.8  Bandwith Reduction

NOTICE:  To edit the bandwith reduction settings you need to 
open the Settings dialog during the program start. Click on the 
Manage button in the login dialog for this purpose.

You can optimize the voice transmission quality by adjusting various settings to 
the current environment of your network setup.

To configure the voice transmission parameters, select on the tab Advanced > 
HiPath Provider > Bandwidth reduction.

The OpenScape Desktop Client displays the default settings. Do not change them 
without instructions from your system administrator.

• Disable DMC
If you operate the OpenScape Desktop Client with a HiPath 4000 PBX, voice 
packets are directly exchanged between the communication partners via the 
network (Direct Media Connect - DMC). If required, you can deactivate this 
behavior by disabling this checkbox. This will stop the direct exchange of 
voice packets between the communication partners. You can activate this 
option if you operate the OpenScape Desktop Client e.g. from a home office.

• Teleworking
If you work at home, activate the Teleworking checkbox. This sets the 
Suppress cyclical control message checkbox automatically. In this way 
you reduce the data volume on the trunk line and thus the bandwidth demand 
in teleworking mode.

NOTICE:  You need to disable this option to operate the 
OpenScape Desktop Client at an OpenScape Voice/Cisco proxy, 
since the communications system cannot send any busy-lamp 
field (BLF) messages.
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• Codec sequence
Communication between the OpenScape Desktop Client and the communi-
cations system is based on defined compression algorithms (codecs) for the 
network transmission of audio signals via the network. Using this combo box 
you can determine the sequence of the codecs for the voice connection.
Select the setting suitable for your location in the Codec sequence combo 
box.

NOTICE:  When you activate the Teleworking option, a different 
selection is available.

• Codec packet lengths
The respective voice packet lengths for the codecs G.711, G.723 and G.729 
are individually defined in milliseconds in this section.
Select a value in each of the three codecs' combo boxes. The values are 
indicated in milliseconds (ms).

• Jitter Buffer (ms)
To avoid voice packet loss, which can result in poor voice quality and 
dropouts, set the buffer size in this field. The jitter buffer caches all incoming 
voice packets for the period set and then forwards them to the audio device’s 
sound output. The jitter buffer continues to forward voice packets until none 
are left, even if the network does not deliver new voice packets quickly 
enough. This avoids dropouts.
Select a value in the Jitter Buffer (ms) combo box. The values are indicated 
in milliseconds (ms).

Specialties when selecting the Jitter Buffer

When selecting the optimum setting for the jitter buffer please note the following:

• The better the network quality, the smaller the jitter buffer may be.

• The bigger the jitter buffer, the more the voice transmission will be delayed.

• We recommend to set the jitter buffer to value 60.

With a click on the Restore Standard Settings button you can reset the values 
to the default settings.

2.3.6.9  Port Restrictions

NOTICE:  To edit the port restrictions settings you need to open 
the Settings dialog during the program start. Click on the Manage 
button in the login dialog for this purpose.

To determine the port restrictions settings in firewall environments, select on the 
tab Advanced > HiPath Provider > Port restrictions.
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The OpenScape Desktop Client displays the default settings. Do not change them 
without instructions from your system administrator.

• Gatekeeper CornetIP Port
The communications port, which supports signaling and voice connections for 
CorNet-IP via a gatekeeper, is defined by activating this field.

• PC-CorNetIP Port range
The communications ports, which support signaling and voice connections 
between a PC and CorNet-IP, are defined by activating the fields from and to 
of the PC-CorNetIP Port range option.

• RTP port range from/to
In these entry fields you specify the values that define the range of the RTP 
ports used for signaling and voice connections.

• H.245 port range from/to
In these entry fields you specify the values that define the range of the H.245 
ports used for signaling and voice connections.

• H.225-Signaling
In this entry field you specify the value used for the signaling connections.

NOTICE:  If no voice transmission is possible during operation 
despite a correct logon, make sure that the RTP port range is 
configured between 1024 and 65353.

• With a click on the Restore Standard Settings button you can reset the 
values to the default settings.

2.3.6.10  VPN

NOTICE:  To edit the VPN (Virtual Private Network) settings you 
need to open the Settings dialog during the program start. Click 
on the Manage button in the login dialog for this purpose.
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The OpenScape Desktop Client informs its active connection partners at specific 
times about the individual IP address – e.g. for correctly addressing the audio 
packets. For this purpose, OpenScape Desktop Client needs to know the current 
IP address, respectively, how it can be determined.

Under Advanced > HiPath Provider > VPN you can define the behavior of the 
OpenScape Desktop Client in a VPN (Virtual Private Network). 

Virtual Private Network (VPN)

In this combo box you define whether or not you have a VPN. The following 
settings can be made:

• none – No VPN is used or you use a VPN where the VPN client provides a 
virtual network adapter for the VPN tunnel.

• automatic – VPN is used, the IP address is determined by the OpenScape 
Desktop Client.

NOTICE:  If the VPN client does not provide a virtual network 
adapter on the PC on which the OpenScape Desktop Client is 
installed, you need to select the automatic option.

• manual – You need to enter the IP address of the OpenScape Desktop Client 
assigned by the VPN in the corresponding field.

2.3.6.11  Quality of Service (QoS)

IMPORTANT:  Deploying the QoS service requires a QoS Packet 
Scheduler being active for the connection used.

If you wish to modify the QoS settings, select on the tab Advanced > HiPath 
Provider > Quality of Service (QoS).
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For the transmission level Layer 2: User Priority acc. to IEEE802.1p and Layer 
3: Priority classes (Codepoint acc. to DiffServ) you can use the Mark Packets 
option to individually define whether the data of the traffic types Call Signaling 
and Voice payload is furnished with the respectively set QoS values.

The QoS settings depend on the operating system used.

• Layer 2: User priority acc. to IEEE802.1p

– Under Microsoft Windows XP Professional SP2 and later you cannot 
perform any settings for Layer 2.

– Under Microsoft Windows Vista/7 you cannot perform any settings for 
Layer 2. The configuration of the Mark Packets option is automatically 
adjusted to the setting for Layer 3.

• Layer 3: Priority classes (Codepoint acc. to DiffServ)

– Under Microsoft Windows XP Professional SP2 and later you can set the 
QoS values for the traffic types Call Signaling and Voice payload 
individually. The default value for the traffic type Call Signaling is AF31 
and for Voice payload EF.

– Under Microsoft Windows Vista/7 you can only activate/deactivate the 
Mark Packets option. The operating system defines the combo boxes 
Call Signaling and Voice payload automatically via the new network 
platform qWAVE (Quality Windows Audio/Video Experience) for audio 
and video streaming applications in private IP networks. TrafficTypes are 
used instead of Codepoint acc. to DiffServ . The TrafficType for call 
signalling is QOSTrafficTypeControl, which corresponds to the 
CodePoint acc. to DiffServ 0x38 (CS7). The TrafficType for voice and 
video data is QOSTrafficTypeVoice, which corresponds to the CodePoint 
acc. to DiffServ 0x38 (CS7). The combo boxes Call Signaling and 
Voice payload are therefore default set with value CS7 and cannot be 
changed.

• Restore Standard Settings
Click on this button if you want to reset the QoS settings to the default values.

NOTICE:  On a PC with Intel Centrino Duo processor, 
OpenScape Desktop Client will detect this automatically at 
runtime. In this case the OpenScape Desktop Client uses the QoS 
support provided by the Intel Centrino Duo processor.

NOTICE:  The PC needs to be rebooted for the QoS settings 
changes to become active.
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2.3.6.12  Operation Settings

NOTICE:  The Operation settings entry is only available when 
you invoke the Settings dialog with a started OpenScape 
Desktop Client. Select the HiPath option in the context menu of 
the Windows taskbar for this purpose.

If you use default ring tones, you can change the pitch of the ring tone in the 
operation settings. Select on the tab Advanced > HiPath Provider > Operation 
settings. 

NOTICE:  This feature is not available when you have selected an 
individual ring tone.

You can use the Change Ring Tone button you can modify the ringer pitch of the 
default ring tones.

You hear the ring tone currently set. Via the Next ring tone and Previous ring 
tone buttons you can individually set the ringer pitch. A click on Close closes the 
configuration dialog for these settings. The setting you have selected last is 
immediately active.

2.3.6.13  Security

NOTICE:  These settings are centrally configured and cannot be 
modified in the OpenScape Desktop Client. More details about 
how to display these settings is provided in the manual 
OpenScape UC Application V7 OpenScape Desktop Client 
Installation and Administration.

If the system times of the OpenScape Desktop Client and the PBX are not 
identical or differ from each other too much, signaling and voice encryption may 
cause problems during the login or connection setup. You can use the security 
settings to compare the system times and detect time zone errors. What's more, 
you can determine if the code was changed and when this happened last.

NOTICE:  These settings are centrally configured and cannot be 
modified in the OpenScape Desktop Client. 

After the HiPath Provider module has been activated and the OpenScape 
Desktop Client started, click the OpenScape Settings button in the Pearl menu 
to see the Security entry on the tab Advanced > HiPath Provider.
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• Current time (UTC)
These settings correspond to the current system time (tt.mm.jjjj 
hh:mm:ss) of the OpenScape Desktop Client PC in UTC (= GMT).

• Current time (local)
These settings correspond to the current system time (tt.mm.jjjj 
hh:mm:ss) of the OpenScape Desktop Client PC in local time.

• Current mode
The entry in this field specifies whether the encryption is active (Encryption 
ON) or inactive (Encryption OFF).

• Current activation (UTC)
This entry field specifies the time when the current mode was activated in 
UTC (= GMT).

• Current activation (local)
This entry field specifies the time when the current mode was activated in 
local time.

• Next mode
The next applicable encryption mode is displayed in field.

• Next activation (UTC)
This entry field specifies the time when the next mode was activated in UTC 
(= GMT).

• Next activation (local)
This entry field specifies the time when the next mode was activated in local 
time.

NOTICE:  If you operate the OpenScape Desktop Client without 
central configuration, signaling and voice data is usually 
unencrypted.
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2.3.7  Stimulus Provider Settings

NOTICE:  You can perform the Stimulus Provider settings only via 
the dialog Logon > Manage button > Settings.

The Stimulus Provider ensures displaying information about the conversational 
partner (phone number or name, connection duration) and about the available 
telephony features (e.g. call transfer, consultation, etc.) on the display of the 
integrated phone, free phone or softphone. Furthermore it enables automatically 
setting up the connection to a number specified by the user after a configurable 
waiting period has expired.

NOTICE:  The Stimulus Provider module cannot be activated in 
combination with the HiPath Provider.

The following settings are possible:

2.3.7.1  General Stimulus Provider Settings

You reach these settings on the tab Advanced > Stimulus Provider > General.

If you enter a phone number but do not click on , the OpenScape Desktop 
Client can automatically establish the connection to the entered phone number 
after a specified period.

• Time limit (ms)
Specify here a period after which the OpenScape Desktop Client establishes 
automatically a connection to the entered number. Value 0 means that the 
connection is not automatically set up.

2.3.7.2  Display

You reach these settings on the tab Advanced > Stimulus Provider > Display.

• Call state
The settings in this section refer to displays during an active call. If you want 
the Caller-Id and/or the Call Duration to appear, activate the respective 
option.
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• Ringing state
The settings in this section refer to displays during a connection request. If 
you want the Caller-Id to appear then, activate this option.

2.3.8  SQLite Provider Settings

The SQLite Provider enables connecting OpenScape Desktop Client to external 
directories via an SQLite database. Thus you can search external directories for 
contacts and resolve phone numbers on the basis of external directories.

NOTICE:  You can edit the SQLite Provider settings only if the 
Settings dialog is opened during the program start. To open this 
dialog, click on the Manage button in the user login dialog during 
the program start.

NOTICE:  For the time being, the SQLite Provider allows 
connecting Microsoft Outlook directories and Lotus Sametime 
contact lists to OpenScape Desktop Client. 

NOTICE:  So that the SQLite Provider can access the Microsoft 
Outlook directories or the IBM Lotus Notes contact list, the 
respective client and subsequently OpenScape Desktop Client 
must be started after the installation of OpenScape Desktop 
Client.

You can perform and edit the settings for SQLite directories on the tab Advanced 
> SQLite Provider > SQLite Directories.

2.3.8.1  SQLite Directories

The SQLite directories OpenScape Desktop Client uses to search for contacts 
and resolve phone numbers are configured and edited in the following dialog.
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The left-hand section of this dialog displays a list of all configured SQLite direc-
tories.

On the right, controls for configuring SQLite directories are available:

• Add...
A click on this button opens the dialog for configuring a new SQLite directory. 
The small triangle on the button lets you select pre-configurations for the 
supported connections.

• Edit...
This button opens the configuration dialog for the SQLite directory selected in 
the directory list so that you can change the settings.

• Remove
Using this button you can remove the SQLite directory selected in the SQLite 
directory list from the list or configuration of the SQLite Provider.

• Enable
This button activates the SQLite directory selected in the directory list.

• Disable
This button deactivates the SQLite directory selected in the directory list.

The configuration dialog, which you reach via the Add... or Edit... button, 
provides the following options:

• Name
Specify here the name under which the SQLite directory is managed in the 
OpenScape Desktop Client configuration.
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• File
Here you specify the file name of the SQLite database to be used for the 
SQLite directory.

• Browse...
If you do not know the name of the desired file you can click on the Browse… 
button to open a search dialog and look for available SQLite databases.

• Test
This button starts a test for checking the connection to the SQLite database.

2.3.9  Settings for the LDAP Directory Provider

The LDAP Directory Provider enables connecting OpenScape Desktop Client to 
external LDAP directories. Such a connection is used for resolving phone 
numbers.

NOTICE:  You can edit the LDAP directory settings only if the 
Settings dialog is opened during the program start. To open this 
dialog, click on the Manage button in the user login dialog during 
the program start.

The directories OpenScape Desktop Client is to use for resolving phone numbers 
must have been previously configured in the LDAP Directory Provider. Select on 
the tab Advanced > LDAP Directory Provider > LDAP Directories for this 
purpose.

2.3.9.1  LDAP Directories

The directories OpenScape Desktop Client uses for resolving phone numbers are 
configured and edited in the following dialog.

The left-hand section of this dialog displays a list of all configured LDAP direc-
tories.

On the right, controls for configuring LDAP directories are available.
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• Add...
A click on this button opens the dialog for configuring a new LDAP directory. 
In there you can define various directory parameters.

• Edit...
A click on this button opens the configuration dialog for the LDAP directory 
selected in the directory list. In there you can change the settings performed 
for the directory.

• Remove
A click on this button removes the selected LDAP directory from the directory 
list or from the configuration of the LDAP Directory Provider.

• Enable
A click on this button activates the LDAP directory selected in the directory 
list. It can be directly used for phone number resolution.

• Disable
A click on this button deactivates the LDAP directory selected in the directory 
list. It cannot be used for phone number resolution.

The configuration dialog for entering the directory parameters is divided into three 
tabs:

• General

On this tab you define the basic settings for the directory management within 
OpenScape Desktop Client and for accessing the LDAP directory.

– Name
Specify here the name under which the LDAP directory is managed in 
OpenScape Desktop Client.

– Server
In this input field you specify the host name of the LDAP server on which 
the LDAP directory is available. Instead of the host name you can also 
enter the IP address of the LDAP server.

– Port
In this field you define the port number under which the LDAP server is 
accessed. The default value is here the entry 389.
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– Search base
If only part of the LDAP directory shall be shared for access, you can 
define an LDAP search base here. You find detailed information about the 
search base of an LDAP directory in the OpenScape Desktop Client setup 
guide.

– Server requires authentication
This option activates the authentication of OpenScape Desktop Client 
when the LDAP directory is accessed. If you select this option, entries can 
be made in the following fields User account and Password.

– User account
Defines the ID for accessing the LDAP server.

– Password
Defines a password as far as it is required for access under the specified 
ID.

– Exact match for phone numbers
Determines the criterion applied when looking for phone numbers during 
an LDAP directory search. If this option is active, phone numbers are 
searched for that exactly correspond to the specified search criterion.
Example:
A search based on the criterion +492404901100 finds only database 
entries with phone numbers in exactly this format but no database entries 
of the format +49 (0489) 901-100.
If this option is inactive, special characters in phone numbers of database 
entries are ignored during a search. In the above example, the phone 
number +49 (0489) 901-100 would also be a search hit.

– Search for prefixes
If this option is active, the search expressions of every LDAP search are 
internally prefixed with the wildcard character *.
Example:
The LDAP directory is searched for the expression Sample under Full 
Name.
Depending on whether or not the Search for prefixes option is active, the 
following example entries are found or not found:

– Test
This button starts a connection test with the specified data. A message will 
then inform you whether or not the test was successful.

• Mapping
On this tab you define how OpenScape Desktop Client maps the structure of 
the LDAP directory on the proprietary, internal data structure. 

LDAP entry Active search for 
prefixes

Inactive search for 
prefixes

Sample, Monica

Sampler, Monica

Monica Sample

Monica Sampler
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To do this, assign appropriate LDAP attributes to the OpenScape Desktop 
Client criteria in the right-hand column.

• Number
On this tab you define the LDAP attribute that OpenScape Desktop Client 
uses for resolving a phone number in a name.

The specified attribute must contain the phone number of the respective 
contact.

NOTICE:  To ensure that phone number resolution via an LDAP 
directory works correctly, the phone numbers must be entered in 
the defined attribute in normalized format, e.g. 490489901100.
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2.3.9.2  Base DN for an LDAP Directory

With integrating an LDAP directory in OpenScape Desktop Client, you can define 
a Base DN in the scope of the directory configuration. On the basis of this Base 
DN, LDAP directory entries are searched for and displayed in the OpenScape 
Desktop Client.

NOTICE:  If you do not define a Base DN, the entire LDAP 
directory is used as search base.

You can define the Base DN in the corresponding entry field of the Add Directory 
in two possible formats:

• <Level name 3>=<Name>, <Level name 2>=<Name>, <Level name 
1>=<Name>

• <Level name1>=<Name>/<Level name 2>=<Name>/<Level name 
3>=<Name>

An LDAP directory shall be filtered for all users of the corporate unit ICN. The 
directory to be integrated shall have the following structure:

• Name of level 1: C (e.g. country code)

• Name of level 2: O (e.g. company name)

• Name of level 3: OU (e.g. corporate unit).

OpenScape Desktop Client is only to access directory entries for which the 
following applies:

• Level 1: C=DE

• Level 2: O=ENTERPRISE

• Level 3: C=ICN.

According to these defaults the following is to be entered for the Base DN:

• OU=ICN,O=ENTERPRISE,C=DE

or alternatively

• C=DE/O=ENTERPRISE/OU=ICN.

2.3.10  Local-Journal-Provider Settings

NOTICE:  To edit the Local-Journal-Provider settings you need to 
open the Settings dialog during the program start. Click on the 
Manage button in the login dialog for this purpose.

Via this module connection data for the journal are stored in the local database. 
These data records are automatically deleted after a specific period or when a 
certain maximum number of data records has been reached. You can perform the 
Local-Journal-Provider settings on the tab Advanced > Local Journal Provider 
> General .
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Activate the check box of the desired option to apply the default value or to 
change it if necessary. By default the maximum number of the data records is set 
to 300 and the maximum age of these data records is set to 90 days.

2.3.11  HLM License Provider Settings

If you want to use the OpenScape Desktop Client as softphone at an SIP or HFA 
communications system, you need to have the matching SIP or HFA licenses. 
These licenses are generated by a central license server and managed by a 
License Agent server (Customer License Agent).

The HLM License Provider is the licensing component of the OpenScape 
Desktop Client. Every time the program starts the provider checks whether a valid 
license exists for the program. For this purpose it connects to the License Agent 
server (CLA), which must have been set up either on the local user PC or on a 
central PC in the network.

NOTICE:  You find more information about licensing of 
OpenScape Desktop Client in the OpenScape Desktop 
Client Installation und Administration setup guide.

Select on the tab Advanced > HLM License Provider  > Licensing to perform 
the settings for the connection to the License Agent (CLA) server.

• Server
Specify in this input field the IP address of the PC on which the License Agent 
(CLA) server for the OpenScape Desktop Client is installed. If the License 
Agent (CLA) server is installed locally, enter the local IP address or the 
address of the local host. If the License Agent (CLA) server is installed on the 
network, the IP address in the network.

• Port
Enter here the default port number for accessing the License Agent (CLA) 
server. It is 61740.
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• Timeout (ms)
Specify in this field the maximum time (in milliseconds) an attempt to set up a 
connection to the License Agent (CLA) server may take.

• Attempts
Use this field to determine the number of connection setup attempts. 

• Password
If an access password has been defined on the License Agent (CLA) server, 
enter that password here as well.

NOTICE:  If no License Agent (CLA) server has been configured 
or the OpenScape Desktop Client cannot connect the License 
Agent (CLA) server owing to e.g. invalid parameters, the program 
start is aborted and a corresponding message displayed.

2.3.12  IBM Lotus Notes Provider Settings

The IBM Lotus Notes Provider provides the connection to a IBM Lotus Notes 
client.

It enables you to access the following features:

• Searching IBM Lotus Notes address books for contacts

• Making calls in the IBM Lotus Notes client

• Resolving phone numbers and names on the basis of IBM Lotus Notes 
address books.

You can perform and edit the IBM Lotus Notes Provider settings only during the 
program start. To do this, click on the Manage button and select the tab 
Advanced > IBM Lotus Notes Provider in the Settings dialog.

NOTICE:  Details specific to IBM Lotus Notes are required for 
configuring the IBM Lotus Notes Provider. You receive such 
details from the administrator of your IBM Lotus Notes system.

You can perform settings for the following areas:

• IBM Lotus Notes Databases

• Authentication

2.3.12.1  IBM Lotus Notes Databases

To use the IBM Lotus Notes Provider you need to specify the IBM Lotus Notes 
databases to be deployed.

To specify the IBM Lotus Notes databases, select in the Settings dialog on the tab 
Advanced > IBM Lotus Notes Provider > IBM Lotus Notes Databases.
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The following options are available for specifying the IBM Lotus Notes databases:

• <Database list>
This list contains all databases configured in the IBM Lotus Notes Provider.

• Add...
A click on this button opens the dialog for configuring a new IBM Lotus Notes 
database to be used in the IBM Lotus Notes Provider.

• Edit...
This button lets you edit the settings of an already defined IBM Lotus Notes 
database selected in the database list. The configuration dialog that opens for 
editing a database features the same settings as the dialog for configuring a 
new IBM Lotus Notes database.

• Remove
With a click on this button you can remove a selected IBM Lotus Notes 
database from the database list.

• Enable
You can use this button to activate a database selected in the database list.

• Disable
You can use this button to deactivate a database selected in the database list.

2.3.12.2  Dialog for Configuring a IBM Lotus Notes Database

In this configuration dialog you can specify the settings for a IBM Lotus Notes 
database to be used in the IBM Lotus Notes Provider. You reach the dialog on the 
tab Advanced > IBM Lotus Notes Provider > IBM Lotus Notes Databases with 
a click on the Add... button.
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The settings are divided into the following tabs:

"General" Tab

On this tab you define the general settings of the IBM Lotus Notes database.

Such settings comprise:

• Configuration name
Specifies the name under which the relevant database entry is managed in 
the database list. It is independent from the database name under IBM Lotus 
Notes.

• Use local database
Select this option to configure a local database for the IBM Lotus Notes 
integration.

• Use server database
Select this option to configure a server database for the IBM Lotus Notes 
integration.
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• Server name
Specifies the name of the Lotus Domino server on which the desired server 
database is available. The field provides a selection list with available servers. 
If you wish to configure a server name not contained in the list, you can enter 
it in the text field directly.

NOTICE:  This field is evaluated only if the Use server database 
option is selected.

• Additional Server
If the desired database is provided by other Lotus Domino servers also, you 
can specify such servers in this field. This setting can be useful e.g. for a IBM 
Lotus Notes cluster.

• Database name
Specifies the name under which the desired database is available on the 
server or on the user PC. If you do not know the database name, you can 
open a search dialog via the associated Browse… button. In there you can 
then look for available databases.

• Test
A click on this button starts a check as to whether a connection to the 
specified database can be set up.

"Mapping" Tab

To enable OpenScape Desktop Client processing the information of a IBM Lotus 
Notes database correctly, the attributes of the IBM Lotus Notes database must be 
assigned to the corresponding directory fields (criteria) of OpenScape Desktop 
Client. You perform this assignment on the Mapping tab.

If a new database is created, the pre-set assignment corresponds to the default 
assignment.

• Criterion
This column shows the criteria available in OpenScape Desktop Client.

• IBM Lotus Notes Field
In this column you can assign the attributes of the IBM Lotus Notes database 
to the various criteria of OpenScape Desktop Client.
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• Test
A click on this button starts a check as to whether the attributes specified in 
the mapping exist in the documents of the specified database. OpenScape 
Desktop Client searches the specified database and checks the first found 
IBM Lotus Notes document that is based on the view displayed in the test 
dialog and on the form possibly defined. If the specified attributes are 
contained in this document, the test terminates successfully. If the mapping 
includes attributes that do not exist in the checked document, the test will 
point to this discrepancy. However, such a message does not necessarily 
point out an error, because OpenScape Desktop Client always searches only 
the first found document.

"Number" Tab

The Number tab contains settings for resolving phone numbers in names via the 
relevant database.

• Server name
Displays the server name you defined on the General tab. No server name is 
displayed when a local database is configured.

• Database name
Displays the name of the database you defined on the General tab.

• Name of view
Defines the view OpenScape Desktop Client uses for accessing the relevant 
database when a phone number is to be resolved in a name. If you do not 
know the name of the desired view, you can open a search dialog via the 
associated Browse… button. In there you can then look for available views.

NOTICE:  If you wish to enter the name of the view in the input 
field via keyboard, you need to use the view's alias.

• Test
A click on this button starts a check as to whether the specified view exists in 
the defined database.
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"Name" Tab

The Name tab contains settings for searching the relevant database for contacts 
and resolving names in phone numbers.

• Server name
Displays the server name you defined on the General tab. No server name is 
displayed when a local database is configured.

• Database name
Displays the name of the database you defined on the General tab.

• Name of view
Defines the view OpenScape Desktop Client uses for accessing the relevant 
database when you look for a contact or a phone number is to be resolved in 
a name. If you do not know the name of the desired view, you can open a 
search dialog via the associated Browse… button. In there you can then look 
for available views.

NOTICE:  If you wish to enter the name of the view in the input 
field via keyboard, you need to use the view's alias.

• Test
A click on this button starts a check as to whether the specified view exists in 
the defined database.

"Dial" Tab

The Dial tab contains settings for dialing from a database.
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• Server name
Displays the server name you defined on the General tab. No server name is 
displayed when a local database is configured.

• Database name
Displays the name of the database you defined on the General tab.

• Name of form
This name serves for finding the correct assignment of the database fields in 
OpenScape Desktop Client for a database under IBM Lotus Notes.

NOTICE:  If you initiate a call from a IBM Lotus Notes database, 
the configuration of the IBM Lotus Notes integration is searched 
for a database that has the same form name as the database from 
which you are dialing. If such a database exists in the configu-
ration, the associated assignment of the database fields is used 
for finding the dial information in the database. The dial process 
fails if no database with the form searched for is configured in the 
IBM Lotus Notes integration.

If you do not know the name of the desired form, you can open a search dialog 
via the associated Browse… button. In there you can then look for available 
views.

NOTICE:  If you wish to enter the name of the form in the text field 
via keyboard, you need to use the form's alias.

– Forms for address books
Select the Contact form for a database based on the pernames.ntf 
template. As a rule, this applies for local address books.
Select the Person form for a database based on the pubnames.ntf 
template. As a rule, this applies for server address books.

– Forms for mail database
Every mail displayed in your IBM Lotus Notes client is based on a defined 
form. If you wish to dial from an e-mail of your IBM Lotus Notes client with 
OpenScape Desktop Client you need to specify this form when config-
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uring the relevant IBM Lotus Notes mail database in the IBM Lotus Notes 
provider. Because various e-mails in a mail database may be based on 
different forms, you may have to specify several forms for a mail database 
for dialing from all e-mails. To do this you need to create several database 
entries and configure one of the required forms for each of these entries.

• Test
A click on this button starts a check as to whether the specified form exists in 
the defined database.

2.3.12.3  Authentication

Communication between OpenScape Desktop Client and IBM Lotus Notes client 
requires the storage location of the notes.ini configuration file and the 
password for accessing the Lotus Domino server.

To perform these settings, select in the Settings dialog on the tab Advanced > 
IBM Lotus Notes Provider > Authentication.

The following options are available for specifying the storage location:

• Use default path
If this option is active, OpenScape Desktop Client expects the notes.ini 
configuration file to be in its default directory. If the notes.ini file is not 
stored in the default directory, you need to specify the individual directory path 
under the Use user-specific path option.

• Use user-specific path
If the notes.ini file is not stored in the default directory, you need to specify 
the individual path under which the configuration file is stored.

• Please enter your IBM Lotus Notes password
Enter here your IBM Lotus Notes password for accessing the Lotus Domino 
server.
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2.3.13  Notifier Toast (Desktop Alerts) Settings

The Notifier Toast (Desktop Alerts) module enables displaying status changes 
as desktop notifications. It is included in the setup by default and independently 
from the selected default provider.

NOTICE:  You can edit the Notifier Toast (Desktop Alerts) 
settings via the Settings dialog at the program start or during live 
operation. To do this, click on the Manage button in the Logon 
dialog or the OpenScape Options button in the Pearl menu.

You reach the configuration dialog for the settings of the Notifier Toast (Desktop 
Alerts) module on the tab Advanced > Notifier Toast (Desktop Alerts) > 
General. 

You can use the Enable the Group pickup call toaster option to activate (default 
setting) or deactivate the display of desktop alerts for incoming calls to 
subscribers of a call pickup group. When this option is active, incoming group 
pickup calls are indicated in a desktop notification and can be accepted from 
there.

2.3.14  The Sendmail Provider Module

You need the Sendmail Provider to send e-mails to a contact directly from one 
of the directories or from the contact list. This provider starts the e-mail client (e.g. 
Microsoft Outlook) installed/configured on the PC and uses the contact's e-mail 
address as recipient address for a new e-mail.

The Sendmail Provider module is added and provided after launching the 
OpenScape Desktop Client by default. The Sendmail Provider does not require 
any further settings.

For sending e-mails to contacts directly from OpenScape Desktop Client the 
following requirements must have been met:

• A standard mail client is installed and configured on the OpenScape Desktop 
Client PC.

• The Sendmail Provider module is active.

• The directory or contact list entries of the relevant contacts include an e-mail 
address that has been selected for direct message transmission.

2.3.15  Keyboard Manager Settings

The Keyboard Manager provides keyboard support features. You can edit the 
following parameters for the keyboard support.
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2.3.15.1  Key Assignments

You can program hotkeys for accepting connection requests or closing connec-
tions by performing the appropriate key assignments in the Keyboard Manager. 
Hotkeys are useful when you mostly use the keyboard for triggering functions.

Select on the tab Advanced > Keyboard Manager > Key assignments.

NOTICE:  To edit the key assignments settings you need to open 
the Settings dialog during the program start. Click on the Manage 
button in the login dialog for this purpose.

System-wide keyboard tokens (Hotkeys)

In this area you can determine the keys or hotkeys for the following actions:

• Accept ringing voice connection
Picking up the receiver

• Disconnect voice connection
Hang up

• Dial selected text
When you push the assigned key or hotkey the OpenScape Desktop Client 
interprets the current cursor marking as target number and initiates a 
connection setup.

IMPORTANT:  System-wide means in this case that no other 
application executed on your PC in parallel to the OpenScape 
Desktop Client will react to these keys. Be sure not to enter keys 
or hotkeys that are allocated in other programs or in the Windows 
environment with functions that you want to use.

 Admissible keys or hotkeys are:

• [F2] to [F11], also in combination with Shift or [Ctrl],

• Letter keys A to Z and the digit key 0 to 9, also in combination with [Ctrl],

• The hotkey Shift + [Esc],

• Blank key,

• [Alt] + Shift + [Ctrl].

NOTICE:  You must not define the function keys [F1] and [F12] as 
hotkeys.
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2.3.16  Screensaver Manager Settings

OpenScape Desktop Client comes with its own screensaver, which can be 
activated as the default screensaver for Windows. While the screensaver is 
active, incoming calls can be accepted and individually defined speed-dial 
numbers dialed. You can perform the following settings for the screensaver.

2.3.16.1  Settings

Select on the tab Advanced > Screensaver Manager > Settings.

• Activate as default Screensaver
The screensaver is used as default screensaver for the PC.

NOTICE:  The special features of the screensaver (call accep-
tance, speed-dial number) are only available if the screensaver 
was activated with this option. If you select the OpenScape 
Desktop Client screensaver merely in the Windows display 
options, the special features are not be activated.

• Activate if computer is locked
If you lock your computer upon activating a screensaver, the screensaver is 
not be activated until a specific period has elapsed. With this option, the 
OpenScape Desktop Client is automatically activated ten seconds after 
locking the computer. This setting ensures that you can at least dial the 
speed-dial number when the screensaver is active.

• Disable during an active connection
When you select this option, the Windows screensaver is inactive during an 
established connection. As soon as the connection is closed, the screensaver 
becomes active again.
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Speed-dial number

Use this section to store the phone numbers that you also want to dial with an 
active screensaver. The speed-dial numbers are displayed in the screen saver as 
keys and can be dialed if the screen saver is active and furnished with a 
password.

• Adding a speed-dial number
You can configure a new speed-dial number with a click on the Add... button. 
The following dialog opens:

You can enter an expressive name for the new speed-dial number in the 
Description field and configure the desired phone number for speed dialing 
in the Number field.

• Editing a speed-dial number
A click on the Change... button opens the following dialog:

In this dialog you can change the Description and/or the Number of a speed-
dial number already configured.

NOTICE:  The Change... button remains inactive until you select 
an entry in the list of configured speed-dial numbers.

• Deleting a speed-dial number
With a click on the Delete button you remove a selected speed-dial number 
from the list.

NOTICE:  The Delete button remains inactive until you select an 
entry in the list of configured speed-dial numbers.

2.3.17  Directory Manager Settings

The Directory Manager controls the priority with which information from various 
configured directories is handled for phone number resolution and contact 
search.
A31003-G2570-U100-1-7619, 05/2012
OpenScape Personal Edition V7, User Guide 103



Configuration and Settings
“Advanced” Tab
To resolve a phone number into a name, it is sent to all available directories simul-
taneously. If contact information is then returned, its display depends on the 
priority the respectively associated directory has in the directory list of the 
Directory Manager. The directory in top position of the directory list has the 
highest priority, the one at the bottom has the lowest priority.

Example:

An LDAP and a Microsoft Outlook directory have been configured in the 
OpenScape Desktop Client. The contact directory of OpenScape Desktop Client 
does not contain any contact data. In the Directory Manager directory list, the 
directories are arranged as follows:

• LDAP directory

• Contact list

• Outlook directory

Obviously, the LDAP directory has higher priority than the Outlook directory.

The phone number for retrieving the associated name is sent to all directories 
simultaneously. If the LDAP directory is the first one to return a name for the 
relevant phone number, this name is displayed and kept.

If, on the other hand, the Outlook directory is the first one to return a name, this 
name is displayed for a start even if the Outlook directory has a lower priority. In 
the case of the LDAP directory also returning a name some time later, the infor-
mation displayed so far will be updated by the information delivered from the 
LDAP directory.

To set the priority of the configured directories in the Directory Manager, select on 
the tab Advanced > Directory Manager > Service Prioritization.

The directory list shows all directories available for resolving phone numbers. The 
position of a directory in this list indicates the priority with which the information of 
the associated directory is handled.

The directory list may display the following directories:
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• The contact list of OpenScape Desktop Client

• LDAP directories configured via the LDAP Directory Provider

• IBM Lotus Notes directories configured via the IBM Lotus Notes Provider.

The Move Up and Move Down buttons let you adjust the priorities of the single 
directory information.

• Move Up
Is used to move the selected directory entry up by one position. This 
increases the priority of the relevant directory.

• Move Down
Is used to move the selected directory entry down by one position. This 
decreases the priority of the relevant directory.
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3  Step-by-Step

The information contained in this chapter helps the user to quickly familiarize 
himself/herself with the basic features of this software solution.

3.1  General Information

This section provides information about the following topics:

3.1.1  How to Start the Program

How to start the OpenScape Desktop Client program:

Step by Step

› Click on Start in the Windows task bar and select OpenScape Desktop 
Client.

NOTICE:  OpenScape Desktop Client starts always under the 
user profile used last. If an LIN number is configured for this 
profile, the Logon dialog appears immediately after the program 
start. If no LIN number exists for this profile, the OpenScape 
Desktop Client starts without any further login actions required. To 
change the profile then, you need to push the shift key at the 
program start. In this case the login dialog is also displayed if no 
LIN number has been defined for the last user.

3.1.2  User Login

NOTICE:  The program always opens the Logon dialog for the 
user to log in if a user profile already exists under the current 
Windows account.

How to log on to the OpenScape Desktop Client via the dialog for the default user 
logon:

Step by Step

1) Start the OpenScape Desktop Client.

The Logon dialog opens.
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2) Use the Profile combo box to select the desired profile or create a new profile 
via the Add Profile ... button.

3) Confirm the default language used to display the OpenScape Desktop Client 
controls and online help or select another language from the list of available 
languages.

4) Afterwards, click on OK.

The login dialog closes.

The program is started.

3.1.2.1  How to Create a new Profile

You can change the user profile only during the default logon to the communica-
tions system by proceeding as follows:

Step by Step

1) Start the OpenScape Desktop Client.

The Login dialog opens.

2) Click on the Add Profile... button. 

The Add Profile dialog opens.

3) Enter a Profile Name.

4) Confirm your entries with OK.

The Add Profile dialog closes.

You have successfully created the new user profile.
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3.1.3  Configuring the Main Window

The main window opens after OpenScape Desktop Client start. It contains the 
frames Call Control, Contacts and Journal by default.

3.1.3.1  How to Integrate a Frame in the Main Window

How to integrate further frames, such as Directory Search, in the main window:

Step by Step

1) Select under Pearl Menu > View the Directory Search option. 

The Directory Search dialog opens as separate window.

2) Click in the Directory Search dialog on the area in the caption bar and drag 
the mouse pointer to the desired position in der main view with the left mouse 
button kept pressed.

The Directory Search window is now integrated in the main view.

3.1.3.2  How to Remove Frames from the Main Window

To remove a frame (e.g. Directory Search) from the main window, click on in 
the caption bar of the frame. The frame is closed. It is not automatically displayed 
in the main window again after a reboot of the program, but must be added 
manually via the Pearl menu > View.

3.1.3.3  How to Change the Quick-Access Toolbar Position

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

How to position the quick-access toolbar under the ribbon in the main window:

Step by Step

1) Click on the icon to the left of the OpenScape label in the caption bar of the 
main window.

The context menu of the quick-access toolbar is displayed.
A31003-G2570-U100-1-7619, 05/2012
OpenScape Personal Edition V7, User Guide 109



Step-by-Step
General Information
2) Select the Show Below the Ribbon option.

The quick-access toolbar is displayed under the ribbon.

NOTICE:  To move the quick-access toolbar back to its original 
position above the ribbon, select the Show Above the Ribbon 
option, which is displayed instead of the Show Below the Ribbon 
option in the context menu.

3.1.3.4  How to Add an Icon to the Quick-Access Toolbar

How to integrate an icon, e.g. a frequently used one, in the toolbar for quick 
access:

Step by Step

1) Rightclick the desired icon in the ribbonquick-access toolbar to display a 
context menu.

A context menu opens.

2) Select the Add to Quick Access Toolbar option in this context menu.

The selected icon is displayed in the toolbar for quick access.

3.1.3.5  How to Remove an Icon from the Quick-Access Toolbar

Proceed as follows:

Step by Step

1) Rightclick the desired icon in the quick-access toolbar.

A context menu opens.

2) Select the Remove from Quick Access Toolbar option.

The selected icon is no longer displayed in the quick-access toolbar.

3.1.4  Ending the Program

The program can be shut down as follows:

Step by Step

1) Rightclick the OpenScape icon in the notification area of the Windows 
taskbar.

The OpenScape context menu is displayed.
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2) Select Exit OpenScape. 

The main window closes and the OpenScape Desktop Client is shut down.

3.2  Getting Started with the Program

This section contains information about configuration adjustments to be 
performed at the initial program start after the OpenScape Desktop Client setup.

NOTICE:  You find detailed information about the installation and 
uninstallation of OpenScape Personal Edition  in the manual 
OpenScape Personal Edition V7 Installation and Administration.

3.2.1  Initial Login

You log on for the first time via the Profile creation dialog, which is only displayed 
if no user settings are available at the program start. This is the case, for example, 
immediately after the setup or after the configuration files have been deleted.

NOTICE:  When you log on as user for the first time, you need to 
configure the user-specific settings for e.g. identifying the 
OpenScape Desktop Client user. You cannot operate OpenScape 
Desktop Client without these settings.

How to log on to the OpenScape Desktop Client for the first time:

Step by Step

1) Start the OpenScape Desktop Client.

The Profile creation dialog opens.

2) Specify the name of the profile or location you wish to work with under Profile 
Name.

3) Click on OK.
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The Profile creation dialog closes.

The program creates the specified profile and switches automatically to the Logon 
dialog in which you perform the language and LIN settings as well as manage the 
configuration settings.

3.2.2  Initial Configuration

When you perform the initial configuration in the Settings dialog you set the user 
data for connecting the communications system as well as the audio device for 
signaling connection requests and for conducting calls.

NOTICE:  When you log on as user for the first time, you need to 
configure user-specific program settings, e.g. to connect to the 
communication system, in addition to the user-specific login infor-
mation. You cannot operate OpenScape Desktop Client without 
these settings.

3.2.2.1  How to Configure the Audio Device

So that you can conduct phone calls, your PC must be equipped with speaker and 
microphone, e.g. in the form of a headset. The hardware settings are grouped in 
audio schemes.

How to configure an audio device:

Step by Step

1) Start the OpenScape Desktop Client.

The login dialog opens.

2) Click on the Manage button.

A selection menu opens.

3) Select the Settings menu option.

The Settings configuration dialog opens.

4) Switch to the Audio Schemes tab and click on Add....

The following dialog opens:
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5) Specify the Description of the audio scheme.

6) Define the audio hardware for the following features:

• Voice recording

Microphone for voice recording

• Audio response

Primary playback speaker

• Additional speaker

Speaker for the "open listening" feature. If an additional speaker has been 
selected here and this audio scheme is active, the softphone menu 

displays the icon for the "open listening" feature.

• Signal response

Speaker for the signal output (ringing).

• Controller

Select the hardware you use. If this hardware is not contained in the 
selection list, then use Soundcard.

7) Click on OK.

The Add Scheme dialog closes.

The new audio scheme is the top entry in the list of configured audio schemes on 
the Audio Schemes tab. This sets it automatically as the currently used hardware 
for audio connections.

3.2.2.2  How to Configure an HiPath Connection

Prerequisites

• When installing the program you selected the HiPath Provider as default 
provider.

How to configure the HiPath Provider module, thus the softphone functionality of 
OpenScape Desktop Client:
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Step by Step

1) Start the OpenScape Desktop Client.

The login dialog opens.

2) Click on the Manage button.

A selection menu opens.

3) Select the Settings menu option.

The Settings dialog opens.

4) Switch to the Advanced tab.

5) Under HiPath Provider > Device you select your Phone type and your Key 
module type if required.

6) Under HiPath Provider > Main connection set the following parameters:

• Type: <Select your PBX here.>

• Gatekeeper: <Enter here the IP address of the communications system 
gatekeeper.>

• Extension number: <Enter here the number under which you can be 
reached on the connected communications system.>

• Password: <Specify here the password configured for your extension 
number.>

• Own IP address: <Select the Detect automatically option.>

7) Under HiPath Provider > Main network access determine the following 
parameters:

• Country code: <Enter here the international prefix for your site, e.g. 49 
for Germany.>

• Area code: <Enter here the area code of your location without leading 
zero.>

• System identification number: <Enter here the system identification 
number.>

• Trunk code: <Enter the code configured on your system for allocating 
outbound trunks, e.g. 0.>

• Prefix for long distance calls: <Enter here the network operator code for 
long distance calls, e.g. 0.>

• Prefix for international calls: <Enter the network operator code for inter-
national calls, e.g. 00.>

8) Click the Test button to check your entries.

The following dialog opens.
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9) Enter the Extension to be dialed. Based on the parameters set for the Main 
network access, the OpenScape Desktop Client automatically determines 
the phone number in the international number format in the Converted inter-
nationally field.

10) When the test has confirmed your entries for the main network access 
parameter as correct, click on the Close button.

The test dialog closes.

You have configured the OpenScape Desktop Client as your softphone with 
connection to a HiPath communications system.

3.2.2.3  How to Configure an SIP Connection

Prerequisites

• When installing the program you selected the SIP Provider as default 
provider.

How to configure the SIP Service Provider module, thus the softphone function-
ality of OpenScape Desktop Client:

Step by Step

1) Start the OpenScape Desktop Client.

The login dialog opens.

2) Click on the Manage button.

A selection menu opens.

3) Select the Settings menu option.

The Settings dialog opens.

4) Switch to the Advanced tab.

5) Under SIP Service Provider > Main line enter the following parameters:

• User: <enter your phone number here>

• Display: <enter your name here>

• Tooltip text: <enter something like SIP Phone optionally>

• ID: <enter your phone number or e-mail address.>

• Password: <Enter here the password provided by your system adminis-
trator.>
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6) Under SIP Service Provider > Registrar set the following parameters:

• Server: <Enter here the IP address provided by your system adminis-
trator>

• You determine the port for the server connection in the Connection. Your 
system administrator will provide further information.

7) Under SIP Service Provider > Proxy set the following parameters:

• Server: <Enter here the IP address provided by your system adminis-
trator>

• You determine the port for the server connection in the Connection. Your 
system administrator will provide further information.

8) Under SIP Service Provider > Network access enter the network access 
data provided by your system administrator (optional).

NOTICE:  Make sure that the Normalize call numbers option 
has been set under SIP Service Provider > Address 
conversion. The network access data are otherwise not required.

9) Under HLM Provider > Licensing, enter in the Server field the IP address of 
the PC on which the license server for the OpenScape Desktop Client is 
installed.

You have configured the OpenScape Desktop Client as your SIP softphone.

3.3  Overview of the User Interface

The OpenScape Desktop Client user interface comprises the following controls:

Main Bar

The main bar allows to quickly operate the program with minimum screen usage. 
It can be docked to the top margin of the desktop or only be displayed in its area 
when you move the mouse pointer.

Main Window

After you have successfully logged in at the system, the program's main window 
opens.
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In the OpenScape Desktop Client main bar you find the following elements from 
top to bottom:

Pearl Menu

This is an application menu icon for accessing the basic OpenScape Desktop 
Client features.

Quick Access Toolbar

A toolbar that provides quick access to functions that you have placed in this bar.

Pearl Menu Quick-Access Toolbar

Fr
am
es

Status Bar

Ribbon
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Ribbon

This is a bar that contains the following elements:

• Tabs organize controls in the ribbon around core scenarios and tasks the 
users perform with the OpenScape Desktop Client.

• Groups within each tab show related controls together.

• Controls within each group provide OpenScape Desktop Client click-to-action 
functions.

Frame

You can customize the main view of the OpenScape Desktop Client by adding or 
removing frames. The following frames are available via Pearl menu > View:

• Call Control
The call control lets you look for and call a contact, shows information about 
in- and outbound calls and provides telephony features during an active call.

• Contacts
The Contacts frame represents your private contact list. You can add single 
contacts to this contact list manually or import such contacts from various 
directories and then group them in the list to suit your own requirements. You 
can also directly call single contacts, edit and remove existing contact data as 
well as send e-mails from the contact list.

• Journal
In the Journal frame OpenScape Desktop Client logs all in- and outgoing 
calls locally on the computer as long as the OpenScape Desktop Client is 
started. Furthermore, you can initiate connections to logged communication 
partners from the Journal.
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• Directory Search
OpenScape Desktop Client supports the integration of several directories. 
You can search these directories for specific contacts and directly get in touch 
with them by e-mail or phone as well as integrate these contacts in your 
private contact list.

• Lines
The Lines frame lists all lines configured in the OpenScape Desktop Client 
and activated for display. This includes the statuses of the various lines.

• Status Bar
The status bar enables volume setting and displays errors.

3.4  Settings-related Actions

You can perform the following individual settings for each user:

3.4.1  How to Change the Language

The language in which the controls and the online help of the OpenScape 
Desktop Client are represented is defined during the default login. How to change 
the language:

Step by Step

1) Shut down the OpenScape Desktop Client.

2) Reboot the OpenScape Desktop Client.

3) Select the Language you want to set from the language list in the Login 
dialog.
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4) Afterwards, click on OK.

The login dialog closes. The language change has been saved and the 
program starts.

The currently configured language is used for representing the user interface and 
the online help.

3.4.2  How to Add an Audio Scheme

NOTICE:  You can configure a new audio scheme in the Settings 
dialog while logging on to the program as well as during operation.

How to proceed when you operate the OpenScape Desktop Client at an SIP or 
HiPath communications system and wish to add an audio scheme to the program 
configuration:

Step by Step

1) In the Logon dialog click on the Manage button and select Settings.

The Settings dialog opens. The Audio Schemes tab is displayed by default.

2) Click on the Add button.

The Add Scheme dialog opens.

3) Assign a name to the new audio scheme in the Description field.

4) In the Voice recording combo box select the audio hardware of the user 
computer to be used by for voice recording.

5) In the Audio Response combo box select the audio hardware of the user 
computer to be used by for voice playback.

6) In the Additional speaker combo box select an additional speaker for voice 
output if required.

NOTICE:  The hardware for the additional speaker must be 
different from the audio response hardware.
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7) In the Signal response combo box select the audio hardware of the user 
computer to be used by for ringtone output.

8) Select the audio hardware of the user computer to be used for controlling 
special hardware in the Controller field.

9) Confirm the settings of the new audio scheme with OK.

The Add Scheme dialog closes.

The newly defined audio scheme appears as first entry in the list of the configured 
audio schemes on the Audio Schemes tab.

3.4.3  How to Edit an Audio Scheme

NOTICE:  You can configure a new audio scheme in the Settings 
dialog while logging on to the program as well as during operation.

How to proceed when you operate the OpenScape Desktop Client at an SIP or 
HiPath communications system and wish to change the configuration of an audio 
scheme:

Step by Step

1) In the Logon dialog click on the Manage button and select Settings.

The Settings dialog opens. The Audio Schemes tab is displayed by default.

2) Click on the Change... button.

The Change Scheme dialog opens.

3) Perform the desired modifications.

4) Confirm the changes with OK.

The Change Scheme dialog closes. Your settings are saved.
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3.4.4  How to Add a Video Scheme

Prerequisites

• You operate the OpenScape Desktop Client at an SIP communications 
system.

• The SIP Service Provider module is active.

NOTICE:  You can configure a new video scheme only in the 
Settings dialog while logging on to the program.

How to add a new video scheme to the OpenScape Desktop Client configuration:

Step by Step

1) In the Logon dialog click on the Manage button and select Settings.

The Settings dialog opens. The Audio Schemes tab is displayed by default.

2) Switch to the tab Advanced > SIP Service Provider > Video schemes.

3) Click on the Add button.

The Add Video scheme dialog opens.

4) Assign a name to the new video scheme in the Description field.

5) In the Camera combo box select the video hardware of the user computer to 
be used by OpenScape Desktop Client for sending video signals.

6) Confirm your settings with OK. 

The Add Video scheme dialog closes.

The new video scheme appears on the Advanced tab in the list of configured 
video schemes.
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3.4.5  How to Edit a Video Scheme

Prerequisites

• You operate the OpenScape Desktop Client at an SIP communications 
system.

• The SIP Service Provider module is active.

NOTICE:  You can change the configuration of an audio scheme 
only in the Settings dialog while logging on to the program.

How to change the configuration of a video scheme:

Step by Step

1) In the Logon dialog click on the Manage button and select Settings.

The Settings dialog opens. The Audio Schemes tab is displayed by default.

2) Switch to the tab Advanced > SIP Service Provider > Video schemes.

3) Click on the Change... button.

The Change Video Scheme dialog opens

4) Perform the desired modifications.

5) Confirm your settings with OK. 

The Change Video Scheme dialog closes. Your modifications are saved.

3.4.6  How to Add a Call Forwarding

After you have configured call forwardings on the SoftPhone tab in the ribbon of 
OpenScape Desktop Client you can quickly rerout incoming calls at a later date.

How to configure a new call forwarding:

Step by Step

1) In the ribbon > SoftPhone tab > Device Feature group click on Call 
forwardings.

A combo box opens.

2) Select Add call forwarding.

The Add Forwarding dialog opens.
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3) Select the type of the new forwarding in the Type combo box.

4) Enter the phone number to serve as rerouting target in the Destination field.

5) If you wish to assign a short description to the new forwarding, make a corre-
sponding entry in the Optional text field. This description will later be 
displayed in the forwarding menu for selection.

6) Click on OK.

The Add Forwarding dialog closes.

The new call forwarding has been created.

3.4.7  How to Activate a Call Forwarding

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

• You must have previously configured at least one call forwarding.

The forwarding menu in the main bar of OpenScape Desktop Client lets you 
rerout your telephone fast and easily.

How to activate a previously defined call forwarding:

Step by Step

1) Click on in the main bar.

The list of configured call forwardings is displayed.

NOTICE:  Call forwardings already active are displayed 
highlighted in the forwarding menu. Forwardings set but not 
available any more are faded gray.

2) Select the desired list entry.

The selected call forwarding has become active.

3.4.8  How to Deactivate a Call Forwarding

How to disable an active call forwarding:
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Step by Step

1) Click on in the main bar.

The list of configured call forwardings is displayed.

NOTICE:  Call forwardings already active are displayed 
highlighted in the forwarding menu. Forwardings set but not 
available any more are faded gray.

2) Select the list entry of the active call forwarding.

The call forwarding is disabled.

3.4.9  How to Set an Individual Ring Tone

NOTICE:  You can edit the settings for the individual ring tone via 
the Settings dialog during the program start or during live 
operation. Click on the Manage button in the login dialog or select 
in the Pearl menu > Personal Settings > Ring Tones.You can 
perform these settings at an SIP as well as at a HiPath communi-
cations system.

NOTICE:  The settings you perform for the individual ring tone at 
an SIP communications system are identical to the settings for the 
individual ring tone at a HiPath communications system. You 
reach them in the Settings dialog on the Advanced tab under the 
SIP Service Provider > Ring tones or HiPath Provider > Ring 
tones option.

How to select an individual ring tone for signaling incoming connection requests 
at an SIP or HitPath communications system while operating OpenScape 
Desktop Client:

Step by Step

1) Open the Pearl menu.

2) Select the Personal Settings > Ring tones option.

The Settings dialog opens. The Advanced tab with option SIP Service 
Provider > Ring tones or HiPath Provider > Ring tones is displayed.

3) Activate the Use individual ring tones check box.
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4) Click the ... button.

The Open window is displayed.

5) In the Open window switch to the folder that contains the desired WAV or MP3 
file.

6) Select the desired file.

7) Click the Open button.

The Open dialog is closed.

The selected audio file has been adopted as the ring tone of your OpenScape 
Desktop Client.

3.4.10  How to Change the Default Ring Tone (HiPath Provider)

NOTICE:  These settings are only available while the OpenScape 
Desktop Client is active, you are logged in and no individual ring 
tone has been configured.

If you operate your OpenScape Desktop Client at a HiPath communications 
system and use the default ring tones of the system, you can change the pitch in 
the following way:

Step by Step

1) Open the Pearl menu.

2) Click on the OpenScape Options button.

The Settings dialog opens.

3) Switch to the tab Advanced > HiPath Provider > Operation settings.

4) Click the Change Ring Tone button.

A dialog is displayed and the current ring tone sounds.

5) Click on Next Ring Tone or Previous Ring Tone to select the desired ring 
tone.

6) Click the Close button to complete the setting.

The selected setting is immediately active.

3.4.11  How to Add a New Internet Page

If you want to open an internet page you visit frequently directly in the web 
browser of the OpenScape Desktop Client, you need to previously define them in 
the following way:
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Step by Step

1) Open the Pearl menu and click on the OpenScape Options button.

The Settings dialog opens.

2) Switch to the tab Advanced > Webbrowser > Internet pages.

3) Click on the Add... button.

The following dialog opens.

4) Then enter the desired Name and Address (URL).

5) Confirm your entries with OK.

The new internet page appears with Name and Address in the last position of the 
configured internet pages list.

3.4.12  How to Change an Internet Page

How to change the settings of an already configured internet page:

Step by Step

1) Open the Pearl menu and click on the OpenScape Options button.

The Settings dialog opens.

2) Switch to the tab Advanced > Webbrowser > Internet pages.

3) Mark the desired entry in the list of configured internet pages.

4) Then click on the Change button.

The following dialog opens.

5) Change the Name and/or the Address (URL).

6) Press the OK button.

The Change Entry dialog closes and your modifications are saved.

3.4.13  How to Delete an Internet Page

How to delete an already configured internet page from the list:
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1) Open the Pearl menu and click on the OpenScape Options button.

The Settings dialog opens.

2) Switch to the tab Advanced > Webbrowser > Internet pages.

3) Mark the desired entry in the list of configured internet pages.

4) Then click on the Delete button.

The selected list entry has been removed from the list of configured internet 
pages.

3.4.14  How to Configure a new SIP Additional Line

How to configure a new additional line:

Step by Step

1) Start the OpenScape Desktop Client.

2) Click on the Manage button in the login dialog.

A selection menu opens.

3) Select the Settings menu option.

The Settings dialog opens.

4) Select on the tab Advanced > SIP Service Provider > Additional lines.

5) Click the Add... button.

The following dialog opens.

6) Enter the unique OpenScape Desktop Client phone number/user address in 
the User field.

7) Enter an expressive text in the Display field.
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8) Enter the text to be displayed as tooltip in the Tooltip text field.

9) Enter your login.

10) If the authentication was configured on the server, enter your Password in 
addition.

NOTICE:  Further details can be obtained from the system admin-
istrator.

11) Confirm your entries with OK.

The dialog for configuring a new SIP additional line closes. The new line entry 
appears in the list of configured additional lines.

3.4.15  How to Change Additional Lines

How to change the settings of an already configured SIP additional line:

Step by Step

1) Start the OpenScape Desktop Client.

2) Click on the Manage button in the login dialog.

A selection menu opens.

3) Select the Settings menu option.

The Settings dialog opens.

4) Select on the tab Advanced > SIP Service Provider > Additional lines.

5) Click on the Change... button.

The following dialog opens.
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6) Perform the desired modifications.

NOTICE:  You cannot edit the User entry field.

7) Confirm your changes with OK.

The dialog for editing an existing SIP additional line closes.

3.4.16  How to Delete an SIP Additional Line

How to delete an SIP additional line already configured:

Step by Step

1) Start the OpenScape Desktop Client.

2) Click on the Manage button in the login dialog.

A selection menu opens.

3) Select the Settings menu option.

The Settings dialog opens.

4) Select on the tab Advanced > SIP Service Provider > Additional lines.

5) Select the line entry you want to delete in the list of configured additional lines.

6) Click on the Delete button.

The line entry has been removed from the list of configured SIP additional lines.

3.5  Contact Management

The following features are available for managing the contacts in your 
OpenScape contact list.

3.5.1  How to Create a New Contact

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

How to add a new contact to your contact list:

Step by Step

1) Click on in the Contacts frame.

The following dialog opens.
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2) Enter the First and Last Name of the new contact in the respective entry fields.

3) Click on the small triangle of the combo box and select the contact information 
that you want to add, e.g. the business phone number of the contact or his/
her business e-mail address.

4) Click on Add to confirm you entries.

The Add New Contact dialog closes.

Your entries are saved and the new contact entry appears in the contact list.

3.5.2  How to Add a Contact from a Directory

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

How to search a directory for a contact and add him/her to your contact list:

Step by Step

1) Open the Directory Search frame by selecting: Pearl menu > View > 
Directory Search.

The Directory Search window opens.

2) Enter the first or second name of the person you look for in the <search 
address books> input field.

3) Click on .

The dialog with the search results from different directories opens.

4) Click on the desired contact entry to select it.

5) Click on . The Add Contact dialog with available contact data opens. If 
desired, you can complete the contact data here.

6) Click on Add to confirm your entries.

The Add Contacts dialog closes.

Your entries are saved and the new contact entry appears in the contact list.
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3.5.3  Editing Contact Data

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

How to edit the contact information of an already configured contact:

Step by Step

1) Rightclick the name of a contact in the Contacts frame.

The context menu of the contact opens.

2) Select the Edit contact option.

The following dialog with the available contact data opens.

3) Perform the desired modifications.

NOTICE:  Click on the Contact Details button to edit further infor-
mation for the selected contact entry in the Change Contact 
dialog. With a click on OK you can save the modifications and 
close the Change Contact dialog.

4) Click the Change button.

Your modifications have become valid and the Change Contact Information 
dialog closes.

3.5.4  How to Create a new Group

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

How to add a new group to your contact list:

Step by Step

1) Rightclick in the Contacts frame.

The context menu of the Contacts frame opens.
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2) Select the Create group... context menu option.

The following dialog opens.

3) Enter a unique name for the group in the Name field. This is a required field.

4) Enter a description that is meaningful to you in the Description field. This 
entry is optional.

5) Click on OK. 

The Create Group dialog is closed.

The newly created group is displayed in the contacts frame.

3.5.5  How to Add a Contact to a Group

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

• You have already created a group in your contact list.

How to add a contact from your contact list to a group:

Step by Step

1) Rightclick the name of a group in the Contacts frame.

The context menu of a contact opens.

2) Select the Add Contact... context menu option.

The Add New Contact dialog opens.

3) Enter the First and Last Name of the new contact in the respective entry 
fields.

4) Click on the small triangle of the combo box and select the contact information 
that you want to add, e.g. the business phone number of the contact or his/
her business e-mail address.

5) Click on Add to confirm you entries.

The Add New Contact dialog closes.

The new contact appears in the contact list as group entry.
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3.5.6  How to Add Contacts to a Group

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

• You have already created a group in your contact list.

How to add specific contacts from your contact list to a group:

Step by Step

1) Select from the contact list the contacts that you want to integrate in a group.

NOTICE:  To select several contact entries at the same time, keep 
the [Ctrl] key pushed while you click on the names of the desired 
contacts.

2) Rightclick the name of a group in the Contacts frame.

The context menu of a group opens.

3) Select the Add Contacts to Group... option.

The following dialog opens:

4) Select one of the groups in the Add Contacts dialog.

5) Click on OK.

The Add Contacts dialog closes.

The selected contacts are displayed in the desired group. They are thus itemized 
in the contact list twice.

3.5.7  How to Move Contacts to the Group

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

• You have created at least two groups.

How to move specific contacts to a group:
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Step by Step

1) Select from the contact list the contacts that you want to integrate in a group.

NOTICE:  You can move contacts from your contact list to a 
group, or from one group to another.

NOTICE:  To select several contact entries at the same time, keep 
the [Ctrl] key pushed while you click on the names of the desired 
contacts.

2) Rightclick the name of a group in the Contacts frame.

The context menu of a group opens.

3) Select the Move Contacts to Group... option.

The following dialog opens:

4) Select the desired group in the All Groups dialog.

5) Click on OK.

The All Groups dialog closes.

The contact(s) is/are integrated in the selected group.

3.5.8  How to Import Contacts from a File

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

• You have created a backup copy of your OpenScape or Microsoft Outlook 
contact list in the XML or CSV format.

How to integrate your Microsoft Outlook contact list in the OpenScape contact list 
or restore your OpenScape contact list after e.g. a reinstallation of the program:

Step by Step

1) Open the Pearl menu and select the File option.

2) Click on Import Contacts from file in the right-hand section of the Pearl 
menu.
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The following dialog opens:

3) Click on the ... button and select the memory location of the contact list file 
you want to import.

4) Click on OK.

The Restore Contact List dialog closes.

The Contacts frame displays your imported contact information.

3.5.9  How to Export Contacts to a File

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

How to create a backup copy of your contact list:

Step by Step

1) Open the Pearl menu and select the File option.

2) Click on Export Contacts to file in the right-hand section of the Pearl menu.

The following dialog opens:

3) Select the memory location where you wish to store the contact list data and 
click on the ... button.

4) Select in the Contact data format the file type (.xml or .csv).

5) Click on OK.
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The Backup Contact List dialog closes.

The backup file of your contact list has been created. A confirmation dialog opens, 
which also states the storage location. A click on OK closes the confirmation 
dialog.

3.6  Communicating with your Contacts

The following features are available for communicating with other subscribers:

3.6.1  How to Call a Contact

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

How to call a contact from your contact list with OpenScape Desktop Client:

Step by Step

› Click in the Contacts frame in the row of the desired contact entry.

NOTICE:  If more than one number is specified for the contact, 

click on to select the desired one.

The connection is established and displayed in the Call Control frame.

3.6.2  How to Dial a Phone Number

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

How to set up a connection to any phone number:

Step by Step

1) Click on the telephone display in the main bar.

The OpenScape Desktop Client keypad is displayed.

2) Enter the desired phone number via the telephone keypad.

3) Then push the return key. 

The call is initiated and listed in the Call Control frame.
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3.6.2.1  How to Dial a Phone Number Using Copy & Paste

You can use the copy & paste method in the OpenScape Desktop Client to set up 
a connection to a phone number that you have entered in another application 
(e.g. a word processing program).

Step by Step

1) Select the phone number in the application (e.g. in a word processing 
program).

2) Copy the selected number to the clipboard by pushing the keys [Ctrl] + [C] 
simultaneously or using the functions provided by the application.

3) Paste the phone number with one of the following hotkeys from the clipboard 
in the display field of the integrated telephone in the main bar:

• Shift key + [Ins] without office code

• [Ctrl] + [V] with office code.

NOTICE:  Alternatively, you can paste the phone number to be 
dialed in the display field of the free phone.

The phone number is shown in the display. The connection is immediately set up 
and listed in the Call Control frame.

3.6.2.2  How to Dial Using "Drag&Drop"

You can use the drag&drop method in OpenScape Desktop Client the to set up a 
connection to a phone number you have entered in another application (e.g. in a 
word processing program, web browser etc.):

Step by Step

1) Select the phone number in the application (e.g. in a word processing 
program).

2) Drag the selected phone number into the display field of the integrated 
telephone in the main bar with the left mousebutton kept pressed.

3) Release the mouse button.

The phone number appears in the display field of the integrated telephone in 
the main bar.

NOTICE:  Alternatively, you can paste the phone number to be 
dialed in the display field of the free phone.

The connection is immediately set up and listed in the Call Control frame.
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3.6.3  How to Accept an Incoming Call

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

How to accept an icoming call displayed in the Call Control frame:

Step by Step

› Click on in the Call Control frame.

You are connected to your connection partner. The Call Control frame shows call 
control features.

3.6.4  How to Transfer a Call to a Device/Subscriber

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

How to transfer the control of an incoming call to another device:

Step by Step

1) Rightclick in the area of the displayed call in the Call Control window.

A context menu opens.

2) Select  Transfer to in the context menu.

The following dialog opens.

3) Enter the phone number of the device you want to transfer the incoming call 
to.

4) Click on the Transfer Call To icon in the Transfer call dialog.

The Transfer call dialog closes.

You can accept the call on another device.

NOTICE:  If you operate the OpenScape Desktop Client at a 
HiPath 4000, the on-hold option is unavailable.
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3.6.5  How to Change the Device during an active Call

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

How to change the device during an active call while keeping the call control:

Step by Step

1) Rightclick the area of the displayed active call in the Call Control frame.

A context menu opens.

2) Select  Transfer to in the context menu.

The following dialog opens.

3) Enter the phone number of the device you want to transfer the incoming call 
to.

4) Click on the Transfer Call To icon in the Transfer call dialog.

The dialog closes.

The call can be accepted on another device.

3.6.6  How to Hold a Call

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

• You are conducting a call, which is displayed in the Call Control frame.

How to set an active call to on-hold:

Step by Step

› In the Call Control frame click on .

Your connection is being held. The conversational partner hears music-on-hold.

NOTICE:  If you operate the OpenScape Desktop Client at a 
HiPath 4000, the on-hold option is unavailable.
 A31003-G2570-U100-1-7619, 05/2012
140 OpenScape Personal Edition V7, User Guide



Step-by-Step
Communicating with your Contacts
3.6.7  How to Retrieve a Held Call

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

• Your active call is being held and displayed in the Call Control frame.

Step by Step

› Click in the Call Control frame on in the area of the held call.

Your held call is released.

NOTICE:  If you operate the OpenScape Desktop Client at a 

HiPath 4000, the back to waiting option is unavailable.

3.6.8  How to Make a Consultation Call

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

• You are conducting a call.

How to consult another subscriber during an active call:

Step by Step

1) Enter the phone number of the subscriber who you want to consult in the 
<Name or Number> combo box of the Call Control frame.

2) Click on to the right of the <Name or Number> field to initiate the call. 

The connection to the first conversational partner is automatically being held and 
he/she hears music(-on-hold). You can now talk to the consultation-call 
subscriber.

3.6.9  Toggling

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

• You are being connected to two conversational partners. One of these calls 
has been set to on-hold because you are conducting a consultation call.

How to toggle calls during a consultation:
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1) Rightclick in the Call Control frame in the area of the held call.

 A context menu opens.

2) Select the Toggle option.

The held call becomes active again and you can talk to the original subscriber. 
The connection to the consultation-call subscriber is held.

3.6.10  How to Transfer a Call to a new Subscriber

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

• You are conducting an active consultation call.

How to connect the original caller to the consultation call subscriber during a 
consultation call:

Step by Step

1) Rightclick in the Call Control frame in the area of the held call.

A context menu opens.

2) Select the Transfer option.

Your connection is automatically closed. The other two subscribers can talk to 
each other.

3.6.11  How to Activate the Completion of Calls to Busy Subscriber (CCBS)

This feature enables you to automate a connection setup to a previously busy 
subscriber in the PBX. When you initiate a call and receive a busy signal from the 
target subscriber, you can activate or use the callback feature as follows:

Step by Step

1) Rightclick the area of the displayed connection in the Call Control window.

The context menu of an active call opens.

2) Select the Callback option.

A greeting informs you that the callback function is active. Thereafter, the 
connection is cleared. You are then available to other callers again and can 
make calls yourself.

If the previously busy target subscriber becomes available again, the 
OpenScape Desktop Client is informed by the PBX accordingly. The program 
then lets you know by a call in the Call Control frame that the target 
subscriber is no longer busy.
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3) Accept the call with a click on in the Call Control frame. 

The PBX calls the target subscriber again.

NOTICE:  CCBS cannot be used if the callee rejects the call or the 
PBX of the callee does not support the feature.

3.6.12  How to Activate Completion of Calls on no Reply (CCNR)

This feature enables you to automate a connection setup to a subscriber who 
does not answer the phone in the PBX. If the target subscriber is available but 
does not answer the phone, you can activate the callback feature as follows:

Step by Step

1) Rightclick the area of the displayed connection in the Call Control window.

The context menu of an active call opens.

2) Select the Callback option.

A greeting informs you that the callback function is active.

When the target subscriber hangs up the next time, the PBX informs the 
OpenScape Desktop Client accordingly. The program then lets you know by 
a call in the Call Control frame that the target subscriber is available.

3) Accept the call with a click on in the Call Control frame.

The PBX reconnects you to the target subscriber.

NOTICE:  When you use the softphone, the free phone or the 
integrated phone of the Personal Edition, the callback request is 
shown in the telephone display. With a click 

on (softphone) or (free or integrated phone), the 
callback function becomes active. To be automatically recon-
nected to the subscriber who has become available or is present 

again, click in the softphone on or , or on in the 
integrated or free phone.

NOTICE:  CCNR cannot be used if the callee rejects the call or 
the PBX of the callee does not support the feature.

3.6.13  How to End a Call

How to clear a connection listed in the Call Control frame:
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› Click in the Call Control frame on in the area of the active call.

The connection is cleared and does no longer appear in the Call Control frame.

3.6.14  How to Send an E-Mail to a Contact

Prerequisites

• OpenScape Desktop Client is correctly configured and you are logged in at 
the communications system.

• An e-mail address has been configured for the contact under the contact infor-
mation.

How to send an e-mail to a contact from the contact list:

Step by Step

1) Click on in the Contacts frame in the row of the desired contact.

Your pre-configured default e-mail application starts.

2) Write and send the e-mail message as usual.

The window of the e-mail application closes. The e-mail was sent.

3.6.15  How to Call a IBM Lotus Notes Contact

How to initiate a call from your IBM Lotus Notes address book using the IBM Lotus 
Notes integration:

Schritt für Schritt

1) Switch to the address book of your IBM Lotus Notes client.

2) Select the desired contact.

3) Click to the Dial button in the IBM Lotus Notes toolbar.

4) If the selected contact includes several phone numbers, a selection dialog of 
OpenScape Desktop Client opens. In this dialog mark the phone number that 
you would like to use for the call.

5) Then click on the Connect button in the selection dialog.

The call is initiated and the selection dialog closed. The main window of 
OpenScape Desktop Client appears in the foreground. The connection is 
displayed in the Call Control frame.
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3.6.16  How to Call a Microsoft Outlook Contact

How to initiate a call from your Microsoft Outlook address book using the 
Microsoft Outlook integration:

Step by Step

1) Switch to the address book of your Microsoft Outlook client.

2) Select the desired contact and click in the Microsoft Outlook toolbar on the 
Dial icon.

3) If the selected contact includes several phone numbers, a selection dialog of 
OpenScape Desktop Client opens. In this dialog mark the phone number that 
you would like to use for the call.

4) Then click on the Connect button in the selection dialog.

The call is initiated and the selection dialog closed. The main window of 
OpenScape Desktop Client appears in the foreground. The connection is 
displayed in the Call Control frame.

3.6.17  How to Call the Originator of an E-mail with IBM Lotus Notes

To call the originator of an e-mail in the IBM Lotus Notes client proceed as follows:

Schritt für Schritt

1) Switch to the inbox of your IBM Lotus Notes client.

2) Select the relevant e-mail.

3) Click to the Dial button in the IBM Lotus Notes toolbar.

4) If the selected contact includes several phone numbers, a selection dialog of 
OpenScape Desktop Client opens. In this dialog mark the phone number that 
you would like to use for the call.

5) Then click on the Connect button in the selection dialog.

The call is initiated and the selection dialog closed. The main window of 
OpenScape Desktop Client appears in the foreground. The connection is 
displayed in the Call Control frame.

3.6.18  How to Call the Originator of an E-mail with Microsoft Outlook

How to call the originator of an e-mail in Microsoft Outlook:

Step by Step

1) Switch to the inbox of your Microsoft Outlook client.

2) Select the relevant e-mail and click in the Microsoft Outlook toolbar on the 
Dial icon.
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3) If the selected contact includes several phone numbers, a selection dialog of 
OpenScape Desktop Client opens. In this dialog mark the phone number that 
you would like to use for the call.

4) Then click on the Connect button in the selection dialog.

The call is initiated and the selection dialog closed. The main window of 
OpenScape Desktop Client appears in the foreground. The connection is 
displayed in the Call Control frame.

3.6.19  How to Sort Journal Entries by Call Type

How to display only specific call types in the journal:

Step by Step

› Select the call type you wish to have displayed in the Journal in the combo 
box at the top right margin of the Journal frame.

The Journal function window lists only the calls of the selected call type.

3.6.20  How to Display Missed Calls

How to display a list of all missed calls in the Journal frame:

Step by Step

› Select in the combo box at the top right margin of the Journal frame.

The Journal displays the missed calls only.

3.6.21  How to Dial from the Journal

How to set up a phone connection from the Journal frame:

Step by Step

1) In the journal list select the entry of the subscriber you want to call.

2) Click on in the toolbar of the Journal frame.

The call is initiated and listed in the Call Control frame.
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3.6.22  How to Start Video Streaming

Prerequisites

• The OpenScape Desktop Client is connected to an OpenScape Voice V5 or 
later.

• You have an installed and operable video camera.

• The Video Viewer module is active.

• In the SIP Service Provider settings you have configured and selected a 
video scheme that uses your operable video camera.

How to switch a video connection to an active call:

Step by Step

1) Click in the ribbon > Softphone tab > Video group on the Camera image 
button.

The Video window opens, showing your own image.

2) Click on .

Your own image appears in a red frame. It is transmitted to the connection 
partner.

NOTICE:  If your connection partner also has a video camera and 
switched his/her image to the conference in the same way, it 
appears automatically in your Video window. You cannot control 
or activate/deactivate receiving video images.

3.6.23  How to End Video Streaming

How to terminate transmitting your own video image:

Step by Step

› Click on in the Video window.

Your own image does no longer appear in a red frame.

NOTICE:  The video image of your connection partner remains 
visible until he/she terminates the transmission or the connection 
is cleared.

Your video image is no longer being transmitted. It is, however, still visible in the 
Video window until you switch off the video camera via the Camera image button 
in the ribbon > SoftPhone tab > Video group.
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3.7  How to Collaborate with Contacts in a Conference

The OpenScape Desktop Client offers the following conference features for 
collaborating with other participants.

3.7.1  How to Start a Local Conference

How to combine two calls to a local conference:

Step by Step

1) Call one of the desired participants.

2) Rightclick the displayed call in the Call Control frame.

A context menu opens.

3) Select Consultation to in the open context menu.

The active call is held. Your conversational partner listens to music-on-hold.

4) Enter the phone number of the subscriber who you want to consult in the 
<Name or Number> combo box of the Call Control frame.

The Consultation to dialog opens.

5) Rightclick in the area of the newly set up connection in the Call Control 
frame.

A context menu opens.

6) Select the Initiate local conference option.

All subscribers are connected to each other. No more participants can be added 
to the conference.

3.7.2  How to End a Local Conference

How to clear the connection to an active local conference:

Step by Step

› Click on in the area of the displayed conference connection in the Call 
Control frame.

You are no longer connected to the conference. As soon as every participant has 
hung up, the conference has ended.
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3.7.3  How to Start a Local Video Conference

Prerequisites

• You operate the OpenScape Desktop Client at an OpenScape Voice V5 or 
later.

• You are taking part in an active local voice conference.

• All participants have an installed and operable video camera.

How to switch a video connection to an active local conference connection:

Step by Step

1) Click in the ribbon > Softphone tab > Video group on the Camera image 
button.

The Video window opens, showing your own image.

2) Click on .

Your own image appears in a red frame. It is transmitted to the connection 
partners.

NOTICE:  If your connection partners also have a video camera 
and switched their image transmission to the conference in the 
same way, you can automatically see these images in your Video 
window. You cannot control or activate/deactivate receiving video 
images.

NOTICE:  If you are the conference initiator, you see three images 
in your Video window: your own one in a red frame and the 
images of the other two connection partners.

NOTICE:  If you are not the initiator of the local conference, you 
see two images in your Video window: your own one in a red 
frame and one that you receive. The latter one is mixed by the 
initiator in a way that it shows the video image of the initiator and 
of the third participant in one video image.

3.7.4  How to Terminate a Local Video Conference

How to terminate transmitting your own video image during a local video 
conference:

Step by Step

› Click on the Video window.
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Your own image does no longer appear in a red frame.

Your video image is no longer being transmitted. It is, however, still visible in the 
Video window until you switch off the video camera via the Camera image button 
in the ribbon > SoftPhone tab > Video group.

If your are the initiator and switch off your video camera via the Camera image 
button, the other two participants do not receive a video image any more. The 
local video conference then turns into a normal local voice conference.

If you are a participant without initiator privileges and switch off your video camera 
via the Camera image button, the initiator only sees the image of the other partic-
ipant and vice versa.

3.7.5  How to Start a Server-based Voice Conference

Prerequisites

• A connection to an OpenScape Voice has been set up.

• You have configured the correct conference server URI in the dialog 
Settings > Advanced tab > SIP Service Provider > System functions.

How to extend a consultation call to a server-based conference (participant-
controlled conference):

Step by Step

1) Rightclick in the Call Control frame in the area of the held call.

A context menu opens.

2) Click on Initiate server-based conference.

A conference between the subscribers is being initiated. The caller, the callee and 
the consultation-call subscriber are then connected to each other. You can switch 
further participants to the conference.

NOTICE:  As soon as every participant has hung up, the 
conference has ended.

3.7.6  How to Add further Participants to a Server-Based Conference

If you wish to add further participants to an active server-based voice conference 
(participant-controlled conference), proceed as follows:

Step by Step

1) Rightclick the conference entry in the Call Control frame.

A context menu opens.

2) Select the Consultation to option.
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The Consultation to dialog opens.

3) Enter the phone number of the desired subscriber.

4) Confirm your entries with the OK button. 

The new connection is established and listed in the Call Control frame.

5) Rightclick the new connection.

A context menu opens.

6) Select the Enter Conference option.

The desired participant has been added to the conference. Only the conference 
is now displayed in the Call Control frame.

3.7.7  How to Initiate a Handover via DTMF Key

How to change a device you use in a conference:

Step by Step

1) Push the key.

2) Enter the phone number of the device you want to switch to.

3) Complete entering the phone number with the key.

The entered phone number is announced for you to check.

4) You are then prompted to continue with one of the following options:

• Push the key to perform the handover,

• push the key to abandon the process.
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4  Operation Reference

This chapter contains detailed information about the various controls you find in 
the user interface.

4.1  How to Start the Program of OpenScape Desktop Client

You can start the OpenScape Desktop Client as follows:

• Click on Start in the Windows task bar and select OpenScape Desktop 
Client.

• Doubleclick the OpenScape Desktop Client link on the desktop of your user 
PC.

OpenScape Desktop Client starts under the user profile used last by default.

If the field for specifying the LIN number is hidden, the OpenScape Desktop Client 
starts without any further login actions.

4.1.1  Error Signaling at the Program Start

If errors occur in the first 120 seconds after the program start of OpenScape 
Desktop Client, e.g. connection, sound device or license problems, the Current 
error report window opens. This window contains details about the occurred 
error.

If an error occurs during operation, it is indicated in the Pearl menu and in the 
OpenScape context menu in the notification area of the Windows task bar by .

4.2  Logging on to the Program

The user can deploy three login types for logging on to the OpenScape Desktop 
Client:

• First login
The Profile creation dialog opens during the initial program start after the 
setup or if no user profile for the current Windows account has yet been 
created when the program starts.

• Default login
When you start the program, the Login dialog is displayed by default. You can 
edit login information here.

NOTICE:  If profile data from the last session is available when 
you start the program, it is entered by default for the current 
session.
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• Automatic login
If no LIN number has been configured for your user account or the LIN entry 
field is hidden, you are automatically logged on and need not fill in the login 
dialog. In this case, changes to the profile preferences (language selection, 
for instance) are impossible before the program starts.

IMPORTANT:  You can invoke the login dialog if you want to 
modify the profile or revise the profile settings. When you start the 
program, keep the shift key pushed for this purpose.

4.2.1  Default Login

The Login dialog is used for the default login at the program.

Depending on the program-start settings, this dialog may appear differently. 
Some input fields and buttons may be disabled.

In the following we describe the functions of all input fields and buttons of the login 
dialog:

• Profile
Select the profile that allows you to operate as a user in the Profile field. If the 
profile you are using is not yet listed, click on the Add Profile... button (if 
configured).

• Language
Select from the languages list the language to be used for the OpenScape 
Desktop Client controls and online help.

• LIN
The LIN (Local Identification Number) field is used for local assignments of 
e.g. building and room numbers or coordinates. This number serves for 
quickly locating an OpenScape Desktop Client PC. Depending on your 
configuration, this field can be hidden, furnished with a default value or 
configured as required field.

NOTICE:  You can use the LIN number only if you operate the 
OpenScape Desktop Client connected to a HiPath 4000 (HiPath 
Provider).
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• Add Profile...
A click on this button lets you create a new profile. The Add Profile dialog for 
specifying the Profile Name opens.

NOTICE:  You can obtain detailed information about the user and 
location concept of OpenScape Desktop Client from the 
OpenScape Personal Edition V7 Installation and Administration 
manual.

• Manage
A click on this button invokes the menu for managing the configuration 
settings.

• OK
A click on this button closes the login dialog. Modifications to the settings are 
saved. Subsequently, the program starts and the main window opens.

• Cancel
A click on this button aborts the login and program start.

4.3  Administering the Configuration Settings

NOTICE:  You can perform some configuration settings only 
during the logon procedure. Other settings that do not directly 
affect operating the OpenScape Desktop Client can also be 
edited after the user login, e.g. configuring the individual ring tone.

NOTICE:  You can display the configuration settings via the 
OpenScape Settings option of the OpenScape context menu 
during OpenScape Desktop Client operation. You open this 
context menu by rightclicking the OpenScape icon in the notifi-
cation area of the Windows task bar.

You open the OpenScape Desktop Client configuration settings via the Manage 
button in the login dialog.

There are different functions available for managing the profile information and for 
switching to the configuration - depending on the configuration options defined at 
the program start.
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The following options are available in the menu of the Manage button:

• Settings
Opens the Settings dialog for configuring the OpenScape Desktop Client 
parameters. Once you have finished editing your settings you are returned to 
the Logon dialog. The current settings are applied when you log on.

• Add Profile...
Opens the Add Profile dialog, in which you can define a new Profile Name.

• Copy Profile...
Opens the Copy Profile dialog to copy the current profile settings into a new 
profile. The settings valid for the copied profile are taken for the new profile.

• Change Profile...
Opens the Change Profile dialog in which you can define a different Profile 
Name for the current profile.

• Delete profile
Deletes the current profile.

• Export Configuration...
Lets you export the parameter settings for the current Windows user account, 
the current login PC or the current login profile either fully or partially to the 
configuration or script files. You find further information about exporting the 
configuration in the manual OpenScape Personal Edition V7 Installation and 
Administration.

• Backup Configuration...
Outsources all parameter settings for the current Windows user account, the 
current login PCs and login profiles. You can create a destination folder to 
which this full configuration is then exported in a defined structure. You find 
further information about backing up the configuration in the manual 
OpenScape Personal Edition V7 Installation and Administration.

• Restore Configuration...
Loads all parameter settings for a user/PC/profile combination. You can enter 
a source folder from which the defined structure for a full configuration is 
loaded. You find further information about backing up the configuration in the 
manual OpenScape Personal Edition V7 Installation and Administration.

4.4  Ending the Program

You can shut down the OpenScape Desktop Client as follows:

• By doubleclicking the Pearl menu.

• By clicking on at top right margin of the main window.

• Via the [Alt] + [F4] hotkey.

• Via the Exit OpenScape option in the OpenScape Desktop Client context 
menu in the notification area of the Windows task bar.

If you wish to shut down the OpenScape Desktop Client during an active call, a 
confirmation dialog opens. A click on OK then confirms that you agree to the 
program's shutdown despite the active call. A click on Cancel closes the confir-
mation dialog and the active call can still be conducted.
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4.5  Main Bar

Different users may see different layouts after they have logged in. Layouts vary 
depending on the modules installed and activated as well as the user preferences 
and window settings that were active when the program was last ended. The main 
bar is a central element of the user interface. It offers a compact representation 
of the telephony, menu and volume control functions, which are otherwise also 
available in the main view.

NOTICE:  You display the main bar with a click on Pearl menu > 
View > Main Toolbar.

The main bar features the following elements:

• OpenScape
Doubleclick this label to open the Current status report window, which 
displays a current error and status report. The report shows all the modules 
that are monitored by the system.

• Telephone display
A click on the telephone display next to the OpenScape label opens an 
operable telephone keypad. Using this keypad or your PC keyboard you can 
enter the desired number. Then click on or push the return key (PC 
keyboard). The connection to the desired contact will be established.

•
Dials the phone number entered via the keypad or accepts an incoming call.

•
Closes an existing connection.

•
Switches the microphone on or off.

•
Switches the voice recording function on or off.

•
Switches the speaker on or off during an active call or in idle state.

Logo
Telephone Display

Record Conversation

Call Forwarding
Configuration

Telephone MenuHelp
Menu

Exit Program

Accept Call/Hangup
Microphone on/off Deactivate Call

Forwarding

Line Menu
Volume Control

Volume Menu
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•
Displays the currently active call forwardings.

•
Displays the configured call forwardings.

•
Opens the phone menu.

•
Opens the line menu.

•
Enables setting the call volume by moving the volume control to the left 
(softer) or to the right (louder).

•
Enables setting the volume of ring tone, microphone and speaker.

•
Opens the program's online help.

• menu
Opens the main bar menu.

•
Closes the main bar.

4.5.1  The Main Bar Menu

When you click on menu in the main bar, the following menu opens:

This menu contains the following options:

• Set auto-hide On
The OpenScape Desktop Client main bar is hidden when the mousepointer is 
outside of it.

• Set auto-hide Off
The main bar is docked to the top desktop margin.

• File
You can use this option to create a backup file of your contact list in CSV or 
XML format (export contacts to a file) or restore your contact list (import 
contacts from a file).
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• Personal settings

NOTICE:  This option is only available if you operate the 
OpenScape Desktop Client with a connection to an SIP commu-
nications system or at a HiPath PBX.

Enables configuring an individual ring tone. A click on Ring tones in the right-
hand section of the Pearl menu opens the Settings dialog with displayed 
configuration options for the individual ring tone.

• View
Depending on the active modules, the individual user may deploy different 
options in the display.

•  About
Opens the Product information window and displays the OpenScape 
Desktop Client version number.

• Update
Establishes a connection to the latest OpenScape Desktop Client version that 
your system administrator has downloaded. A message tells when no update 
is available.

• Help
Opens the help file for the entire application.

• OpenScape Options
Serves to display the current application settings.

• Exit OpenScape
Serves to close the application.

4.6  Pearl Menu

You invoke the Pearl menu with a click on the opposite icon.

If an error occurs while a module is being loaded, the Pearl icon displays a . If 
an unanswered call exists in the journal, a appears in the Pearl icon. Both icons 
can be displayed parallel. While the mousepointer is hovering over the icon, a 
quickinfo appears that provides details about the error(s) or indicates the number 
of missed calls.
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The Pearl menu contains the following options:

• Status Information
This option provides connection status information about missed calls, for 
example.

• File
You can use this option to create a backup file of your contact list in CSV or 
XML format (export contacts to a file) or restore your contact list (import 
contacts from a file).

• View
Depending on the active modules, the individual user may deploy different 
options in the display. The following figure exemplifies this.

– SoftPhone
Opens the softphone in a separate window. This option is only available if 
the SoftPhone module is active.

– Main Toolbar
Displays the main bar at the top screen margin.

– Contacts
Enables integrating the Contacts frame in the OpenScape Desktop Client 
main menu.

– Call Control
Enables integrating the Call Control frame in the OpenScape Desktop 
Client main menu.

– Journal
Enables integrating the Journal frame in the OpenScape Desktop Client 
main menu. 

– Directory Search
Enables integrating the Directory Search frame in the OpenScape 
Desktop Client main menu.

– Webbrowser
Displays a list of your pre-configured internet pages. Select an internet 
page with a click on the corresponding name. OpenScape Desktop Client 
opens this internet page in a separate window in which you can navigate. 
Each internet page is displayed in a separate window.
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– Integrated phone
Enables displaying the integrated phone of the OpenScape Desktop 
Client as telephone display in the main bar. Furthermore, you can use this 
option to remove the integrated phone from the main bar. This option is 
only available if the Telephone module is active.

– Free phone
A click on this option opens or closes a freely positionable phone (display 
and keypad) on the desktop in a separate window. This option is only 
available if the Telephone module is active.

– Lines
A click on this option integrates the Lines frame in the OpenScape 
Desktop Client main window. Another click removes it from the 
OpenScape Desktop Client main window. This feature is only available in 
connection with an SIP Provider.

• Personal Settings

NOTICE:  This option is only available if you operate the 
OpenScape Desktop Client with a connection to an SIP commu-
nications system or at a HiPath PBX.

Enables configuring an individual ring tone. A click on Ring tones in the right-
hand section of the Pearl menu opens the Settings dialog with displayed 
configuration options for the individual ring tone.

• Update
Establishes a connection to the latest OpenScape Desktop Client version that 
your system administrator has downloaded. A message tells when no update 
is available.

• Help
Opens the program's online help.

• About
Opens the Product information window and displays the OpenScape 
Desktop Client version number.

• OpenScape Options
This button opens the Settings dialog, which displays the current settings of 
the application.

• Exit OpenScape
This icon serves for closing the application.

4.7  Quick Access Toolbar

The Quick Access Toolbar enables fast access to your OpenScape Desktop 
Client features. It is positioned in the caption bar of the main window above the 
ribbon.
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The <name or number> combo box as well as the Call and 

Hangup features are included in the Quick Access Toolbar by default.

NOTICE:  The remains inactive (shaded gray) as long as the 

<Name or Number> field does not contain any entry. The icon 
is only active during an active call.

The context menu options let you remove features from the bar, adjust the bar's 
position as well as minimize the ribbon. You reach the context menu with a click 
of the right mouse button on the Quick Access Toolbar.

• Remove from Quick Access Toolbar
Removes the relevant icon from the Quick Access Toolbar

• Show Quick Access Toolbar Below the Ribbon
Moves the Quick Access Toolbar below the ribbon. The option changes to 
Show Quick Access Toolbar Above the Ribbon for repositioning the Quick 
Access Toolbar above the ribbon. 

• Minimize the Ribbon
Minimizes the ribbon. Only the tabs' captions are displayed. A click on one of 
these captions displays the associated tab. Another click minimizes the 
displayed tab again.

4.8  Ribbon

Below the Pearl menu and Quick Access Toolbar, the ribbon displays the 
OpenScape Desktop Client controls in tabs and groups by default.

Tabs

Tabs organize controls in the ribbon around core scenarios and tasks the users 
perform with the OpenScape Desktop Client.

The ribbon includes the following tabs, regardless whether you use OpenScape 
Desktop Client at an HFA or SIP communications system:

• Home

• SoftPhone.

Groups

Groups within each tab show related controls together.

The following groups are always available on the Home tab of the ribbon:

• Call Control

• Contacts.

The following groups are available on the SoftPhone tab of the ribbon:

• Calls
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• Device Feature

• Video this group is available only with an SIP connection with operable video 
camera and configured video scheme.

You can integrate all features available in the ribbon in the Quick Access Toolbar 
via the ribbon's context menu. You reach the context menu with a click of the right 
mouse button on the ribbon.

• Add to Quick Access Toolbar
Integrates the icon that was clicked with the right mouse button in the Quick 
Access Toolbar also.

• Show Quick Access Toolbar Below the Ribbon
Moves the Quick Access Toolbar below the ribbon. The option changes to 
Show Quick Access Toolbar Above the Ribbon for repositioning the Quick 
Access Toolbar above the ribbon. 

• Minimize the Ribbon
Minimizes the ribbon. Only the tabs' captions are displayed. A click on one of 
these captions displays the associated tab. Another click minimizes the 
displayed tab again.

4.8.1  “Home” Tab

On the Home tab you find the groups Call Control and Contacts with their 
controls.

4.8.1.1  Controls of the "Call Control" Group

The Call Control group contains the following controls:

• <name or number>
You can enter the phone number or the contact name of the desired conver-
sational partner in this field.

• Call 
For initiating a new call.

• Hang up
To clear an existing connection.
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4.8.1.2  Controls of the “Contacts” Group

The Contacts group provides controls to view and add contacts in your contact 
list.

• View
Click on View to add the Contacts frame to the OpenScape Desktop Client 
main window.

• Add Contact
Click on Add Contact... to open the Add New Contact dialog and add a 
contact to your list.

4.8.2  “SoftPhone” Tab

Independent from the provider module installed (HiPath or SIP Service 
Provider), the SoftPhone tab contains the groups Calls and Device Feature 
with their controls.

If you use OpenScape Desktop Client as SIP softphone and have an operable 
video camera used by an active video scheme, the SoftPhone tab contains the 
Video group in addition. The controls of this group enable switching the video 
camera on and off as well as transmitting your own video image during an active 
connection.

4.8.2.1  Controls of the “Calls” Group

The Calls group is always displayed on the SoftPhone tab, regardless of the 
communications system (HiPath or SIP Service Provider) at which you operate 
OpenScape Desktop Client. Depending on the audio device used it contains the 
following controls:

• Accept/Hook off
Accepts an incoming call or starts a new conversation

• Hang up
Closes a connection

• Mute
Activates and deactivates the muting of an existing connection.

• Voice recording
Activates and deactivates the voice recording function.
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• Headset
Switches the headset on/off in case of an active call or in idle state

• Additional speaker
Switches the additional speaker on/off in case of an active call or in idle state. 
The additional speaker must be configured in the settings for the currently 
used audio scheme.

4.8.2.2  Controls of the “Device Feature” Group

The Device Feature group is always displayed on the SoftPhone tab, regardless 
of the communications system (HiPath or SIP Service Provider) at which you 
operate OpenScape Desktop Client. It enables access to the following telephone 
and dial tone features.

Functions

Click on the Functions button to display the following menu, for example:

NOTICE:  Depending on your PBX further features are available, 
which are described in the following.

• Do Not Disturb
Click on the Do Not Disturb option if you do not want to receive any calls. The 
caller receives a busy tone.

• Call waiting
When the Call waiting option is active, another call that comes in during an 
active call is signaled by a so-called call-waiting tone. The caller hears a 
normal ringing tone and no busy tone. You can then accept, ignore or reject 
the second call. To accept the second call, click on the green handset icon. 
The active call will then automatically be held.

• Second call without tone
This option corresponds to Call waiting, but no call-waiting tone is played.
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• Ringer cutoff
When you activate the Ringer cutoff option, your OpenScape Desktop Client 
will signal incoming calls without ring tone.

• Repertory dialing
When the Repertory dialing option is active, the OpenScape Desktop Client 
creates from an entered character string a digit string that is the actual phone 
number, e.g. the entered character string 0800OpenScape is converted in 
the phone number 0800673672273.

• Voice recording
Activate the Voice recording option to activate or deactivate the recording 
feature. You find the recorded calls in the folder My Documents\My 
Music\VoiceRecordings.

• Directed call pickup
This feature allows you to accept calls that are designated for someone else. 
If e.g. your colleague is called but he/she cannot accept the call himself/
herself (he/she is in a meeting, on the phone on another line, etc.), select the 
option Directed call pickup. In the open dialog of the same name enter the 
phone number of the device with the alerting call. Click on OK. You are 
connected to the caller.

• Pickup call
This feature allows every member of a call pickup group to accept a call for 
another group member. Calls signalled acoustically to a subscriber of a call 
pickup group are at the same time signalled visually to the other group 
members by an LED (next to the programmed key) on the display. You can 
pick up the call by pushing a key or dialing a code number as well as via the 
displayed desktop notification.

• Request messages
You can use this option to play newly received voicemails.

• Delete callback
Selecting this menu option deactivates the callback feature.

NOTICE:  If you want to use the Callback feature, access the 
Advanced tab in the Settings dialog, select the SIP Service 
Provider > Codes option and specify the required codes in the 
Callback area.

• ACD Logon (HFA)
Logging on as call center agent.

• ACD Post-processing (HFA)
Switching to status Post-processing after a call as call center agent.

• ACD not available (HFA)
Call center agent loggs off temporarily.

Lines

Click on the Lines button to display a selection list with all configured lines.
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All lines configured in the OpenScape Desktop Client are displayed in the Lines 
menu. You can change the line options and the line/connection status for 
individual lines. Doubleclick a line to allocate it and to receive a dial tone in the 
Lines menu of the main bar, in the "Lines" window or in the line control in the 
Device Feature Group on the Softphone tab.

All lines configured in the OpenScape Desktop Client can be configured in the 
Lines frame. Only those lines that are shown can be edited.

Call forwardings

Click on the Call forwardings button to display the following menu:

If connection requests are to be diverted in your absence, you can define settings 
for different forwarding types in the OpenScape Desktop Client. This feature can 
be activated or deactivated as required. The provider connected defines which 
types of forwarding are available.

NOTICE:  In the call forwardings menu you see the currently 
active call forwardings highlighted. Forwardings set but not 
available any more are faded gray.

NOTICE:  The active call forwarding items are effective when 
OpenScape Desktop Client is up. When you shut down 
OpenScape Desktop Client and reboot it, the forwardings that 
were active at the time the program was shut down are automati-
cally reactivated and the deactivated ones stay inactive.

NOTICE:  In case of an OpenScape Voice connection, active 
forwardings stay effective even if the OpenScape Desktop Client 
has been shut down. All incoming calls are then forwarded to a 
specific, pre-set destination.

• Add call forwarding...
A click on this option lets you configure a new call forwarding. The following 
dialog opens:

In this dialog you perform the following settings for the new call forwarding: 

– Type
Defines the type of the new forwarding
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– Destination
Defines the phone number to which a call is forwarded

– Optional text
Specifies a text that describes the relevant forwarding. This text is 
displayed in the forwarding menu for selection

• Manage Forwardings...
A click on this option opens the following dialog:

The following controls are available in this dialog:

Forwarding type Setting Function

Forwarding in case of 
"unavailable"

unavailable If you do not accept a call within a pre-set period while OpenScape Desktop 
Client is active, the call is forwarded to the phone number specified under 
Destination.

Behavior of this forwarding type in case of a connection to an OpenScape 
Voice:

• If you do not accept a call within a pre-set period while OpenScape Desktop 
Client is active, the call is forwarded to the phone number specified under 
Destination.

• If the OpenScape Desktop Client is inactive, all incoming calls are forwarded 
to the phone number specified as Destination.

Forwarding in case of 
"busy"

busy If you are conducting a call while OpenScape Desktop Client is active, all 
incoming calls are forwarded to the phone number specified under Desti-
nation.

Behavior of this forwarding type in case of a connection to an OpenScape 
Voice:

• If you are conducting a call while OpenScape Desktop Client is active, all 
incoming calls are forwarded to the phone number specified under Desti-
nation.

• If the OpenScape Desktop Client is inactive, all incoming calls are forwarded 
to the phone number specified as Destination.

Unconditional 
forwarding

always With OpenScape Desktop Client being active, all incoming calls are forwarded 
to the phone number specified under Destination regardless the line state 
("free" or "busy").

At an OpenScape Voice, all incoming calls are forwarded to the phone number 
specified as Destination regardless the line and OpenScape Desktop Client 
state (started or not started).
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– Add...
This button enables configuring a new call forwarding in the Add 
Forwarding dialog.

– Change...
This button enables editing the settings of an already defined call 
forwarding in the Change Forwarding dialog.

– Delete
Using this button you can remove a selected call forwarding from the call 
forwardings list.

– Close
A click on this button closes the Manage Forwardings dialog.

• Deactivate all call forwardings
A click on this option disables all configured forwardings.

• <List of possible call forwardings>
Selecting a call forwarding displayed here toggles the forwarding state:

– a previously inactive call forwarding is activated (displayed highlighted)

– a previously active call forwarding becomes inactive.

4.8.2.3  Controls of the “Video” (SIP) Group

The Video group enables access to the video functions and features the following 
controls:

• Camera image
Using this option you switch your own camera image on or off.

• Video streaming
Activates or deactivates the video data transmission during an active call.

NOTICE:  The buttons Camera image and Video Streaming 
must be activated (see figure above) to enable video telephony. If 
these two buttons are inactive, the OpenScape Desktop Client 
can solely receive video data from other participants. Your video 
image is not sent to the conversational partners.

4.8.2.4  Video Features

Parallel to a voice connection you can also exchange images of the connection 
partners. This requires an operable video camera at yours and your communi-
cation partner's as well as the configuration of a video scheme in the SIP Service 
Provider settings.
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If the above requirements are complied with at your station, you can add the video 
image to the conversation. When your connection partner complies with the video 
transmission requirements, you receive the video image of your connection 
partner automatically, no matter whether a video camera is installed or switched 
on at your station. This requires the Video Viewer module to be active. Your own 
video image or the one sent to your connection partner as well as the video image 
of your connection partner appear in the Video window. The Video window closes 
automatically as soon as no video data is received or sent any more. There is no 
way you can close the Video window manually.

Displaying your own video image

The Camera image button of the Video group is used to switch the camera or 
your own video image on or off. Your connection partner does not see this image.

NOTICE:  You see your own video image mirrored, but it is trans-
mitted unmirrored to the connection partner.

Receiving a video image

Received video images are always accepted and represented, independent from 
an installed or active video camera. This, however, requires the Video Viewer 
module to be active. The representation of received video images cannot be 
suppressed or switched off.

The next figure is an example of the Video window during an active call 
conducted between two connection partners. They receive the image of the 
respectively other participant, but do not yet send any video data themselves.
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Sending a video image (point-to-point video)

To send video images you need an installed and configured video camera as well 
as a video scheme defined in the SIP Service Provider settings. The video 
streaming can be switched to a voice connection only retrospectively. This applies 
to the caller as well as for the callee. During a call, a unilateral or a bidirectional 
video transmission may take place.

You start sending your own image with a click on or enabling the Video 
Streaming button in the ribbon > SoftPhone tab > Video group. Your own video 

image appears in a red frame. The icon changes to .

You stop sending your own image with a click on enabling the Video 
Streaming button in the ribbon > SoftPhone tab > Video group. You can then 
still see the image of your connection partner. After the active call has been termi-
nated, the video streaming comes automatically to an end, too, and you see only 
your own image in the Video window.

Controls in the "Video" Window

Depending on the connection status, the following controls are available in the 
Video window:
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• This icon appears at the bottom margin of the Video window during an 
active call. You use it to start transmitting your own video image. When you 

click the icon, it changes to .

• You use this icon to end transmitting your own video image. When you 

click the icon, it changes to .

• A click on this icon displays your own video image in addition to the image 
of the connection partner in the Video window minimized and in a red frame. 

When you click the icon, it changes to .

• A click on this icon hides your own video image from the Video window. 

When you click the icon, it changes to .

• When you position the mousepointer onto this icon, a tooltip is displayed. 
It informs about options to initiate specific functions of the Video window via 
PC keyboard.

Operating with the PC keyboard

• [Spacebar] - Pressing the [spacebar] you can toggle different layouts of the 
Video window.

• [F11] key - Enabling the [F11] key you can maximize or restore the Video 
window.

NOTICE:  During a video conference or an active call with video 
streaming you can use the keys of your PC keyboard (or of your 
configured preferred device) to give control commands to the 
communications system by sending DTMF tones.

4.8.2.5  Behavior of the Video Streaming

The video streaming behavior follows the changes analog to the audio trans-
mission:

• Call is on-hold
When a call is held, the video streaming stops as well. The held subscriber 
does not see a video screen. If the video streaming status changes during a 
held call, the restoration of the connection follows this change. If, for example, 
the camera is switched off, the video streaming is inactive when the call is 
resumed.

• During a consultation call
For modifications to the video streaming status during a consultation call the 
same applies as for a held call.

• Toggling
When you toggle the active and held subscriber, the video streaming to the 
active subscriber is held and resumed to the held subscriber also. The Video 
window shows only your own video image and the one of the respective 
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subscriber. The video statuses of the two connections are independent from 
each other in this case. In other words, if the video streaming status of one 
connection is changed, it does not affect the other connection.

• Transferring a call
When a call is transferred, the video installation and configuration of the 
subscriber to be transferred and of the new subscriber decides whether no, a 
unilateral or a bidirectional video connection exists.

• Local video conference
In case of a local conference in which all participants have activated the video 
streaming, the initiator of the conference receives the video images of the 
other two participants. Three video images can be seen in his/her Video 
window: his/her own one in a red frame and two of the other participants. The 
other two conference participants see in the Video window the following: their 
own video image in a red frame and one received video image. The initiator 
mixes the latter in a way that a participant receives the video image of the 
initiator and of the third participant in one video image.
If the initiator has not installed, configured or activated a video camera, the 
initiator receives both video images within a conference, but since his/her own 
video transmission channel is missing, the other two participants do not 
receive a video image.
If at least one participant has not installed, configured or activated a video 
camera in a conference, the initiator does not adopt a video mixing function, 
so that both participants receive the video image of the initiator.

4.8.2.6  Views of the Video Window

The video feature of OpenScape Desktop Client offers various default views for 
the video window depending on the number of active video images (one, two or 
three) and on the currently selected perspective. You can toggle the default views 
by pushing the space bar. In addition, the video feature of OpenScape Desktop 
Client enables you to customize video window views.

NOTICE:  The figures shown in the following are examples. They 
help the user to imagine possible default views of the Video 
window.

NOTICE:  The number of available default views depends on the 
current connection type: unilateral, bidirectional or trilateral video 
connection.

Views of an Image in the Video Window

If the Video window contains only one image - your own image or the one of the 
connection partner - the window view remains almost unchanged when you 
modify the angle. The following views are pre-set:

• Your own image is positioned in the middle of the video window. The 
connection to the connection partner is not up yet.
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• The image of the connection partner is positioned in the middle of the video 
window. Your own image is being sent but it's preview in the Video window is 
switched off.

• Your own image or the received one appears in the center of the video 
window.

• Your own image or the received one appears in the center of the video window 
and is slightly turned.

Views of two Video Images in the Video Window

During a point-to-point video connection the Video window contains two images: 
your own (sent image) and the one of the connection partner (received image). 
These images may be arranged in the video window as follows:

• Your own image is minimized and appears in a red frame at the bottom left 
window margin.
 A31003-G2570-U100-1-7619, 05/2012
174 OpenScape Personal Edition V7, User Guide



Operation Reference
Ribbon
• Your own image is minimized and appears in a red frame at the top right 
window margin.

• Both images appear slightly rotated.
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• Both images appear on top of each other.
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• Both images appear next to each other.

Views during a local Video Conference

During a local video conference the Video window of the initiator contains three 
video images: his/her own image and the images of the respective connection 
partners. These images may be arranged in the video window as follows:

• Your own image is minimized and appears in a red frame at the bottom left 
window margin.

• The image of the initiator is minimized and appears in a red frame in the 
center of the bottom screen area.
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• The images of the conversation partners appear slightly turned.

• The three images appear on top of each other.

• The three images appear next to each other

The other two conference participants see in the video window only two images: 
their own video image in a red frame and one received video image. The initiator 
mixes the latter in a way that a participant receives the video image of the initiator 
and of the third participant in one video image. 
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Customized Views

The video feature of the OpenScape Desktop Client enables you to customize 
pre-defined video window views.

• Moving a video image in the video window
To change the position of an image in the video window, click in the center of 
the video image. The mousepointer appears in the center of the image. Keep 
the left mousebutton pressed and drag the image to the desired position in the 
video window. Then release the mousebutton.

• Maximizing/minimizing the video image
Click on one margin of the image frame, keep the mousebutton pressed and 
drag the mousepointer in the desired direction to maximize or minimize the 
image.
You can also rightclick the center of an image, keep the right mousebutton 
pressed and move the mouse up and down. The proportions of the selected 
video image become smaller or larger.

• Turning the video image
Rightclick the center of an image, keep the mousebutton pressed and move 
the mouse to the left or right. The image turns to the corresponding direction.

NOTICE:  While you adjust a video image, it appears transparent 
as you can see in the below figure.
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The changes to the default view automatically apply for current operation and are 
dismissed when you shut down the program. After a reboot of OpenScape 
Desktop Client only the pre-set views are available. 

4.9  General Information about Frames

A frame is an element of the OpenScape Desktop Client graphic user interface 
marked by its caption bar and specific operating elements. The caption bar of 
each frame consists of the following elements:
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NOTICE:  All options listed under Pearl menu > View except 
Integrated Telephone and Free Phone can be added to the main 
view as frames.

The following sections describe the frames available in the OpenScape Desktop 
Client, their controls and functionality.

4.10  Frame "Call Control"

You can initiate, control and accept calls from the Call Control frame. It also 
displays information about incoming, active and outgoing calls. The frame 
displays the called or calling number followed by your phone number.

By clicking on the section displayed on the left and with the left 
mouse button kept pressed each frame can be:

• added to the main view or deleted from it (the frame adopts 
the view of a window that you can freely position on the 
desktop),

• moved up or down in the main view.

This icon serves to minimize each frame in the main view. A 
frame is minimized if only its caption bar is displayed and has 
been replaced by . A click on on restores the last frame 
size.

<Frame name> • Contacts

• Journal

• Call Control

• Directory Search

• Lines

• Webbrowser

Opens the online help window for the corresponding frame.

Maximizes the frame or minimizes all other main view frames. 

Click on in a maximized frame to return to the last view size 
of the frame.

Closes the frame. Via Pearl menu  > View > <desired option> 
it can be opened again or displayed in the main view.
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Depending on the connection status (outgoing call, incoming call, active call and 
number of calls), the right-hand section of the Call Control frame provides 
various control options.

Inbound Call

In case of an incoming call, the Call Control frame provides the following control 
options:

•
Accept call

•
Opens the Transfer to window in which you can enter the phone number of 
another device to deflect the incoming call to.

•
Reject call

Active Call

In case of an active call, the Call Control frame provides the following control 
options:

•
Terminate active call

•

Set active call to on-hold The icon changes to: . 

•
Resume held call

•
Opens the Transfer to window in which you can enter the phone number of 
another device to deflect the active call to.

• l
Displays a keypad on the screen that allows transferring digits as DTMF tones 
(tone dialing).

Consultation Call

In case of a consultation call, the Call Control frame lists two calls: the held and 
the consultation call. The following control options are available in the area of the 
held call:

•
Disconnect active call

•
Transfers the held call to the consultation-call subscriber. Your connection is 
then automatically cleared.

• l
Displays a keypad on the screen that allows transferring digits as DTMF tones 
(tone dialing).
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The following control options are available in the consultation call area:

•
Disconnect active call

•

Set active call to on-hold The icon changes to: . 

•
Resume held call

•
Opens the Transfer to window in which you can enter the phone number of 
another device to deflect the active call to.

•
Select this option if two connections exist (one is on hold and the other one is 
active) to connect the other two subscribers. Your telephone calls are now 
finished.

•

Click on to display the below keypad.

You can use this keypad to dial a phone number or select other options 
(sending DTMF characters) when deploying an answering machine or while 
playing your voicemails.
You can enter DTMF characters also via the PC keyboard of by copy&paste. 
Copy the desired content (e.g., PIN, phone number, etc.) by simultaneously 
pushing [Ctrl] + [C] to the clipboard. Then click on . Paste the copied 

content via [Ctrl] + [V] in the DTMF dialing keyboard. Enable at the top 
right margin on the DTMF dialing keyboard for sending this content. The 
selected DTMF characters are displayed at the top left margin of the DTMF 
dialing keypad.

•
The existing connections are extended to a conference (participant-controlled 
conference). You can add up to 48 participants to this conference.

•
Phone calls (one or both set to on-hold) are merged to a local conference 
(three-party conference), so that all three participants can talk to each other. 
No further participants can be added.
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•
Using this feature you can toggle two connections. Only the subscribers to the 
active connection can talk to each other. The conversational partner who has 
been put on-hold listens to music-on-hold until the conversation is taken up 
again.

•
This option allows you to record the conversation. You find the recording in 
the folder My Documents\My Music\VoiceRecordings.

Outbound Connection

In case of an outgoing call, the Call Control frame provides the following control 
options:

•
Terminate initiated call

4.10.1  Context Menus of the "Call Control" Frame

When the Call Control frame displays a connection, you can invoke a context 
menu by clicking the right mousebutton. Depending on the connection status 
(outbound, inbound or existing connection and number of connections), the 
context menu offers various options for controlling the respective connection.

4.10.1.1  Context Menu of an outbound Connection

An outbound connection is a connection that you have initiated. OpenScape 
Desktop Client displays this connection in the Call Control frame. The desired 
connection partner has not yet accepted your call.

During an outbound call the context menu of the Call Control frame provides the 
following options:

• Disconnect

Click Disconnect to clear the connection.

• Callback
Select this option to activate the callback function.
This feature is only available for specific PBXs.

• Start voice recording
Click on Start voice recording to record the conversation. You find the 
recording in the folder My Documents\My Music\VoiceRecordings.

4.10.1.2  Context Menu of an inbound Connection

An inbound connection has been set up by another subscriber. OpenScape 
Desktop Client displays this connection in the Call Control frame. You have not 
yet accepted this call.
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The context menu provides the following options:

• Accept
Click on Accept to set up an active connection.

• Transfer to...
Click on Transfer to... to open the Transfer to dialog and to enter the phone 
number of the device to which you want to transfer the incoming call.

• Reject
Click on Reject to reject the call.

• Start voice recording
Click on Start voice recording to record the conversation. You find the 
recording in the folder My Documents\My Music\VoiceRecordings.

4.10.1.3  Context Menu of an active Call

During an active call the context menu of the Call Control frame offers the 
following options:

• Disconnect
Click on Disconnect to clear the existing connection.

• On hold
Click on On hold to hold the active call. The On hold menu option is replaced 

with Back to Waiting. Click on Back to Waiting to retrieve the held call.

• Transfer to
Click on Transfer to... to open the Transfer to dialog and to enter the phone 
number of another device to which you want to transfer the active call.

• Consultation to
Click on Consultation to to place a call on hold and to set up a new 
connection to another extension.

• Public Hold
Click on Public Hold to keep a call in the PBX. You can then ring off and 
accept the call at another telephone.

• DTMF-dialing
Click on DTMF-dialing to display the below keypad.
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You can use this keypad to dial a phone number or select other options 
(sending DTMF characters) when deploying an answering machine or while 
playing your voicemails.
You can enter DTMF characters also via the PC keyboard of by copy&paste. 
Copy the desired content (e.g., PIN, phone number, etc.) by simultaneously 
pushing [Ctrl] + [C] to the clipboard. Then click on . Paste the copied 

content via [Ctrl] + [V] in the DTMF dialing keyboard. Enable at the top 
right margin on the DTMF dialing keyboard for sending this content. The 
selected DTMF characters are displayed at the top left margin of the DTMF 
dialing keypad.

• Start voicerecording
Click on Start voicerecording to record the conversation. You find the 
recording in the folder My Documents\My Music\VoiceRecordings.

4.10.1.4  Context Menu of a Consultation Call

NOTICE:  The number of offered options depends on the type of 
the communications system used.

During an active consultation call the context menu of the Call Control frame 
offers the following options, for example:

• Disconnect
Click on Disconnect to clear the existing connection.

• On hold
Click on On hold to hold the active call. Click on Back to Waiting to retrieve 
the held call.
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• Transfer to...
Click on Transfer to... to open the Transfer to dialog and to enter the phone 
number of another device to which you want to transfer the active call.

• Transfer
Select this option if two connections exist (one is on hold and the other one is 
active) to connect the other two subscribers. Your telephone calls are now 
finished.

• DTMF-dialing
Click on DTMF-dialing to display the below keypad.

You can use this keypad to dial a phone number or select other options 
(sending DTMF characters) when deploying an answering machine or while 
playing your voicemails.
You can enter DTMF characters also via the PC keyboard of by copy&paste. 
Copy the desired content (e.g., PIN, phone number, etc.) by simultaneously 
pushing [Ctrl] + [C] to the clipboard. Then click on . Paste the copied 

content via [Ctrl] + [V] in the DTMF dialing keyboard. Enable at the top 
right margin on the DTMF dialing keyboard for sending this content. The 
selected DTMF characters are displayed at the top left margin of the DTMF 
dialing keypad.

• Initiate server-based conference
The existing connections are extended to a conference (participant-controlled 
conference). You can add up to 48 participants to this conference.

NOTICE:  This option is displayed only if the Conference Factory 
URI has been configured in the dialog Settings > Advanced tab 
> SIP Service Provider > System functions. If this setting is 
missing, the Initiate local conference option is available in the 
context menu. 

• Initiate local conference
Phone calls (one or both set to on-hold) are merged to a local conference 
(three-party conference), so that all three participants can talk to each other. 
No further participants can be added.

• Enter Conference
Via this option further participants can be added to a conference. This option 
is only available during an active server-based conference (participant-
controlled conference).
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• Toggle
Using this feature you can toggle two connections. Only the subscribers to the 
active connection can talk to each other. The conversational partner who has 
been put on-hold listens to music-on-hold until the conversation is taken up 
again.

• Start voice recording
Click on Start voice recording to record the conversation. You find the 
recording in the folder My Documents\My Music\VoiceRecordings.

4.11  "Contacts" Frame

The Contacts frame displays all of the contacts you entered into the contact list. 
Use the contact list to perform the following actions:

• Directory Search
You can enter the first or last name of a contact in the <Search in contact 
list> field to use this information as criterion for searching different directories. 
If a similar name is already available in your contact list, it is listed on top of 
the below Search Directories for button. A click on the name marks the 
contact entry in the list.

• Adding a contact

A click on opens the Add New Contact dialog for adding a new contact 
entry to your contact list.

• Removing contact/group

With a click on you can remove the name of a contact or group from your 
contact list.

• Calling

Clicking on or (if several phone numbers are specified for a contact) 
you can initiate a call to the contact of your contact list. This outbound call is 
then displayed in the Call Control frame.

NOTICE:  If several phone numbers are available for the contact 

you wish to call, click on to select one of them.
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4.11.1  Adding a new Contact

The contact list can contain names from several sources. You can add names 
from Microsoft Outlook. You can also copy contacts from an internal company 
directory. And you can manually create new contacts via the Add New Contact 
dialog.

NOTICE:  You reach the Add New Contact dialog via the context 

menu of the Contacts frame or with a click on  in the Contacts 
frame.

The Add New Contact dialog lets you enter the following information for a new 
contact:

• Last name
Last name of the new contact.

• First name
First name of the new contact.

• <Contact information> combo box
Select the contact information that you want to configure from the list. In the 
field to the right of the combo box you can make you entries for the following 
contact data:

– Phone Business

– Phone Business 2

– Phone Mobile

– Phone Private

– Fax
Depending on the activated modules the following input options may also be 
available:

– E-mail Business
In case of active Sendmail Provider module only

– E-mail Business 2
In case of active Sendmail Provider module only

– Web Address
In case of active Web Access Manager module only

– SIP address
In case of active SIP Service Provider module only
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• Contact Details
With a click on the Contact Details button you open the Add Contact dialog. 
In this dialog you can enter further information for the new contact.

• Add
A click on this button closes the Add New Contact dialog and integrates the 
new contact in the contact list.

• Cancel
A click on this button closes the Add New Contact dialog. The settings you 
have made will then not be saved.

4.11.2  Contact Details

In addition to standard contact data such as name, first name, phone number etc. 
you can specify more detailed information on a contact in the OpenScape 
Desktop Client. This information includes the address, job-related facts or a photo 
that you can add to the contact profile.

You complete the information about a new contact in the Add Contact dialog. 
Furthermore, you can edit the detailed contact data of an already existing contact 
in the Change Contact dialog. You reach both dialogs in the Contacts frame via 
the Add New Contact or Change Contact Information dialog as well as with a 
click on the Contact Details button.

NOTICE:  You invoke the Add New Contact dialog via the context 
menu of the Contacts frame by selecting the Add Contact... 
option.

NOTICE:  You invoke the Change Contact Information dialog 
via the context menu of the Contacts frame by selecting the Edit 
Contact... option.
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The following options are available for entering contact information:

• Last name
You can enter here a maximum of 64 characters to specify a surname.

• First name
You can enter here a maximum of 64 characters to specify a forename.

• Address
You can enter here a maximum of 64 characters to specify an address.

• Zip code/City
In the first field you can enter a maximum of 7 characters to specify the Zip 
code. In the second field you can enter a maximum of 40 characters to specify 
a town or city.

• Company
You can enter here a maximum of 64 characters to specify a company name.

• Department
You can enter here a maximum of 64 characters to specify a department.

• Room number
You can enter here a maximum of 32 characters to a room number.

• State
You can enter here a maximum of 40 characters to specify a state or county.

• Country
You can enter here a maximum of 40 characters to specify a country.

• Internet page
You can enter here a maximum of 64 characters to specify a URL.

• Select Image
A click on this button opens a dialog in which you can select an image for the 
relevant contact. A click on Open closes the dialog and the selected image is 
integrated.
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• Delete Image
A click on this button deletes the image assigned to the selected or new 
contact.

The Add Contact or Change Contact includes four tabs in the bottom section.

• Web Address
Displays the contact’s web address.

NOTICE:  The Web Address tab is available in case of the active 
Web Access Manager module only.

• E-mail
Displays all e-mail addresses defined for this contact.

• Call number
Displays all phone numbers entered for this contact.

• SIP address
Displays the contact’s SIP address.

NOTICE:  This tab is only displayed if you have selected the SIP 
Service Provider as default provider.

Each of the four tabs provides the following functions:
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• Add...
A click on this button opens an input dialog. In this dialog's Description field 
you enter a short description of the associated information (web address, e-
mail, phone number or SIP address). If you specify several information 
items of the same type, a description helps to distinguish them. The type of 
information that you can add depends on the respectively active tab.

• Change...
A click on this button opens a dialog in which you can edit the web address, 
e-mail, call number or SIP address already available for the contact.

• Delete
With a click on this button you remove a selected web address, e-mail, call 
number or SIP address for the relevant contact. Before you can actually 
delete the selected item, a message appears that you need to confirm with 
OK, upon which the relevant information is deleted then.

• OK
A click on this button closes the Add Contact or Change Contact dialog. 
Your entries or modifications are saved.

• Cancel
A click on this button closes the Add Contact or Change Contact dialog. 
Your entries or modifications are not saved.

4.11.3  Context Menus of the "Contacts" Frame

The Contacts frame offers the following context menus.

4.11.3.1  Context Menu of a Contact

Rightclick a contact's name to display the following context menu.

• Add Contact...
Click on Add Contact... to open the Add New Contact window.

• Create Group...
Click on Create Group... to open the Create Group window for assigning a 
group name to a contact.
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• Edit Contact...
Click on Edit Contact... to open the Change Contact Information window to 
modify the information of an existing contact.

NOTICE:  The menu options Add Contact... and Edit Contact... 
open two dialogs that provide the same setting options.

• Synchronize Contact...
This feature requires an OpenScape UC Application server and has therefore 
no functionality.

• Add Contacts to Group...
Select one or several contacts and click on Add Contacts to Group... to open 
the Add Contacts window and to add the contact(s) to one of the listed 
groups.

• Move Contacts to group...
Select one or several contacts and click on Move Contacts to group... to 
open the All Groups window and to assign the contact(s) to another group.

• Default Name Order
You can use the Default Name Order option to define in which sequence the 
first and last name of your contacts are displayed: <last name, first name> or 
<first name, last name>.

• Sort Contacts
You can use the Sort Contacts option to determine whether the list of your 
contacts should be sorted alphabetically Ascending (A - Z) or alphabetically 
Descending (Z - A).

• Delete
Click Delete to remove the name of the selected contact from your list of 
contacts.

4.11.3.2  Context Menu of a Group

Right-click the name of a group to display a menu from which you can select the 
following settings:

• Add Contact...
Click on Add Contact... to open the Add New Contact dialog and to add a 
new contact to the selected group.
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• Create Group...
Click on Create Group... to open the Create Group dialog and to add a new 
group to your contact list.

• Rename Group...
Click on Rename Group... to open the Rename Group dialog and to assign 
a different name to the selected group.

• Duplicate Group...
Click on Duplicate Group... to open the Duplicate Group dialog in which you 
can assign a new name to the selected group. The same contacts will then be 
summarized under two different group names in the Contacts frame.

• Default Name Order
You can use the Default Name Order option to define in which sequence the 
first and last name of your contacts are displayed in the selected group: <last 
name, first name> or <first name, last name>.

• Sort Contacts
You can use the Sort Contacts option to determine whether the list of 
contacts in the selected group should be sorted alphabetically Ascending (A 
- Z) or alphabetically Descending (Z - A).

• Delete
Click Delete to remove the selected group from your list of contacts.
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4.12  Directory Search

In the Directory Search frame you can access your company directory and your 
private contacts.

It is not displayed in the OpenScape Desktop Client main view by default. Go to 
the Pearl menu  > View and select the Directory Search option. The separate 
Directory Search window is displayed.

To integrate this window as frame in the main view, click on the area and drag 
the frame to the desired position in the main view.

The following features are available in this window or frame:

<search address books>

In this field you enter the name to be searched for in the configured directories.

Take into account the following points during the entry:

• The “blank” character is the default field separator.

• The order of given name and surname is not important.

• Names that include an affix are handled like given name and surname. This 
leads to No Search Results.

<number of directories>

Select in this combo box the directories to be searched for the desired contact.

• All Directories
If this checkbox is set, OpenScape Desktop Client will search all configured 
directories for the desired contact.

• Microsoft Outlook directory
If this checkbox is set, OpenScape Desktop Client will search your 
Microsoft Outlook contact list for the desired contact.

• <corporate directory>
If this checkbox is set, OpenScape Desktop Client will search the configured 
directory of your company for the desired contact.

Execute the search

A click on this icon starts the search for the desired contact in the configured direc-
tories. The search results are listed in the Directory Search window or frame.

Add to contact list

A click on this icon integrates a selected contact in the OpenScape contact list.
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If a contact with the same first and second name exists already in your contact 
list, the Similar contact detected dialog is displayed.

In this dialog you can perform the following settings:

• Add the contact anyway
Adds the new contact under the same name to the contact list.

• Update new information from this contact to the existing one:
Select this option if you want to update the contact information of one of the 
contacts in your OpenScape contact list.

• Remember decision for other contacts
If this checkbox is active, the Similar contact detected dialog is no more 
displayed in case of repeated similarity of contact data. Depending on the 
active option, the new contact is directly integrated in the OpenScape contact 
list or the data of a contact already available in your OpenScape contact list 
is automatically updated.

4.13  "Journal" Frame

In the Journal frame OpenScape Desktop Client logs all in- and outgoing calls 
locally on the computer as long as the OpenScape Desktop Client is started. 
Furthermore, you can initiate connections to logged communication partners from 
the Journal.
A31003-G2570-U100-1-7619, 05/2012
OpenScape Personal Edition V7, User Guide 197



Operation Reference
"Journal" Frame
The Journal frame remains empty until you make at least one call or receive a 
call.

NOTICE:  Please note that no calls are logged in the Journal if 
OpenScape Desktop Client is not started. Incoming calls that 
were missed while OpenScape Desktop Client was not started 
are not displayed in the Journal after the application's start.

4.13.1  Journal Controls

The following controls are available in the Journal frame for operating the journal:

• <search in journal list>
Enter a contact name, a contact number or a conference description in the 
<search in journal list> entry field to search for a corresponding journal 
entry. The journal entries that correspond to the entered search mask are 
automatically listed in Journal frame by the OpenScape Desktop Client. If the 
name or phone number searched for have not been found, the Journal frame 
does not show any entries.

• Call a contact

Select a call entry in the journal and click on  to set up the connection.

• Delete journal entry

Select a call entry in the journal and click on  to remove the entry from the 
journal.

• Play voice recording
If you have selected a journal entry for which a voice recording is available, 
you can click on to play the recording. The icon in the row of the relevant 
journal entry indicates whether a voice recording is available. 

• Delete Voice Recording
If you have selected a journal entry for which a voice recording is available, 
you can click on Delete Voice Recording

In the Journal frame you can select the scheme for representing the journal infor-
mation.

• Change to period view

Click on  to activate the period view. In this view, the entries in the Journal 
frame are grouped in periods.
The number of entries for the following periods are displayed in the Direction 
column:

– Today (number of entries)

– This week (number of entries)

– Last week (number of entries)

– Two weeks ago (number of entries)

– Three weeks ago (number of entries)
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– More than three weeks ago (number of entries)
The rest of the connection data in this representation are the same as in the 
normal view. 

• Switch to normal view 

Click on to deactivate the period view and return to the normal view.

When the period view is deactivated, a contact name is associated with each 
call in the combined view for both the activated and deactivated states. In this 
representation the following call data is displayed:

– Direction 
The call direction is displayed as icon.
Click the icon preceding the Direction label to sort the list of journal 
entries Ascending or Descending .

– Time
The time at which the call was made or received.
Click the icon preceding the Time label to sort the list of journal entries 
Ascending or Descending according to the respective times. 

– Name
Name or number of the contact or conference.
Click the icon preceding the Name label to sort the list of journal entries 
Ascending or Descending in alphabetic order.

– Number
Displays the called or calling phone number.
Click the icon preceding the Number label to sort the list of journal entries 
Ascending or Descending  in numerical order.

– Connection Time
Displays the call duration.
Click the icon preceding the Connection Time label to sort the list of 
journal entries Ascending or Descending according to the 
connection time.

– Note
A note added to a call via the Edit note context menu option.
Click the icon preceding the Note label to sort the list of journal entries 
Ascending or Descending according to notes.

• Combined view

Click on  to activate the combined view.
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NOTICE:  This view can be combined with one of the two other 
views - normal or period view.

In this representation the following call data is displayed:

– Direction
Depending on the other view which is active at the same time, this column 
is the same as the column of the period or normal view.
The call direction is displayed as icon.
Click the icon preceding the Direction label to sort the list of journal 
entries Ascending or Descending . 

– Time
The time at which the call was made or received.
Click the icon preceding the Time label to sort the list of journal entries 
Ascending or Descending according to the respective times. 

– Name
Name or number of the contact or conference.
Click the icon preceding the Name label to sort the list of journal entries 
Ascending or Descending in alphabetic order.

– Connection Time
Displays the call duration.
Click the icon preceding the Connection Time label to sort the list of 
journal entries Ascending or Descending according to the 
connection time.

– Note
A note added to a call via the Edit note context menu option.
Click the icon preceding the Note label to sort the list of journal entries 
Ascending or Descending according to notes.

• Click to return to the normal or period view.

• Options for filtering journal entries

Select in the drop-down menu next to the combined view icon an option 
that determines how information is filtered in your journal. The selection list 
contains the following options:
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4.13.2  Context Menu of the "Journal" Frame

If you rightclick an entry in the Journal frame, a context menu appears that may 
look as follows:

In the following we describe all options possible in this context menu:

• Call
Click on Call to call the contact.

• Delete
Click on Delete to remove the journal entry.

• Edit Note
Click on Edit Note to open the Edit a Note dialog.

Here you can add a note to the selected connection in the journal.

Icon Definition Description

All All entries are displayed in alphabetic order 
according to the contact names.

Incoming / outgoing – 
connected

All active calls are displayed.

Incoming – connected All active incoming calls are displayed.

Incoming – not reached All unaccepted incoming calls are displayed.

Outgoing – connected All active outgoing calls are displayed.

Outgoing – not reached All unaccepted outgoing calls are displayed.
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• Delete Note
Click on Delete Note to remove a call note from the journal. If no note is 
available for the entry, this option is inactive.

• Copy Number
When you click on Copy Number, the phone number of the entry is pasted to 
the clipboard and can be inserted in other applications.

• Play Voice Recording
This option is only available when you rightclick a journal entry for which a 
voice recording is available. A click on the Play Voice Recording option 
starts the voice recording playback.

• Delete Voice Recording
This option is only available when you rightclick a journal entry for which a 
voice recording is available. A click on the Delete Voice Recording option 
deletes the voice recording.

• Delete complete history
Click on Delete complete history to remove the history of the call from the 
journal.

• Combined Views
Click on Combined Views to activate the combined view.

• Period View
Click on Period View to view the connection entries grouped in specific 
periods.

4.14  Lines

The Lines frame is not displayed in the OpenScape Desktop Client main window 
by default. Go to Pearl menu  > View and select the Lines option. The Lines 
frame is displayed.

NOTICE:  You must have configured at least one additional line to 
view the Lines option under Pearl menu > View.

To integrate this frame in the main window, click on the area and drag the frame 
to the desired position in the main window.
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The Lines frame (SIP only) displays all configured lines that are activated for 
representation and their statuses. You can configure the appearance of the lines 
display by clicking the OpenScape Options button at the bottom of the Pearl 
menu and then selecting the tab Advanced > Device State > Lines.

Icons indicate the line type, the line or call status and the line options. 
Furthermore, the display text or user deposited in the line configuration is put out 
in the lower row. If the line is not in idle state and call partner information is 
available, this information is shown in the upper row.

4.14.1  Icon Displays in the Line Window

The following status displays are shown per line:

Icon Meaning

Line type

Corresponds to the primary line (own line).

Corresponds to the secondary line (foreign line).

Line options

Line is the default line for incoming calls.

Line is the default line for outgoing calls.

Line is a private line.

Lime is a commonly used line.

Line rings in case of incoming connection requests.

Line does not ring in case of incoming connection requests.

Line rings delayed in case of incoming connection requests.

Line/call status

Ringer cutoff (no call)

Ringer cutoff (diverted)

Line is used for an outgoing connection request, corresponds to status 
start / accomplish dialing.
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4.14.2  Working with Lines

Initiating a call

The following options are available for calling a contact via a specific line:

• You doubleclick the desired line and dial the call partner in the integrated or 
free phone. The connection is set up, using this line.

• Using the drag & drop method you drag a contact from the contact directory 
to the desired line. The connection is set up, using this line.

• Click on in the main bar. The preferred line will automatically be used for 
the following connection request.

Accepting a call

The following options are available to accept a call on a specific line:

• You can accept incoming connections requests with a doubleclick on the line 
on which they arrive. You conduct the call via this line then.

• If you click on in the main bar, the preferred line is automatically used to 
answer inbound connection requests (for incoming calls).

Parking a call

The following options are available for parking a call:

• You park an active call on a line by doubleclicking the line status icon.

• Another doubleclick on the line status icon will reactivate parked or privately 
held calls.

Line is used for an outgoing connection request, destination rings.

Line is used, destination is busy.

Line is used, status connected.

Incoming connection request on preferred line.

Incoming connection request on non-preferred lines.

Line is used by third party (currently not operable).

Call is publicly held on the line and can be accepted (similar to 
parking).

Connection is held (in case of a consultation on one / the same line).

Icon Meaning
 A31003-G2570-U100-1-7619, 05/2012
204 OpenScape Personal Edition V7, User Guide



Operation Reference
Status Bar
4.14.3  Context Menu of a Line

Right-click the line you want to edit in the Lines frame. A context menu opens.

The currently active lines options are marked and can be modified.

You can select one of the following features:

• Preferred lines for outgoing calls
The line is preferred for outgoing calls.

• Preferred lines for incoming calls
The line is preferred for incoming calls.

• Ring immediately on incoming call
Incoming connection requests are signaled.

• Do not ring on incoming call
Incoming connection requests are not signaled.

• Deferred ring on incoming call
Incoming connection requests are signaled delayed.

4.15  Status Bar

In the status bar on the left hand side you can see the number of occurred errors. 
When you doubleclick this error status you receive more detailed information 
about these errors. 

Error Status

Volume Control

Volume Menu
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On the right hand side the ring tone volume control is displayed when no call is 
active. When the SIP connection is active, the payload is displayed.

4.16  Free Phone

The OpenScape Desktop Client has a telephone that can be freely positioned on 
the desktop and used as dial aid. Via this telephone you can make calls, accept 
incoming ones etc.

To display the Phone window on the desktop, select Pearl menu > View > Free 
phone.

NOTICE:  The free phone is only available (selectable in the Pearl 
menu > View) when the Telephone module is active.

The OpenScape Desktop Client free phone offers the following controls:

• Display
The two-line display shows time, date and your own phone number. During 
an active call you can use dialog keys to browse different functions or select 
them.

• Telephone keypad
On the telephone keypad you find digit keys from [0] to [9] (with the corre-
sponding assignment to letters) as well as the keys [*] and [#]. Depending on 
the input mode you can enter normal and special characters by pushing keys. 
Push the appropriate key as often as it takes to show the desired character in 
the display.

Display

Telephone
Keypad

Dialog Keys
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• Dialog keys
You use the three dialog keys for browsing (back and forth) and to confirm 
functions.

4.17  Integrated Phone

The OpenScape Desktop Client has an integrated phone that can be used as a 
dialing aid. The integrated phone is docked to the main bar. When you click the 
display that appears in the main bar when the integrated phone is active, a 
keypad appears under the display. Via this telephone you can make calls, accept 
incoming ones etc.

To display the Phone window on the desktop, select Pearl menu > View > 
Integrated phone.

The integrated phone of OpenScape Desktop Client offers the same controls as 
in the free phone.

4.18  SoftPhone

To display the SoftPhone window on the desktop, select in the Pearl menu  > 
View > SoftPhone.

NOTICE:  Opening the softphone via Pearl menu > View is only 
possible with the active SoftPhone module.

The SoftPhone serves as dial aid that you can freely position on the desktop. To 
integrate the softphone in the main window or to remove it from there, click on the 

depicted area at the left margin under the window caption bar with the mouse-
button kept pressed.
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The following operating options are available in the OpenScape Desktop Client 
softphone:

• Display
The two-line display shows time, date and your own phone number. During 
an active call you can use dialog keys to browse different functions or select 
them.

• Keypad
On the keypad you find digit keys from [0] to [9] (with the corresponding 
assignment to letters) as well as the keys [*] and [#]. Depending on the input 
mode you can enter normal and special characters by pushing keys. Push the 
appropriate key as often as it takes to show the desired character in the 
display.

• Dialog keys
You use the three dialog keys for browsing (back and forth) and to confirm 
functions.

• Audio keys
The four audio keys let you switch an additional speaker as well as a micro-
phone on or off, initiate or accept a call, and clear an existing connection or 
reject a connection request.

4.19  Extended Keypad

If you operate OpenScape Desktop Client via the HiPath Provider at a HiPath 
4000 or HiPath 3000, the extended keypad is available to you in the OpenScape 
Desktop Client. It contains programmable function keys, which are allocated with 
phone numbers frequently dialed or with telephony features.

Display

Dial Keys
Dialog Keys

Audio Keys
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You open the extended keypad via the Pearl menu > View > Extended Keypad. 

The keypad can contain up to four key columns. The number of key columns, the 
number of function keys per column as well as the allocation of the function keys 
depends on the selected device or key module type in the HiPath Provider config-
uration.

If the extended keypad comprises several columns, you can unfold or hide them 
at will. For this purpose, use the triangle icons at the top margin of the respective 
column as exemplified in the next figure.

After the OpenScape Desktop Client setup, some keys may already be allocated 
with default functions of the HiPath 3000/4000 used.

The telephone or key module type configured in the HiPath Provider determines 
whether Electronc Key Labeling (EKL) is available. If EKL is available, all keys 
that are or will be programmed with a function are automatically labelled with the 
function text specified in the HiPath system for this purpose. In this case you 
cannot individually label the function keys configured in OpenScape Desktop 
Client anymore.

If you have a telephone or key module type without EKL selected for OpenScape 
Desktop Client, you can use the context menu of the extended keypad to allocate 
keys with functions individually and label them manually.
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4.19.1  Context Menu of the Extended Keypad

You can use the context menu of the extended keypad to allocate keys with 
functions individually and label them.

NOTICE:  If a telephone or key module type with EKL has been 
configured for the OpenScape Desktop Client telephone, you 
cannot allocate the keys of the extended keypad with functions 
individually and label them.

The following options are available for allocating and labelling the keys:

• Change Caption...
Opens a dialog in which you can define a caption of the selected key.

• Accept caption from display
Allows copying a key caption from the current display of the OpenScape 
Desktop Client telephone. Two options are available:

– Accept caption from display
Copies the phone number currently shown in the telephone display as key 
caption.

– Shift key + Accept caption from display
Copies the name currently shown in the telephone display as key caption.

4.20  Webbrowser

NOTICE:  Using the web browser features requires the 
Webbrowser module to be active.

You can use the OpenScape Desktop Client web browser like any other standard 
browser to open configured internet pages and deploy navigation features. The 
web browser thus enables fast access to internet pages frequently visited. 

Opening the Web Browser

To open the window that displays the web browser, select Pearl menu > View > 
Webbrowser. In the submenu then available select a previously configured 
internet page. 

The caption bar of the opened window features the internet page's name that was 
defined during the configuration of the internet addresses. 
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Four icons in the top left corner of the window assist you in working with the web 
browser:

• Page back
Makes the browser return to the previous page.

• Page forward
Makes the browser move forward to the next page.

• Cancel
Stops the current internet page loading.

• Update
Reloads the currently displayed internet page.

4.21  Notifier Toast

An incoming call displays a notifier toast in the bottom right area of the desktop 
on the first ring and for as long as the call continues to ring. You can accept the 

call ( ), reject it ( ) or forward it to another phone number ( ).
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If the caller's phone number was found in the configured directories (private 
contact list, LDAP directory, Microsoft Outlook directory or Lotus Sametime 
contact list), the notifier toast displays the contact's name and phone number. 
Otherwise, it contains the information "Unknown".

The notifier toast will stick and stay if you hover the cursor over it.

Notifier Toast for Call Pickup Group

NOTICE:  To use the Enable the Group pickup call toaster feature 
you need to perform specific settings in the modules Notifier 
Toast (Desktop Alerts) and SIP Service Provider > Codes.

A notification for a call pickup group is displayed whenever a group member 
receives a call. The notification persists until the call is accepted or the caller 
hangs up. The names of the caller and of the callee are displayed if they were 
found in the configured directories. Otherwise, the names are represented as 
"Unknown".

You can accept the pickup group call with a click on .

4.22  Screensaver

The OpenScape Desktop Client offers a screensaver feature that you can 
configure as default screensaver for the user PC. In this state you can dial a 
configured speed-dial number as well as accept and terminate an incoming call 
for yourself or a member of your call pickup group without having to close the 
active screensaver.

NOTICE:  You can start the screensaver on the user PC only if the 
OpenScape Desktop Client has been started also.

Depending on the connection status of OpenScape Desktop Client, the screen-
saver displays the following controls:

• <Speed-dial number> Dial
If speed-dial numbers have been configured for the screensaver, you can 
click on Dial to open a menu for selecting the phone number to be dialed.

NOTICE:  OpenScape Desktop Client must have been started so 
that a connection to the speed-dial number can be established.

• Accept call
When a call arrives and the screensaver is active, the Accept call button 
appears. With this button you can directly accept the call without deactivating 
the screensaver.

• Disconnect call
Terminates a call conducted while the screensaver is active.
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• Close Screensaver
Deactivates the screensaver.

• OpenScape Desktop Client is started or OpenScape Desktop Client is 
not started
This display indicates the OpenScape Desktop Client status. If the 
OpenScape Desktop Client is inactive, you cannot accept incoming calls or 
establish a connection with the speed-dial number.

4.23  Operating OpenScape Desktop Client with the PC Keyboard

The following information refers to operating the OpenScape Desktop Client with 
the PC keyboard:

In the OpenScape Desktop Client you can frequently directly dial with digit keys 
by selecting the relevant entry field with a mouseclick and entering the number.

NOTICE:  In the Web browser window you cannot directly dial 
with the keypad.

4.23.1  Operating with Hotkeys

You can use the OpenScape Desktop Client without the mouse via hotkeys.

Action Key/hotkey

System-wide keys (independent from the cursor/mousepointer position)

Accept incoming call Key configurable

End active call (hangup) Key configurable

Divert call (the current marking is used as forwarding desti-
nation).

Key configurable

Mousepointer in the OpenScape Desktop Client telephone or on the main bar

Search features [left arrow key] or [right 
arrow key]

Confirm feature Return key

Return to idle state in the system menu [Esc] (this key corre-

sponds to the icon in 
the main bar.)

Dial directly from the clipboard; the conversion of the 
characters to be dialed is determined by the network access. 
The office code is not added.

Shift key + [Ins]

Dial directly from the clipboard; the conversion of the 
characters to be dialed is determined by the network access. 
In this case the office code is added.

[Ctrl] + [V]
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• Push the Alt key to display the hotkeys options. The options appear as letters 
and numbers over each function.

• Push the letter or number that corresponds with the function you want to use. 
Some of the functions begin immediately. Other functions display additional 
hotkey options (letters and numbers) that can be pushed.

• Push the Esc key at any time to return to the respectively previous hotkey 
level. You can continue pushing the [Esc] key until the display of hot-key 
options no longer appear.

• Push the Alt key a second time to hide the hotkey options.

4.24  Audio Control Operating Elements

When you integrate an audio scheme in OpenScape Desktop Client, various 
audio icons are displayed in the main bar depending on the hardware and user 
settings. Using these audio icons you can quickly and effectively activate the 
corresponding features:

Button Function / Meaning

Lift receiver

(handset or another provided audio device)

• In case of an active connection request, e. g. an incoming 
call:
accept call and set up connection.

• In idle state:
activate handset or another provided audio device.

Hang up

(handset or another provided audio device)

• In case of an established connection:
close connection.

• In the system menu:
finish scrolling, return to idle state.

Microphone on/off

• In case of an established connection:
activate or deactivate audio device muting.

Loudspeaker on / off

• In case of an established connection or in idle state:
activate or deactivate speaker.

Headset on / off

• In case of an established connection or in idle state:
activate or deactivate headset operation.
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NOTICE:  The headset icon and the headset volume control are 
only available if you use a terminal device with appropriate 
signaling and this audio device was configured in the active audio 
scheme.

4.25  OpenScape Icon and Context Menu in the Notification Area of the 
Windows Task Bar

When the OpenScape Desktop Client is started, the OpenScape icon is 
displayed in the notification area of the Windows task bar by default. In the 
Settings dialog > Advanced tab > General > Task Bar and Notification Area 

Volume control

Move control to the right (louder) or to the left (softer) to set 
the volume:

• Ring tone - when the OpenScape Desktop Client is in idle 
state or a connection request is received.

• Speaker - in case of an established connection with 
activated speaker.

• Handset - in case of an established connection with 
activated handset and deactivated speaker.

• Headset - in case of an established connection with 
activated headset and deactivated speaker.

"Volume" menu

Open the "Volume" menu with a click on the "Volume" button 
(to the right of the slider) to set the microphone, ring tone 
and speaker volume independent from your respective call 
state in OpenScape Desktop Client. Here you can adjust the 
volume of the relevant audio device.

Depending on the operating system these icons are not 
visible since these settings are only possible via the 
operating system settings.

Additional speaker on / off

If your PC has an operable additional speaker and this 
speaker is configured in the settings for the current audio 
scheme, you can activate or deactivate it with a click on the 
"additional speaker" icon.

Button Function / Meaning
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OpenScape Icon and Context Menu in the Notification Area of the Windows Task Bar
you can activate/deactivate displaying this icon. The OpenScape icon displays 

status messages about missed calls  and signals error messages and 

warnings .

NOTICE:  You can open the current error report via the 
<number of errors/warnings> button in the status bar of the 

main window.

Double-clicking the OpenScape icon displays the main window again after it has 
been e.g. minimized or it has not been the currently active window.

With a click of the right mouse button on the OpenScape icon you open the 
OpenScape context menu.

The OpenScape context menu provides the following features:

• Status Information
This option provides connection status information about missed calls, for 
example.

• File
You can use this option to create a backup file of your contact list in CSV or 
XML format (export contacts to a file) or restore your contact list (import 
contacts from a file).

• View
Depending on the active modules, the individual user may deploy different 
options in the view. For example, you can display the main bar, open the web 
browser of OpenScape Desktop Client, show the contact list, the journal and 
the call control, etc.

• Personal Settings
Enables configuring an individual ring tone in the WAV or MP3 format. A click 
on Ring tones opens the Settings dialog with options for configuring ring 
tones of the currently connected communications system - SIP Service or 
HiPath Provider.

• About
Opens the Product information window and displays the OpenScape 
Desktop Client version number.

• Update
Establishes a connection to the latest OpenScape Desktop Client version that 
your system administrator has downloaded. A message tells when no update 
is available.
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• Help
Opens the program's online help.

• OpenScape Options
Serves to display the current application settings.

• Exit OpenScape
Serves to close the application.

4.26  IBM Lotus Notes Integration

If the IBM Lotus Notes client is already available on the PC when you install 
OpenScape Desktop Client, you can use the IBM Lotus Notes Integration feature 
after the setup. It extends the IBM Lotus Notes client by the features of the 
OpenScape Personal Edition. This enables IBM Lotus Notes users to deploy 
features of the OpenScape Personal Edition in their familiar IBM Lotus Notes 
environment.

NOTICE:  To use the IBM Lotus Notes Integration you need to add 
the Lotus Notes Provider module to the OpenScape Desktop 
Client configuration. How to add or remove modules is outlined in 
the setup manual of the OpenScape Personal Edition.

NOTICE:  To use the IBM Lotus Notes Integration, a IBM Lotus 
Notes client must have been installed and started on the user PC.

The IBM Lotus Notes Integration enables the following features:

• Searching IBM Lotus Notes address books for contacts
If you have IBM Lotus Notes address books configured in the Lotus Notes 
Provider you can search them for contacts. This search option is available in 
the Directory Search scope.

• Initiating calls in the IBM Lotus Notes client
You can initiate a call from the following IBM Lotus Notes elements:

– Your private or global IBM Lotus Notes address book
In this case all phone number information contained in the IBM Lotus 
Notes address book for the selected contact is transferred to OpenScape 
Desktop Client. If several phone numbers are available, you need to 
select one of them for setting up a connection.
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– Your IBM Lotus Notes inbox
In this case the IBM Lotus Notes client searches the available IBM Lotus 
Notes address books for the name of the originator of the selected e-mail. 
The phone numbers that can be associated to the originator are trans-
ferred to the OpenScape Desktop Client.

To initiate a call in the IBM Lotus Notes client, select the desired IBM Lotus 
Notes contact in the IBM Lotus Notes address book or the desired e-mail in 
the IBM Lotus Notes inbox. Then click on Dial in the toolbar of the IBM Lotus 
Notes client.

NOTICE:  The Dial button in the toolbar of the IBM Lotus Notes 
client is always displayed. However, it only works in IBM Lotus 
Notes databases configured in the Lotus Notes Provider.

As soon as you have initiated the call, the main window of OpenScape 
Desktop Client appears in the foreground. In there you can control the 
connection in the Call Control frame as usual.

• Resolving phone numbers and names 
The IBM Lotus Notes Integration enables resolving phone numbers and 
names on the basis of IBM Lotus Notes address books. Phone numbers and 
names are resolved in the background. Private as well as global IBM Lotus 
Notes address books are supported.

4.27  Microsoft Outlook Integration

If the Microsoft Outlook client is already available on the PC when you install 
OpenScape Desktop Client, you can use the Microsoft Outlook Integration 
feature after the setup. It extends the Microsoft Outlook client by the features of 
the OpenScape Personal Edition. This enables Microsoft Outlook users to deploy 
features of the OpenScape Personal Edition in their familiar Microsoft Outlook 
environment.

NOTICE:  To use the Microsoft Outlook Integration you need to 
add the SQLite Provider module to the OpenScape Desktop 
Client configuration. How to add or remove modules is outlined in 
the setup manual of the OpenScape Personal Edition.

NOTICE:  To use the Microsoft Outlook Integration, a 
Microsoft Outlook client must have been installed and started on 
the user PC.

The Microsoft Outlook Integration enables the following features:
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• Finding contact information in Microsoft Outlook contact directories
The SQLite Provider is used for accessing the information of 
Microsoft Outlook contact directories. The corresponding module is installed 
with the Microsoft Outlook Integration. In this process, it is automatically pre-
configured for accessing the information of Microsoft Outlook contact direc-
tories. This search option is available in the Directory Search scope.

•  Initiating calls in the Microsoft Outlook client
For this feature, the toolbar provides different Microsoft Outlook windows and 
the Dial button. You can initiate a call from the following Microsoft Outlook 
windows:

– Your Microsoft Outlook contact list or the window of an opened 
Microsoft Outlook contact
If you have selected a contact entry in your Microsoft Outlook contact list 
and click the Dial button, Microsoft Outlook evaluates the current object 
(name, phone number, e-mail address etc.) and determines the 
associated phone number based on the Microsoft Outlook contacts. The 
phone number is transferred to the OpenScape Desktop Client that uses 
it as destination number and sets up a connection.
If several phone numbers are available for the current Microsoft Outlook 
contact, e.g. business, private and mobile phone numbers, the following 
dialog opens in which you need to select one of these numbers for this 
contact.

NOTICE:  OpenScape Desktop Client updates your 
Microsoft Outlook contacts only with every program start. If you 
have added a new contact in Microsoft Outlook or changed 
contact data, you must restart the OpenScape Desktop Client. 
Only then your new contact entries or your changes in 
Microsoft Outlook are applied by the OpenScape Desktop Client.

If no phone number information is available, the connection setup fails.

– Your Microsoft Outlook inbox or the window of an opened e-mail
If you select an e-mail and then click the Dial button, the 
Microsoft Outlook client searches the Microsoft Outlook address books 
(your personal Microsoft Outlook contact list and e.g. the corporate 
A31003-G2570-U100-1-7619, 05/2012
OpenScape Personal Edition V7, User Guide 219



Operation Reference
Operation in Restricted Mode
directory) for the originator's name. The phone numbers that can be 
associated to the originator are transferred to the OpenScape Desktop 
Client.
If several phone numbers have been stored for the selected contact, 
proceedings are the same as outlined above.
If no phone number information is available for the selected e-mail origi-
nator, the connection setup fails.

NOTICE:  This dialog appears even if you have selected a sent e-
mail with several addressees. Select the desired contact from this 
dialog.

– Your Microsoft Outlook task list or the window of an opened task
You can compare initiating a call from a task with the procedure described 
for initiating a call from your Microsoft Outlook inbox.

– The window of an opened appointment in your Microsoft Outlook calendar
You can compare initiating a call from an appointment with the procedure 
described for initiating a call from your Microsoft Outlook inbox.

As soon as you have initiated the call, the main window of OpenScape 
Desktop Client appears in the foreground. In there you can control the 
connection in the Call Control frame as usual.

• Resolving phone numbers and names 
The Microsoft Outlook Integration enables resolving phone numbers and 
names on the basis of Microsoft Outlook address books. Phone numbers and 
names are resolved in the background. Private as well as global 
Microsoft Outlook address books are supported.

4.28  Operation in Restricted Mode

You can operate the OpenScape Personal Edition as SIP Softphone at an 
OpenScape Voice with a so-called survivability solution (e.g. 
OpenScape Branch). If the OpenScape Voice fails, the survivability solution 
ensures that the program switches automatically to restricted mode, thus being 
able to permanently provide basic SIP telephony services.

The status bar of OpenScape Personal Edition signals operation in restricted 
mode by a corresponding information display . In this case the following 
functions are available in the Call Control:

• Make call

• Accept an incoming call

• End call

• Set active call to on-hold

• Retrieve held call

• Make consultation call

• Connect consultation call subscriber with waiting subscriber
 A31003-G2570-U100-1-7619, 05/2012
220 OpenScape Personal Edition V7, User Guide



Operation Reference
Operation in Restricted Mode
When the OpenScape Voice is available again, the OpenScape Desktop Client 
returns automatically to the normal operation mode.
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Communicating with Contacts
Reaching a Contact from the Contact List by Telephone or E-mail
5  Communicating with Contacts

The contact list of the OpenScape Personal Edition is your private address book. 
It allows fast communication with your regular conversational partners.

5.1  Reaching a Contact from the Contact List by Telephone or E-mail

The icons to the right of a contact’s name in the Contacts frame show you 
whether that person can be reached by phone or e-mail.

• - The contact can be reached via telephone.

• - The contact can be reached via telephone. There are at least two phone 
numbers configured for him/her.

• - This icon is always available when an e-mail address has been 
configured for the contact.

This information is also available in the form of a tool tip when you hold the cursor 
over the icon.

To call or e-mail to a contact from your contact list, click the appropriate icon next 
to the contact’s name in the Contacts frame.

Callback

If you cannot reach a contact by phone - he/she does not answer the phone or the 
line is busy - you can use the Callback feature. Rightclick the area of the 
displayed connection in the Call Control window. Select the Callback Option 
in the displayed context menu.

NOTICE:  So that you can use this feature you need to open the 
Settings dialog and select on the tab Advanced > SIP Service 
Provider > Codes. Then specify the required codes in the 
Callback area.

NOTICE:  Only specific PBXs support the callback feature.

5.2  Calling any Contact

You can use the following options to call a subscriber who is not entered in your 
contact list of the OpenScape Personal Edition:

• Via the main bar
Click on the telephone display in the main bar. Using the open keypad or your 

PC keyboard you can enter the desired number. Then click on or push 
the return key. The connection to the desired contact is established.
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• Via the quick-access toolbar
Enter the desired phone number in the <name or number> field and click 

on .

• Via the ribbon
Enter the desired phone number in the <name or number> field of the tab 

Home > Group Call Control and click on the Make Call button.

• Via the Call Control frame
Enter the desired phone number in the <name or number> field and click 

on .

5.3  The Bubble (Business Card)

The business card is shown when you hover the cursor over the name of a 
contact in the Contacts frame or in the Journal. It sticks on top of all windows 
when clicked, and it can be moved and deleted.

• The business card displays a picture that was associated with the contact 
when you added a contact.

• In the business card you can see the contact's name.

• The business card shows the name and address of the contact's company as 
far as such information is available.

• The icon lets you invoke a default e-mail application (e.g. 
Microsoft Outlook) to send an e-mail to the contact.

• The or icon lets you set up a phone connection to the contact.

5.4  Collaboration in Conferences

With the OpenScape Personal Edition you can use two types of conference 
services:

• Local conference (three-party conference)

• Server-based voice conference

NOTICE:  In the OpenScape Voice documentation the server-
based voice conference is referred to as participant-controlled 
conference.
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Collaboration in Conferences
5.4.1  Local Conference (Three-Party Conference)

A local conference (three-party conference) is a spontaneous simplified 
telephone conference that is started by an initiator (participant who initiates the 
conference). Three participants can talk to each other on the phone at the same 
time, that is each participant with each participant. This type of conference is 
realized by the device and no conference bridge is required. The participants 
must already be connected before the conference may be initiated. The 
difference for the initiator of a local conference is that the two other conversational 
partners must already be connected to him/her. The other two must either be put 
on hold or one on hold and the other one in an active call.

NOTICE:  In a local conference the initiator cannot add more than 
two other participants.

5.4.2  Server-based Voice Conference

A server-based voice conference is a spontaneous conference initiated by a 
participant who asks other participants to join in on the basis of consultation calls.

NOTICE:  In the OpenScape Voice documentation this type of 
conference is referred to as participant-controlled conference.

In contrast to a local conference (three-party conference) this type of conference 
is provided by a conference server. This enables it to connect up to 48 participants 
to each other.

NOTICE:  Using this feature requires the system supporting the 
consultation call feature, at least one active connection as well as 
connection to an OpenScape Voice.

5.4.3  Controlling a Conference via Telephone

With OpenScape Desktop Client you can control a current local or server-based 
voice conference (participant-controlled conference) via the keys of the 
SoftPhone, integrated or free phone. The keys of one of these phones are used 
for transmitting control commands to the system by sending DTMF tones.

NOTICE:  The administrator can deactivate the operating menu 
by configuration. Furthermore, he/she can change the 
assignment of commands to the single keys. In case of doubt, 

have the menu options announced via .
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Activating the Control Menu

To control a conference via the keys of the SoftPhone, integrated or free phone 

you first need to activate the operating menu by pushing the key. This 
prevents disruptions that may occur during a conference when a telephone key is 
inadvertently pushed.

NOTICE:  The administrator can deactivate this behavior by 
configuration, so that you need not activate the operating menu 
separately.

Control Commands

In the OpenScape Desktop Client you can use the following key commands for 
controlling a conference:

• Prompt menu
The available menu options are announced to you.

• Lock/unlock conference
Once the conference has been locked, no further participants may dial in. 
Pushing this key once more undoes the restriction.

NOTICE:  In a local conference only the initiator can trigger this 
feature.

• Mute self
Via this key you can temporarily deactivate the microphone of your telephone. 
The conference connection is maintained. Pushing this key once more reacti-
vates the microphone.

• Mute conference
This feature mutes all microphones of the conference participants. Only the 
voice signal of the conference participant who triggers this function is still 
transmitted to all conference participants.

NOTICE:  In a local conference only the initiator can trigger this 
feature. In case of a server-based voice conference (device-
controlled conference), all conference participants can trigger this 
function and also cancel a muting by themselves.

• Initiate device handover
This function allows you to change the device you use in the conference. After 
you have pushed this key, enter the phone number of the device you want to 

switch to. You need to complete the phone number entry with the key. 
For further proceedings, please follow the voice prompts.

• Toggle music-on-hold
If you currently are the only conference participant and hear music-on-hold, 
you can push this key to switch off the music. Pushing this key once more 
reactivates the music-on-hold.
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E
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General settings 22
Group

adding a contact 133, 194
adding contacts 134
context menu 194
creating 132, 195
duplicating 195
moving contacts 134
renaming 195

H
Handover via DTMF keys 151
Handset

volume 215
Hang up 214
Hanging up 143
Headset

on / off 214
volume 215

HFA license 91
HiPath license server 91
HiPath provider

main connection 66
settings 65

HLM License Provider 91
Hotkeys 23, 213

I
individual ringtone 56, 75
Initial configuration 112
Initial login 111
Integrated phone 207
Integration

Lotus Notes 217
Microsoft Outlook 218

Internet page
adding 33, 126
changing 34, 127
deleting 34, 127

J
Jitter buffer 77
Journal 197

calling a contact 198
combined view 199
context menu 201
filtering entries 146, 200
normal view 199
options 198
period view 198
sorting entries 146

K
Key assignments 101
Key module 66
Keyboard Manager 100
keyboard operation 213
Keyboard support 100

L
Language

changing 119
selecting 154

LDAP 90
adding a directory 87
directories 86
A31003-G2570-U100-1-7619, 05/2012
228 OpenScape Personal Edition V7, User Guide



Index
LDAP Directory Provider 86
License server 91
Licensing 91
LIN 25, 154
Line settings 32
Lines 202
Load Default Profile 59
local conference 225
Local conferences

ending 148
starting 148

Local Journal Provider 90
Local video conference 173
Location 25
Location information

HiPath provider 68
SIP Service Provider 48

Logging on 153, 154
Lotus Notes

calling e-mail originator 145
Lotus Notes address book 217, 219
Lotus Notes integration 217
Lotus Notes Provider

authentication 99
configuring a Lotus Notes database 92
settings 92

M
Main bar 157

menu 158
Main connection

HFA connection 66
SIP Service Provider 39

Main Line 39
Managing the configuration settings 155
Microsoft Outlook

calling e-mail originator 145
Microsoft Outlook integration 218
Mobile user 63

logging on 63
Mode 25
MP3 file 56, 75

N
Name resolution 218, 220
network access settings 48
Normalize call numbers 50
Notification area 28
Notifier 211
Notifier toast 211

incoming call 211
pickup group call 212

settings 100

O
Office code 49, 69, 73
OpenScape symbol in the task bar 28
Operating with the PC keyboard 213
options 25
Outbound domain 47
Outlook integration 218
Own video image 170

P
Participant-controlled conference 150
Pearl menu 160, 161, 216
personal settings 159
Phone number resolution 218, 220
playback 17, 120
Point-to-point video 171
Ports

restrictions 60, 77
settings (HiPath provider) 77
settings (SIP Service Provider) 60

Prefix
HiPath connection 73
HiPath provider 69
SIP Service Provider 49

Profile 154
adding 108, 155, 156
changing 156
copying 156
deleting 156

Program start settings 24
Program update 28
Proxy server 45

Q
QoS settings

HiPath provider 79
SIP Service Provider 62

Quick access toolbar 162
adjusting 162
context menu 162

R
Registrar server 45
Restricted mode 220
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